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BOOK OVERVIEW AND OTHER
RESOURCES

Description of this guide
MicroStrategy Mobile gives users access to MicroStrategy reports and documents on
their mobile devices, and allows users to analyze and interact with business data. There
are different applications for use on the Apple© iPhone®, the Apple iPad®, and
Android® devices.

This guide discusses how an administrator can install and configure MicroStrategy
Mobile on mobile devices and how a designer working in MicroStrategy Developer or
MicroStrategy Web can create reports and documents for use with MicroStrategy Mobile.

Specifically, this guide includes the following:

• Chapter 1, Using MicroStrategy Mobile describes common business scenarios and
use cases for the MicroStrategy Mobile application.

• Chapter 2, Designing Reports and Documents for Mobile Devices provides best
practices to design reports and dashboard-style documents in MicroStrategy Web, for
display and use on mobile devices such as iPhones, iPads, and Android-based phones
and tablets.

• Chapter 3, Displaying data as interactive visualizations: Widgets provides best
practices for displaying data as widgets.

• Chapter 4, Using links in documents describes the steps to create links in documents
for mobile devices, which allow users to open a device’s applications or navigate
between reports and documents.

• Chapter 5, Administering MicroStrategy Mobile describes how to install and
configure MicroStrategy Mobile on an Intelligence Server, and how to install and

© 2017, MicroStrategy Inc. 5
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configure the MicroStrategy Mobile client on mobile devices. It also explains how to
subscribe to reports and discusses the ways in which administrators can manage
multiple subscriptions simultaneously.

About this book
This book is divided into chapters that begin with a brief overview of the chapter’s
content.

The following sections provide the location of additional examples, list prerequisites for
using this book, and describe the user roles the information in this book was designed
for.

The sample documents and images in this guide, as well as some example steps,
were created with dates that may no longer be available in the MicroStrategy
Tutorial project. If you are re-creating an example, replace the year(s) shown in
this guide with the most recent year(s) available in the software.

How to find business scenarios and examples
Within this guide, many of the concepts discussed are accompanied by business scenarios
or other descriptive examples. Many of the examples use the MicroStrategy Tutorial,
which is MicroStrategy’s sample warehouse and project. Information about the
MicroStrategy Tutorial can be found in the Basic Reporting Guide.

Detailed examples of advanced reporting functionality can be found in the Advanced
Reporting Guide.

What’s new in this guide

MicroStrategy 10.5

• Mobile administrators can customize error messages originating from Intelligence
Server. For details, see Customizing error messages for mobile devices.

MicroStrategy 10.4

• You can enable push notifications for users with Android devices so that they receive
alerts when selected targets are met. For steps, see Configuring MicroStrategy
Mobile for Android to receive push notifications.

• iOS users can now apply multiple layers with different datasets on a map. This allows
users to see data from various datasets by switching between layers on the same map,
as well as see multiple layers for comparison on the same map. For steps on how to
add datasets to a Google map, see the GIS Help.

http://www2.microstrategy.com/producthelp/10.4/GISHelp/Lang_1033/GIS_Integration.htm
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MicroStrategy 10.3

• You can select which view (month, week, or day) that the Date Selection widget
displays initially on a iPad. For steps, see Displaying an interactive event calendar:
Date Selection widget.

MicroStrategy 9.4.1 iOS Update 5

• For devices with very high-resolution screens, such as the iPhone 6 Plus, you can
take advantage of the additional screen space by providing images of a higher
resolution.

For guidelines for adding images to your documents, and additional best practices to
design documents, see Best practices for designing reports and documents for
mobile devices, page 19.

MicroStrategy 9.4.1 iOS Update 4

• You can create a link that opens and prints a target document. For steps, see Using
links to access features within the MicroStrategy Mobile application, page 150.

MicroStrategy 9.4.1 iOS Update 3

• You can enable MicroStrategy Mobile for iOS to download data when the app is
running in the background so that new data is already downloaded and available
when users resume the app. For steps, see Configuring MicroStrategy Mobile for
iPhone or iPad, page 186.

• You can customize the accent color used for some text and buttons in MicroStrategy
Mobile for iOS. For steps, see Configuring MicroStrategy Mobile for iPhone or
iPad, page 186.

• You can specify a dark or light color theme for MicroStrategy Mobile for iOS. For
steps, see Configuring MicroStrategy Mobile for iPhone or iPad, page 186.

MicroStrategy 9.4.1 Update 1

• A user can interact with data and send those interactions back to the data source,
using transactions to make decisions and write back to the data source. If you have
multiple input object controls on a document displayed on an iOS device, you can
create a transaction table to group and organize the controls. For steps and an
example, see Organizing transactions with tables on iOS devices, page 67.

Analytics Enterprise

• The name of MicroStrategy Desktop has been changed to MicroStrategy Developer.
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MicroStrategy 9.4

• You can create a Survey widget for an iPad, which allows an analyst to interact with a
survey on an iPad and submit answers, which are then stored in your data source.

For steps and an example, see Gathering data from users: Survey widget, page 119.

• You can create a Microcharts widget for use on an iPhone. A Microcharts widget
allows users to analyze trends at a glance using compact charts and line graphs.

For steps and an example, see Visualizing trends: Microcharts widget, page 108.

• You can take advantage of Smooth Scroll mode for a Microcharts widget displayed
on an Android device, to ensure that the metric columns in the widget have enough
space to be displayed on a mobile device. For steps, see Enabling Smooth Scroll
mode, page 110.

• You can select formatting options for a Time Series widget displayed on an Android
device, such as background and label display options. For steps, see Uploading
images: Photo Uploader widget, page 113.

• You can create a Video Player widget for the iPhone and iPad. This widget plays
video directly in a document. Videos can be cached for offline viewing.

For steps and an example, see Downloading and playing videos: Video Player
widget, page 128.

• In a Map widget:

▫ You can display map markers as points on a path displayed on the map. The line
used to represent the path is displayed as thicker for larger metric values and
thinner for smaller metric values.

▫ Additional display themes, such as Desert Theme and Ice Theme, are available.

▫ You can choose to display or hide items in the map, such as the map toolbar, or
a slider that allows the user to zoom in and out of the map.

For steps to create a Map widget, see Displaying geographical data: Map widget,
page 93.

Prerequisites
Before working with this manual you should be familiar with:

• The nature and structure of your company’s data that you will analyze in your
business intelligence reports and documents

• The information provided in the Basic Reporting Guide about analyzing report
data—and the information about designing reports, if you plan to create reports in
MicroStrategy Developer or MicroStrategy Web for use with MicroStrategy Mobile

Who should use this guide
This document is designed for the following users:
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• Administrators who intend to install and configure MicroStrategy Mobile on mobile
devices.

• Report and document designers who intend to create reports and documents in
MicroStrategy Developer and MicroStrategy Web for use with MicroStrategy Mobile.

• Analysts who intend to run and analyze MicroStrategy reports and documents using
MicroStrategy Mobile on a mobile device.

Education
MicroStrategy Education Services provides a comprehensive curriculum and highly
skilled education consultants. Many customers and partners from over 800 different
organizations have benefited from MicroStrategy instruction. For a detailed description
of education offerings and courses, visit https://www.microstrategy.com/Education.

https://www.microstrategy.com/Education


1
USING MICROSTRATEGY
MOBILE

Use MicroStrategy Mobile to distribute the power of analytics within your enterprise.
You can create a powerful custom mobile app that allows users to view, analyze, and
write-back information to your database or you can use MicroStrategy Mobile simply as
an extension of your MicroStrategy project to view project documents, dashboards, and
reports on mobile devices.

For an overview of what you can create with Mobile and how, see the following:

• Common business scenarios for MicroStrategy Mobile, page 10: This section
provides examples of the kinds of documents and apps you can create.

• Overview: Creating documents for mobile, page 11: This section provides a
workflow for creating documents for mobile devices and outlines the considerations
to take into account while creating documents for mobile devices.

• Overview: Creating apps with MicroStrategy Mobile, page 15: This section provides
a workflow for creating mobile apps and outlines the considerations to take into
account while designing apps for mobile devices.

• Viewing demo apps and dashboards: Restoring default settings, page 17: This
section provides steps to restore your app to MicroStrategy’s default settings.

Common business scenarios for MicroStrategy
Mobile

MicroStrategy Mobile can be used to support business activities, including the following
examples:

• Instantly view data from any existing report or document to answer your questions.
If you are in a business meeting, Mobile ensures that the data is up-to-date. Examples
of documents and dashboards you can create with Mobile are:

▫ A Visual Insight dashboard used to explore data in a strategic business meeting.
Dashboards allow users to change the graph used to display data and create their
own filters, thresholds, and metrics.

© 2017, MicroStrategy Inc. 10
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▫ A dashboard-style document that displays data on a business’ bestselling products
and stores. Users can view inventory on bestselling products as well as data on
other products that are similar. The information in the document is updated
weekly.

• Instantly write information to your database. Transaction Services allow you to
create forms that automatically send information to your database. Examples of how
you can use Transaction Services are:

▫ A Corporate Request Center (CRC) app with selectors that allow users to approve
or deny time off, expenses, and purchase order requests. The approvals and
denials are automatically written to the database after processing.

▫ A customer satisfaction survey document that asks customers to rate your
business on a scale and leave comments. You can ask customers to complete the
survey after a transaction.

• Distribute mobile apps within your organization, or in the Apple App Store or Google
Play. Mobile apps can support any recurring business needs you have. Examples of
apps you can create are:

▫ An app for your CFO with a high-level overview of your company’s performance
that refreshes with up-to-date information biweekly.

▫ An app that displays product, sales, and inventory information for your business
and maps all items to store locations. Users can drill down into graphs and
widgets for deeper analysis and also scan product barcodes to view item
information. The data in the app is automatically refreshed on a weekly
schedule.

• Link together multiple mobile devices with MicroStrategy Mobile installed on them
to create a Command Center. You can use any of the linked devices to control the
data that displays on all other linked devices. Changes made on one device, such as
filtering or drilling, update the display of the other linked devices. For steps, see the
MicroStrategy Developer Library.

▫ If you have Apple TV, you can display the output of each device on an HDTV.

Overview: Creating documents for mobile
Dashboard-style documents form the basis of the apps and dashboards you can create
with MicroStrategy Mobile.

https://resource.microstrategy.com/msdz/default.asp
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The following workflow describes the process of creating a document for viewing on a
mobile device. It assumes that you are familiar with designing MicroStrategy reports and
documents and have the necessary privileges to do so.

For information on designing MicroStrategy reports, see the Basic Reporting Guide. For
information on designing dashboard-style documents, see the Document Creation Guide.

If users want to be able to create their own filters, thresholds, or change the graph
style used to display data, consider creating a dashboard instead of a document.
For steps to create a dashboard, see the MicroStrategy Web Help.

To view sample RS documents created for each mobile device, in the MicroStrategy
Tutorial project, navigate to the Shared Reports folder. ClickMicroStrategy
Platform Capabilities, then clickMicroStrategy Mobile. Select the folder to open
based on the device you are using. The folder displays with a list of reports and
documents designed for that device.

To create a document for a mobile device

1 Based on how users will interact with the document, decide what objects to add to
the document.

• If users want to be able to see different subsets of data depending on the
situation, consider using a prompt or including a table of selectors. Examples of
how prompts and selectors can be used are:

▫ Viewing data on a specific product. Create a prompt that asks the user to
type or scan the product’s barcode. The data in the document is filtered
based on the product scanned.

▫ Searching for hospitals within a certain distance from the user. Create a
prompt that asks for permission to obtain the user’s location from their

https://www2.microstrategy.com/producthelp/10.7/BasicReporting/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
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mobile device and a selector the user can use to define the maximum
distance of a hospital. The data in the document is filtered to display only
the hospitals that are within the distance defined by the selector to the user.

For guidelines on creating prompts for mobile devices, see Allowing users to
filter data: prompts, page 56. For steps to create a selector, see the Dashboards
and Widgets Creation Guide.

• If users want to be able to edit, add, or delete data from your database with a
mobile device, create documents that use Transaction Services. You must have
Transaction Services to use this feature.

For an introduction to Transaction Services, and instructions to create
Transaction Services reports, see the Advanced Reporting Guide. For
instructions to create Transaction Services-enabled documents, see the
Document Creation Guide.

▫ If you are designing for iPhones or iPads, consider using a Transactions table
to organize the Transactions data. For example, you are creating a calendar
of events and want users to be able to add or edit events on the calendar.
You can use a Transactions table to easily create a form that asks the user for
event details and saves them to the database. For steps, see Organizing
transactions with tables on iOS devices, page 67.

▫ If you want to create a survey, where users are presented with a set of
questions they answer by selecting options from a list or by typing in their
answers, consider using a Survey widget. For steps, see Gathering data from
users: Survey widget, page 119.

• To create a document that runs other applications on the mobile device to
perform a specific task, such as opening your mail app to send an email, accesses
specific features within MicroStrategy Mobile, such as repeating a prompt on a
document, or opens other documents or reports, add a link. For more
information on what you can do with links and steps to create them, see Linking
to reports and documents from a mobile document.

• To include videos and images in a document, use the Video Player and Image
Viewer widgets. For steps, see Downloading and playing videos: Video Player
widget, page 128 and Displaying images: Image Viewer widget, page 87.

2 Based on the information users want to access and how they want to use that data,
decide how you will display data in your document.

• You can display important information in a docked header or footer. Docked
headers and footers are always visible at the top and bottom, respectively, of the
screen as the user scrolls up or down in the document. For steps, see Allowing
users easy access to document content: docked headers and footers, page 49.

• You can inform users of important information, such as new content or updates,
by displaying and update a badge displayed next to the MicroStrategy Mobile
application icon on a user’s iPhone or iPad. For steps, see Notifying users:
Displaying a badge next to the MicroStrategy Mobile application icon, page 51.

• You can create a simple graph to display your data. Many graph types are
available, such as overlapping bar graphs and pie graphs. For steps, see the
Document Creation Guide.

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/AdvancedReportingGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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For interactive graphs, such as a data cloud, graph matrix, or map, consider
using a widget. For a description of each widget you can use and steps to create
them, see Adding widgets and visualizations to documents for mobile devices,
page 78.

3 Design your document based on how you want the user to interact with your
document and the mobile device they are using. For best results, follow the
guidelines listed in Best practices while planning reports and documents, page 19.

For iPads and Android tablets, it is recommended that the document be the same
size as the screen of the device. If you cannot fit all the objects you need in one
document, consider splitting the document into multiple documents and linking
them together, or use one of the following techniques:

• Group small sets of related data together into panel stacks. For information on
creating panel stacks for mobile devices, see Allowing users to access
information easily: mobile-friendly panel stacks, page 36.

• Place detailed data in an Information Window that displays when the user taps
on another object. For example, you are creating a document with a scatter
graph. You can create an Information Window that displays when the user taps
on a bubble in the scatter graph, with detailed information on the bubble. For
steps, see Providing additional information to users: Information Windows,
page 38.

4 Create the datasets that support your document. You can import data from your
database or use an already existing report or Intelligent Cube. For steps, see the
Document Creation Guide.

5 Create the document based on your design. For best results, follow the guidelines
listed in Best practices while creating reports and documents, page 22. For device-
specific guidelines, see also Best practices while creating reports and documents for
the iPhone 5, page 24 or Creating documents for mobile devices, page 24.

6 If the document is going to be viewed on devices with different screen sizes, format
the document so it displays properly on all devices. For steps, see Formatting
documents for mobile devices, page 26.

7 Distribute the document. If the document is part of an app, deploy the app within
your organization or on the App Store. For steps, see Deploying and configuring the
MicroStrategy Mobile application, page 183. Otherwise, place the document in the
Shared Reports folder of your MicroStrategy project. All users with permission to
view the folder are able to view the document from their mobile device.

8 If you have MicroStrategy Enterprise Manager, you can fine-tune the design of your
app based on user statistics. Enterprise Manager is a set of pre-built documents that
display data on how people are using your app, such as what device they’re using,
which documents they view the most, and app performance. You can also create
your own documents with the statistics that Enterprise Manager collects. For a
description of the pre-built reports in Enterprise Manager and steps to install and
configure, see the System Administration Guide.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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Overview: Creating apps with MicroStrategy
Mobile

You can use MicroStrategy Mobile as a platform to create mobile business intelligence
(BI) apps for your organization. By linking dashboard-style documents and Visual Insight
dashboards together, you create the experience of a mobile app. Using visualizations and
widgets, users can analyze data and make decisions based off that data as they receive it.

The app you create uses a dashboard-style document that serves as a home screen and
links to other documents of interest. The home screen displays when users open your
Mobile application instead of MicroStrategy’s default interface. For example, the CFO
Dashboard demo app has a home screen that links to documents for financial
performance, what-if analysis, and so on, as shown in the following figure:

To create a mobile app

1 Evaluate what the users need and the workflow that they require. It is useful to know
the following:

• The users’ current problems, their goals, and their expectations

• The mobile device(s) the users are using for the app.
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2 Define the purpose of the app and the key issues the app solves. Based on this,
determine the data required for the app and whether your database contains that
data.

3 Create a diagram of the documents you are designing and how users will navigate
between them. Design the documents to accomplish your users’ tasks and the
navigation system to support your users’ workflow. Best practices while designing
documents are described in Best practices while planning reports and documents,
page 19.

You can have users navigate the app with:

• A menu bar with buttons that link to the main documents in your app. The
menu bar displays at the bottom of all documents that it is linked to.

• Swiping left or right to view each new screen. This is useful for apps that have a
linear workflow or for apps whose main purpose is to showcase information. Do
this by creating a panel stack that fills the screen of the device and adding a
docked panel selector to the stack. Each panel in the stack is a separate screen.

• A link embedded in a document. You can create links to documents from a text
field, image, button, or attribute element. Depending on the device you are
designing for, you can create links that filter the data of the document they link
to based on the object the user selects.

4 Create the documents that make up your app and link them together based on your
diagram.

To create the feel of a standalone app, designate one of the documents you create as
the home screen for your app, which you configure to display when the application
opens. Consider adding a button to your home screen with a link to MicroStrategy’s
device-specific help, which provides instructions for your users on how to interact
with widgets and reports, and so on. To create a link to the help, see Using links to
access features within the MicroStrategy Mobile application, page 150.

For high-level steps to create a document, see Overview: Creating documents for
mobile, page 11.

5 If you are creating a custom home screen for the app, create a mobile configuration
that configures users' devices to load the custom home screen when the application
loads. For steps to create a mobile configuration, including steps to define a custom
home screen, see Chapter 5, Administering MicroStrategy Mobile.

6 By default, users log in to your mobile app using their MicroStrategy user name and
password. You can customize the way users log in to your app, by requiring a custom
token when they log in or allowing them to use their Facebook credentials to log in.
You can also have users log in separately for each project they want to access, or re-
direct users to a different page when they cannot log in. For detailed information on
how you can customize the way users log in to Mobile, see theMicroStrategy
Developer Library.

7 Distribute your app to a preliminary set of users to gather feedback on whether your
app addresses your users' needs. You can also test how easily users navigate and use
your app. Redesign components of your app as necessary based on user feedback.

https://resource.microstrategy.com/msdz/default.asp
https://resource.microstrategy.com/msdz/default.asp
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8 Distribute the app to users within your organization, on Google Play, or on the Apple
App Store. For steps to deploy and configure your app for all mobile devices, see
Chapter 5, Administering MicroStrategy Mobile.

You can create customized versions of the MicroStrategy applications that use your
organization's branding. For the requirements and steps to build customized
applications, refer to theMicroStrategy Developer Zone (MSDZ), at the following
URL: https://resource.microstrategy.com/MSDZ/

To access the MSDZ, you must create an account in the MicroStrategy
Knowledge base, at the following URL: https://resource.microstrategy.com.

9 Update and maintain the app as necessary. Most apps require periodic refreshing so
the data they contain is relevant and up-to-date. To automatically refresh the data,
you can create subscriptions for users to send them updated data on a schedule.

If the users are using iPhone or iPad devices, you can use the Newsstand feature to
schedule deliveries to users' devices at off-peak hours, even if the MicroStrategy
Mobile application is not currently running. For steps, seeManaging Mobile report
subscriptions, page 222.

Viewing demo apps and dashboards: Restoring
default settings

On the iPhone or iPad, you can restore your custom Mobile app to the MicroStrategy
default project settings to view the latest demo apps that MicroStrategy provides and see
examples of the latest features.

To restore your Mobile app to the MicroStrategy default app settings

1 From the iPhone or iPad home screen, tap Settings.

2 From the list of apps on the left, tap one of the following:

• If you want to reset the Mobile app, tapMicroStrategy.

• If you want to reset the Good Dynamics app, tapMicroStrategyGD.

3 Tap Reset Application.

You can return to your custom Mobile app by re-installing it, either by downloading it
from your company’s internal website or clicking a configuration URL in an email from
your administrator.

https://resource.microstrategy.com/MSDZ/
https://resource.microstrategy.com/
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DESIGNING REPORTS AND
DOCUMENTS FOR MOBILE
DEVICES

This chapter contains steps to design reports and dashboard-style documents in
MicroStrategy Web, for display and use on mobile devices such as iPhones, iPads, and
Android-based phones and tablets. These can be standalone documents or documents
that are part of a mobile app. This chapter also contains best practices for designing
reports and documents that perform well and are easy to use. The following topics are
covered:

• Best practices for designing reports and documents for mobile devices, page 19.
Designing a MicroStrategy report or dashboard-style document that is viewed on iOS
and Android devices requires the use of device-specific document features. This
section discusses best practices for using these features.

• Creating documents for mobile devices, page 24. This section describes the ways in
which you can design dashboard-style documents for iOS- and Android-based
devices, and to use features specifically designed for these devices.

• Allowing users to filter data: prompts, page 56. A prompt is a question that the
system presents to a user when a report is executed. The user’s answer determines
the data that is returned by the report. Specific prompts can be added to a report for
use on a mobile device that has the MicroStrategy Mobile application.

• Allowing users to filter data using filter panels, page 67. You can create a panel of
selectors in a dashboard-style document that acts as a filter panel, where users decide
what data in the document is displayed by making selections in the panel.

• Organizing transactions with tables on iOS devices, page 67. A user can interact
with data and send those interactions back to the data source. For example, a user
can add a new customer contact name and details while on-site with the customer,
and send the new data back to be recorded in the data source immediately.
Transactions allow users to make decisions and write back to the data source. If you
have multiple input object controls on a document displayed on an iOS device, you
can create a transaction table to group and organize the controls.

© 2017, MicroStrategy Inc. 18
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Prerequisites
• This chapter assumes that you know the nature and structure of your company’s

data, which users will analyze in business intelligence reports and documents.

• This chapter assumes that you are familiar with designing MicroStrategy reports and
documents and have the necessary privileges to do so.

For information on designing MicroStrategy reports, see the Basic Reporting Guide.
For information on designing dashboard-style documents, see the Document
Creation Guide.

Best practices for designing reports and
documents for mobile devices

Designing a report or dashboard-style document that is viewed on iOS and Android
devices requires the use of device-specific document features. This section discusses best
practices for using these features.

Best practices for enhancing performance on a mobile
device
• Keep the report or document as focused as possible, by providing only the objects

necessary for an effective analysis.

• Consider using Intelligent Cubes to provide historical or trend data in your
documents. For background information on Intelligent Cubes, and instructions to
create reports based on Intelligent Cubes, see the In-memory Analytics Guide.

• To let users display subsets of data, group data in a document using features such as
page-by. Accessing a cached report or document that has multiple pages is faster
than re-prompting the report or document, which resubmits the job to the
Intelligence Server.

Best practices while planning reports and documents
• Sketch the documents you will use in your app and outline how users will navigate

between them. If you are creating an app for both tablets and mobile phones, you
may want to create multiple diagrams for your app, one for each screen size.
Diagramming the documents and links that need to be created allows you to identify:

▫ If you are creating an app that uses an existing dashboard-style document,
whether the content in that document needs to be reorganized to suit a smaller
screen.

▫ If you are creating an app with documents that contain a large amount of data,
consider splitting each document into multiple, smaller documents to reduce

https://www2.microstrategy.com/producthelp/10.7/BasicReporting/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/manuals/en/InMemoryAnalytics.pdf
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loading time. You can then use links to allow users to switch between the
documents.

▫ The navigation tools you must include. For example, you can include a tab bar on
the bottom of every document that links users to other documents or you can
allow users to navigate through documents by swiping right or left. For
descriptions of the navigation tools you can use, see Chapter 4, Using links in
documents.

▫ If users must tap on or swipe across an object, the size of those objects. In
general, objects that users are meant to tap on should be at least 30 pixels wide
and 30 pixels tall. For best results, make the objects larger, around 45 pixels wide
and 45 pixels tall.

▫ If you are creating an app or a document that links to other documents, the
order in which these documents must be built. Links must be created after the
document they target has already been created. For instructions on creating
links in mobile documents, see Chapter 4, Using links in documents.

▫ Where duplicate functionality exists. If two documents display different data
with the same formatting, you may be able to create one document, duplicate it,
and change the datasets to save development time.

▫ The datasets that are needed. One dataset can frequently supply data to multiple
documents, which can speed up development and reduce cache sizes on the
Intelligence Server.

▫ Any user interactivity you may want to include, such as widgets for data
visualization or changing the appearance of the app when the mobile device is
oriented in landscape mode instead of portrait.

• Consider the mobile device you are designing for:

▫ Create your documents using fonts that are available on the device.

▫ Ensure that the document displays correctly on the mobile device by defining
the display properties, available in the Properties dialog box. These properties
include optimizing the layout for display on a device, and whether the page-by
bar and re-prompt icon are displayed. For descriptions of these properties, see
Creating documents for mobile devices, page 24.

▫ Consider the size of the device’s screen when building your reports. Although
users can scroll through data, reports with fewer metrics improve performance
and are usually easier to read. In addition, take advantage of the larger screen
size available on tablet devices.

▫ Design documents for tablets such that users can view all the data in a single
screen without panning. If more data must be displayed than will fit on one
screen, consider using panel stacks to arrange the data such that the user can
navigate by swiping or using selectors.

▫ To take advantage of the high-resolution screens on newer iOS devices, consider
using large images in your documents.
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If the documents are for both older and newer mobile devices, add the
suffix @2x to the image’s file name. This ensures that the image is
appropriately resized for the older device. For example,
http://example.com/image@2x.png. For devices with very high-
resolution screens, such as the iPhone 6 Plus, use the suffix @3x.

▫ In documents for tablets, use Information Windows to show users additional
information about an attribute element they select. For information on creating
Information Windows, see Providing additional information to users:
Information Windows, page 38.

▫ In documents for tablets, use the Interactive Grid widget adjacent to a panel
stack, and use the Interactive Grid as a selector that targets the panel stack. This
allows users to view additional information without linking to a new document.

• In general, use at least 13-point size font. Font sizes that are greater than or equal to
13-point font are easier for readers to view.

• Images are easier to manage if they are hosted on a web server, and referenced using
HTTP or HTTPS URLs. That way, if you need to migrate images across
environments, you do not need to change the URLs for the images.

An example of an HTTP URL to an image is
http://example.com/folder/image.png.

• You can configure the mobile apps to pre-cache reports, documents, or dashboards,
so that they are available to users if they are offline. If the reports and documents
contain images, to ensure that the images are pre-cached, store the images on both
your Mobile Server and Intelligence Server machine. By default, the folders that you
can store your images in are:

▫ Mobile Server: C:\Program Files\MicroStrategy\Mobile Server
ASPx\Images

▫ Intelligence Server: C:\Program Files\MicroStrategy\Intelligence
Server\Images

When you add the images to your documents or dashboards, use relative paths for
the image’s location, for example, .\images\mobile_example.png.

• If the data in your document is frequently updated, you can have the document
periodically refresh itself as it is being displayed on a mobile device. For steps, see
Enabling automatic refresh for documents, page 35.

• In a Transaction Services document, you can submit a unique ID for a specific
mobile device, using the Mobile ID prompt. This allows you to keep track of which
mobile devices are creating which records. You can filter the transaction date by
Mobile ID.

The Mobile ID prompt is a system prompt, which is a special type of prompt that
does not require an answer from the user. Instead, it is answered automatically by
Intelligence Server. System prompts are located in the Public
Objects/Prompts/System Prompts folder in Developer. For background
information on system prompts in general, see the System Administration Guide.

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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• Use the docked panel selector to display visualizations grouped on panel stacks. For
information on creating docked panel selectors, see Allowing users to easily switch
between panels: docked panel selectors, page 37.

• For reports with data grouped by an attribute in the page-by pane, you can choose to
display the report on an iPad as a book with a separate page for each attribute
element. This option, called Enable book-style page-by navigation, is selected by
default. For steps to group data in a report, see the Basic Reporting Guide.

Best practices while creating reports and documents
• Consider using one of MicroStrategy’s pre-designed templates when creating

documents for a mobile device. The pre-designed templates take into account the
size of the device’s screen. For a list of pre-designed templates, see Creating
documents for mobile devices using a template, page 25.

• Enable drilling to give users the ability to view information at different levels within a
single report. Drilling allows users to get more information from one report without
having to browse to, and run, other reports.

• When designing graph reports to be used on a mobile device, consider the following:

▫ To display tooltips on mobile devices, enable tooltips for the graph series while
creating the graph. For steps, see the Basic Reporting Guide.

▫ To maximize the graph size, move the legend below the graph.

▫ The following graph types are supported on Android devices:

— Bubble

— Funnel

— Gauges

— Horizontal Area

— Horizontal Bar

— Horizontal Line

— Pareto

— Pie

— Scatter

— Vertical Area

— Vertical Bar

— Vertical Line

▫ If you must display more information than can fit on one screen, use page-bys to
break the graph in logical places across multiple screens.

https://www2.microstrategy.com/producthelp/10.7/BasicReporting/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/BasicReporting/WebHelp/Lang_1033/index.htm
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• When designing grid reports, add padding around the cells to make the data more
legible on mobile devices.

• Because Android devices come in varying screen sizes, a document designed for iOS
may appear different when viewed on an Android device. To adapt a document’s
display to an Android device, while leaving the display on an iOS device unaffected,
use the following properties to modify the document:

▫ Use the Fit Page or Fit Width options to ensure that the document fits to the
size of the screen. Before selecting one of these Zoom options on the Home
toolbar, optimize the layout for micro applications. For steps, see Formatting
document tabs: layouts, page 31.

▫ By default, when the document is displayed on an Android device, any area not
used to display the document is rendered in the same color as the background
color defined for the document. You can use the Document Fill Color or Layout
Watermark to provide a background for any part of the screen that is not used by
the rest of the document.

▫ Manually size the column widths of any grids on a document, rather than using
the automatic resizing options.

• Consider using Mobile Views to support different screen sizes, and different
orientations of the device. For instructions on using Mobile Views, see Formatting
documents for various screen sizes and different orientations: Mobile Views, page
27.

• Consider creating documents that include widgets, rather than converting reports to
widgets. Certain features, such as Information Windows and network lines for the
Map widget, can only be used in documents.

For steps to create widgets in documents, see Chapter 3, Displaying data as
interactive visualizations: Widgets.

• If you are creating an Interactive Grid widget, it is recommended that you assign an
action to only one attribute form in the widget. For example, if you want one
attribute to act as a selector, ensure that drilling is disabled for the Grid/Graph, and
that attributes on the Grid/Graph do not link to other reports or documents.

For steps to create an Interactive Grid widget, see Displaying data in rows and
columns: Interactive Grid widget, page 90.

• Consider using links to add interactivity to your document. For example, you can
create links that allow users to send an email, make a phone call, or execute related
reports and documents. For information and the steps to create links, see Opening a
device’s installed applications from documents, page 132 and Linking to reports and
documents from a mobile document, page 138.

• If you have prompts in a linked-to report, make sure that there are default answers
saved for the prompts.
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Best practices while creating reports and documents
for the iPhone 5
The iPhone 5 has a different aspect ratio than the iPhone 4. To ensure that your reports
and documents display correctly on an iPhone 5, follow the best practices below:

• By default, reports and documents displayed on the iPhone 5 are displayed with
black bars on the edges to fill the screen. If you design your reports and documents
to fill the iPhone 5 screen, you can create an iPhone configuration that enables the
iPhone 5 to display them on the entire screen. For steps, see Configuring
MicroStrategy Mobile for iPhone or iPad, page 186.

• You can use Mobile Views to support documents that need to be displayed on both
the iPhone 4 and the iPhone 5. You can size each layout according to the phone’s
screen size. This is the recommended approach if you are designing for both the
iPhone 4 and iPhone 5. For instructions on using Mobile Views, see Formatting
documents for various screen sizes and different orientations: Mobile Views, page
27.

• You can dock objects at the top or bottom of the screen as an alternative to Mobile
Views. If you design the content that displays in the middle of the screen to fit the
iPhone 5, that content will scroll when viewed on an iPhone 4. If you design the
content that displays in the middle of the screen to fit the iPhone 4, empty space will
be displayed when viewed on an iPhone 5. This allows you to use a single view for
both devices. However, using multiple views is recommended, so that the users do
not experience additional scrolling or empty space.

To dock an object at the top of the screen, insert the object in the page header
section of the document. In the Properties and Formatting dialog box for the
section, select the Dock to top of screen (Mobile only) check box. When the
document is displayed on a mobile device, the docked page header is always displayed
at the top of the screen, remaining in place as the user scrolls up or down in the
document.

Similarly, to dock an object at the bottom of the screen, insert the object in the page
footer section. In the Properties and Formatting dialog box for the section, select the
Dock to bottom of screen (Mobile only) check box.

Creating documents for mobile devices
This section describes the ways in which you can design dashboard-style documents for
iOS- and Android-based devices, and to use features specifically designed for some
devices.

If you are creating an app, you can use dashboard-style documents as the pages and
panels of your app and create links on buttons and tab bars in your documents to allow
users to navigate to other pages or panels in the app. For steps, see Chapter 4, Using
links in documents.
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This section assumes that you have created a document with the datasets that you want
to analyze. For steps to create a document, refer to the Report Services Document
Creation Guide.

Creating documents for mobile devices using a
template
A document template allows you to start with a predefined structure when you create a
new document. You can use several predesigned templates for your mobile documents to
help you create documents that are correctly sized for the device’s screen, as described
below.

The following templates are optimized for display on iPhone and Android smart phones:

• iPhone Portrait: This template is designed to be viewed on an iPhone or Android
smart phone held in a vertical position. Only the Detail Header section of the
document is displayed.

▫ Width: 6.6 inches

▫ Height: 9.6 inches, which includes room for the smart phone’s status bar

▫ Supported orientation: Portrait only

▫ Graph tooltips displayed: Yes

• iPhone Portrait Micro-Application: This template is the same as the iPhone
Portrait template, except that the Optimize layout for micro application option is
selected, preventing users from performing actions such as zooming in or out of the
document. This allows you to better control the user’s experience and interaction
with the document.

• iPhone Landscape: This template is designed to be viewed on an iPhone or
Android smart phone held in a horizontal position. Only the Detail Header section of
the document is displayed.

▫ Width: 10 inches. The smart phone’s status bar is not displayed in landscape
view.

▫ Height: 6.6 inches

▫ Supported orientation: Landscape only

▫ Graph tooltips displayed: Yes

• iPhone Landscape Micro-Application: This template is the same as the iPhone
Landscape template, except that the Optimize layout for micro application option is
selected, preventing users from performing actions such as zooming in or out of the
document. This allows you to better control the user’s experience and interaction
with the document.

• iPhone Map Information Window: You can define an Information Window for
a Map widget to be displayed on an iPhone or Android smartphone, to display
additional information when a user taps a map marker in the widget. Use this
template to create a document layout for use as an Information Window. For
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detailed steps, see Using a layout as an Information Window in a Map widget, page
100.

▫ Width: 3 inches

▫ Height: 2 inches

The following templates are optimized for display on iPad and Android tablets:

• iPad Portrait: This template is designed to be viewed on an iPad or Android tablet
held in a vertical position. Only one section of the document is displayed.

▫ Width: 8 inches

▫ Height: 10 inches, which includes room for the tablet’s status bar

▫ Supported orientation: Portrait only

• iPad Landscape: This template is designed to be viewed on an iPad or Android
tablet held in a horizontal position. Only one section of the document is displayed.

▫ Width: 10.67 inches

▫ Height: 7.33 inches

▫ Supported orientation: Landscape only

For documents displayed on an iOS device, you can create a navigation document, which
contains only a tab bar. A tab bar displays a series of buttons, which users can tap to
navigate through the documents in your app. Use the following templates to create a
navigation document. For steps and examples, see Linking from documents with buttons
and tab bars, page 152.

• Navigation for iPad: This template is designed to create a navigation document
for iPads.

• Navigation for iPhone: This template is designed to create a navigation document
for iPhones.

Formatting documents for mobile devices
You can ensure that the document displays correctly on mobile devices by defining the
display properties, such as whether the document layout is optimized for mobile phones,
and whether the page-by bar and re-prompt icon are displayed.

You can format the display properties at the following levels:

• For each Mobile View. You can create Mobile Views to define how your document
appears on different devices, and for different orientations of the device. For
example, you can size a graph so that it takes up less vertical space when displayed in
landscape orientation on a device. For instructions to define Mobile Views, see
Formatting documents for various screen sizes and different orientations: Mobile
Views, page 27.

• In multi-layout documents, for each document layout. For descriptions of the layout
display properties, see Formatting document tabs: layouts, page 31 and Disabling
swiping between layouts in iOS documents, page 33.
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You must use MicroStrategy Web to define these properties. For instructions, see the
steps below.

Formatting documents for various screen sizes and different
orientations: Mobile Views

You can specify how to display documents on iPhone, iPad, and Android devices by using
Mobile Views. Mobile Views allow you to quickly and easily determine how the elements
of a document are displayed in the following scenarios:

• When users rotate their devices. For example, you can resize a graph to take
advantage of the extra horizontal space when the device is held in landscape
orientation, or rearrange the controls on the document to accommodate the extra
vertical space when the mobile device is held in portrait orientation.

• When users access the same document from different devices, which may have
different screen sizes. For example, you can size text to take up less room on a
mobile phone in one Mobile View, or enlarge an image to fit a tablet in another
Mobile View. The document is automatically displayed using the Mobile View that
most closely matches the height and width (resolution) of the device’s screen.

• When users access the same document on an iPhone 4 and an iPhone 5, which have
different screen sizes. You can create a view for each device, with the corresponding
layout height. The objects on each layout can have different sizes and positions.

When you use a Mobile View, controls in the document keep the same basic settings
when displayed in different Mobile Views. For example, a selector containing a list of
regions targets a graph displaying revenue data. If the user selects the Southeast region
from the selector, revenue information for Southeast is displayed in the graph. When the
user rotates the mobile device and the document is displayed using a different Mobile
View, Southeast remains selected and the data displayed in the graph is unchanged.

Parameters you can change in Mobile Views

Once you have added a Mobile View to a document, you can do the following:

• Display a preview of the Mobile View in Design Mode or Editable Mode in Web.

• Edit controls in the Mobile View. You can edit the following options for a control
independently in each Mobile View:

Editing any option that is not included in the list below also edits this property
for all other Mobile Views in the document. For example, if you change the
background color of a document section to green in one Mobile View, the
section is displayed as green in all other Mobile Views.

▫ The position of the control in the document

▫ The height and width of the control

▫ The height of the control's title bar (for Grid/Graphs, panel stacks, and
selectors)
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▫ Whether the control is hidden. You can determine whether a control will be
visible when the Mobile View is displayed on a mobile device. All controls in the
document must be included in each Mobile View you define. However, you can
hide a control in an individual Mobile View to prevent it from being displayed
when the document is viewed on a mobile device. For steps to determine
whether a control is visible, see the Document Creation Guide.

For example, you want to create two Mobile Views, but only want to display a
specific grid in the Mobile View for a single mobile device. You must hide the
grid in the Mobile View in which you do not want the grid to be displayed.

▫ Whether the height and width of the control are automatically determined or are
fixed at a specific size

▫ The height of a document section

▫ Whether a document section can grow or shrink to fit its contents

▫ Whether to hide a document section if it has no content

• Show or hide all controls in the document in Design Mode, regardless of whether
they are shown when the document is displayed on a mobile device.

By default, the mobile device tries to display a document using the Mobile View that
matches the exact height and width of the device’s screen. If there is more than one
Mobile View with the same height and width as the mobile device’s screen, the first of
these Mobile Views, as listed in the Manage Views Editor, is used. Otherwise, the mobile
device displays the Mobile View whose width most closely matches the width of the
mobile device’s screen.

Using Mobile Views with multi-layout documents

Documents can contain multiple layouts. When you create a Mobile View, it is
automatically available to every layout in the document.

For example, a multi-layout document contains three layouts. If you create a Mobile
View to determine how the document is shown on an iPhone, you must edit the controls
in each layout to define how the layouts will be displayed. You can use the Orientation
option for Mobile Views in conjunction with the Supported Orientation option for
document layouts to determine how a mobile device chooses the best Mobile View to use
to display a document layout, as follows:

• If the Supported Orientation of the document layout is set to Both Portrait and
Landscape, the document layout is displayed using the Mobile View that most closely
matches the height and width of the mobile device, as well as the orientation in
which the mobile device is held.

For example, if the mobile device is held vertically, the mobile device attempts to
display the document layout using the Mobile View that has Orientation set to
Portrait or Portrait and Landscape, and most closely matches the height and width
of the device. If only Mobile Views designed to be displayed in landscape orientation
have been defined for the layout, the mobile device chooses the best Mobile View
from among those defined and rotates the Mobile View to be displayed vertically, to
match the orientation of the mobile device.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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• If the Supported Orientation of the document layout is set to either Portrait Only or
Landscape Only, the document layout is displayed using the Mobile View that most
closely matches the height and width of the mobile device, as well as the Supported
Orientation of the layout.

For example, if the Supported Orientation is Portrait Only, the mobile device
attempts to display the document layout using the Mobile View that has Orientation
set to Portrait or Portrait and Landscape, and most closely matches the height and
width of the mobile device. If only Mobile Views designed to be displayed in
landscape orientation have been defined for the layout, the mobile device chooses
the best Mobile View from among those defined and displays the Mobile View
vertically, to match the Supported Orientation of the document layout. The Mobile
View is locked to the same orientation as the Supported Orientation option, meaning
that if the Supported Orientation is set to Portrait Only and a Mobile View is
displayed vertically on the mobile device, the orientation of the layout as displayed on
the mobile device remains the same and does not rotate regardless of whether the
user rotates the mobile device.

When a document is viewed on the iPhone, the Supported Orientation option
determines which layout is displayed on the mobile device. The mobile device
then determines the best Mobile View to use to display the layout. For more
information on the Supported Orientation setting, see theMicroStrategy Web
Help.

To define a Mobile View in a document

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 From the Tools menu, selectManage Views. The Manage Views Editor opens.

A default Mobile View is automatically displayed in the list of Mobile Views,
and cannot be deleted.

3 Click the Duplicate icon next to an existing Mobile View. A new Mobile View is
automatically created.

4 In the Name field, type a name for the new Mobile View.

5 Under the Resolution column, specify the height and width of the mobile device
screen on which to display the Mobile View, as follows:

a In the first field, type the width, in pixels, of the device screen.

b In the second field, type the height, in pixels, of the device screen.

6 You can specify whether the Mobile View is designed to be displayed on a mobile
device when the device is held vertically or horizontally. From the Orientation
drop-down list, select one of the following:

• To display the Mobile View when the device is held vertically, select Portrait
Only.
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• To display the Mobile View when the device is held horizontally, select
Landscape Only.

• To display the Mobile View when the device is held vertically or horizontally,
select Portrait and Landscape.

7 Repeat the appropriate steps above to define each Mobile View.

8 You can determine which Mobile View to display in Design Mode when the
document layout is displayed in Web. Under the Current column, select the Mobile
View to display.

9 To delete an existing Mobile View, click the Delete icon next to the Mobile View to
delete.

10 You can choose to show all controls in Design Mode in Web, regardless of whether
they are marked as hidden. For example, you design a Mobile View to be displayed
on the iPhone. The Mobile View contains several controls that will be displayed on
the iPhone, as well as a grid that is marked as hidden and will not be displayed. You
can choose to display all the controls in Design Mode, including the grid. Do one of
the following:

• To display all controls in the layout in Design Mode, regardless of whether they
are hidden, select the Show hidden objects in Design Mode check box.

• To display only the controls that are specified as not hidden, clear the Show
hidden objects in Design Mode check box.

11 Click OK to save your changes.

12 Add controls to the document, such as text fields, images, graphs, and so on. For
steps to add controls to a document, see the Document Creation Guide. When you
add a new control to the document, a message is displayed asking if you would like to
make the control visible in all Mobile Views. Do one of the following:

• To make the control visible in all views, select Yes.

• To make the control visible in only the current Mobile View, select No.

• To remove a control from a Mobile View, select the control, and press Delete. A
message is displayed asking you if you want to delete the control from the
document. To hide the control from the current Mobile View, while keeping it
visible in all other Mobile Views, select No.

To determine which Mobile View to display in Web

13 From the Tools menu, selectManage Views. The Manage Views editor opens.

14 Under the Current column, select the Mobile View you want to display.

15 Click OK to save your changes.

To delete a Mobile View from a document

16 From the Tools menu, selectManage Views. The Manage Views editor opens.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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17 Click the Delete icon next to the Mobile View you want to delete.

18 Click OK to save your changes.

Formatting document tabs: layouts

Each layout in a document can be defined to display on an iPhone, iPad, or Android
device independently of other layouts within the same document. Steps are provided
below to format a document layout for mobile devices.

For an introduction to multi-layout documents, see the Document Creation Guide.

To define how tabs in a document display on mobile devices

1 In MicroStrategy Web, open the document in Design Mode.

2 From the Tools menu, select Layout. The Properties dialog box opens.

3 From the left, under Layout Properties, clickMobile. You can define the following
display options:

• From the Supported Orientations drop-down list, select which orientations
you want the layout to support:

▫ Portrait Only (height is greater than width)

▫ Landscape Only (width is greater than height)

▫ Portrait and Landscape

4 You can also define the following display options for documents:

• To allow users to filter the display of the document by tapping a page-by element
from the page-by bar, select the Display page-by interface check box.

• To allow users to change their prompt answers, select the Display filter
interface check box. The Filter button displays on the layout.

• To use a layout as an Information Window in a Map widget, select the Use as
Information Window for the Map widget check box.

An Information Window is a small pop-up window that provides additional
details about a location. It is displayed when a user selects a map marker in a
Map widget. For more information, see Using a layout as an Information
Window in a Map widget, page 100.

If the document is to be displayed on multiple devices, it is recommended
that you use a panel stack as the Information Window. For information,
see Providing additional information to users: Information Windows,
page 38.

• To prevent Android users from performing actions such as scrolling in the
document, choose Optimize layout for micro application. Optimizing the

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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layout for a micro-application prevents allows you to better control the user’s
experience and interaction with the document.

Selecting this option allows you to size the layout for Android devices to fit the
page or the width of the device's screen. When a user views the document on an
Android device, a fit-to-page layout is zoomed and displayed within the screen,
so that he does not need to scroll vertically or horizontally to view any data. A
fit-to-width layout is zoomed to the width of the screen, so that a user does not
need to scroll horizontally to view any data. To do this, complete the following
steps:

a Select Optimize layout for micro application.

b Click Apply.

c On theHome toolbar, select either Fit Page or Fit Width from the
Zoom drop-down list.

5 You can choose to always open a document in full screen mode. From the left, under
Document Properties, click Document, and select the Always open this
document in full screen mode check box.

Documents displayed on an iPhone in landscape orientation are automatically
displayed in full screen mode.

When documents are displayed in full screen mode, the navigation bars and action
menu are hidden. You can control whether users can access the hidden navigation
bars and action menu.

• To display the navigation bars and action menu when users tap on the full screen
button at the top of the app, select the Allow users to access navigation
bars and action menu check box (default).

• To prevent users from accessing the navigation bars and access menu, clear the
Allow users to access navigation bars and action menu check box.

▫ On the iPad, users are also unable to access the layout bar, which displays
the different tabs in the document.

▫ On the iPhone in landscape orientation, users are unable to access the layout
bar, which displays the different tabs in the document, and the page-by bar.
In Portrait orientation, users can access both.

Consider doing this when you want to control how users exit and interact with
the document, such as when the document is part of a custom mobile app with
its own navigation system.

To allow users to perform actions that would normally be done in the action
menu, you can create a link in the document that performs the same action. For
example, to allow users to exit the document, you can create a link in the
document that opens another document or sends them to a different screen in
the app, such as the Home page. For steps, see Using links to access features
within the MicroStrategy Mobile application, page 150.

6 Click OK. The Properties dialog box closes.
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Disabling swiping between layouts in iOS documents

By default, users can navigate between layouts in a document by swiping to the left or
right. On an iPad or iPhone, you can disable this default so that users must use the layout
bar to navigate between layouts.

To disable swiping between layouts in documents on iOS devices

1 In MicroStrategy Web, open the document in Design Mode.

2 From the Tools menu, select Document Properties. The Properties dialog box
opens.

3 From the left, under the Document Properties section, clickMobile.

4 Do one of the following:

• To allow users to swipe between pages or select an option in the layout bar to
display a report or document, select the Enable swiping to switch layout
check box (default).

• To disable swiping between layouts and have users switch layout by tapping the
layout’s name in the layout bar, clear the Enable swiping to switch layout
check box.

5 To enable graph tooltips on the device, select the Enable graph tooltips check
box.

6 Click Apply. The Properties dialog box closes.

Displaying documents on iOS devices with a dark or light theme

On the iPad and iPhone, you can choose whether documents use a dark or light theme.
In the image shown below, the document on the left is using the dark theme, while the
document on the right is using the light theme.
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A document’s theme controls the colors of its title bar, menu, and may also control the
colors of the widgets in the document.

You may want to choose the dark theme if the document’s background is also dark, so
that the title bar and menu match the document. Similarly, if the document’s
background is light, you may want to choose the light theme.

You can also display documents with the same theme the app is using. By default, Mobile
apps use the dark theme.

To choose which theme a document displayed on the iPad or iPhone
uses

1 In MicroStrategy Web, open the document in Design Mode.

2 From the Tools menu, select Document Properties. The Properties dialog box
opens.

3 From the left, under the Document Properties area, selectMobile.

4 From the Document theme color drop-down list, select one of the following:

• If you want the document and its widgets to use the same theme as the rest of
the Mobile app, select Application theme color (default).

• If you want the document to always use the dark theme, select Dark.

• If you want the document to always use the light theme, select Light.
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Enabling automatic refresh for documents

For iPhone, iPad, and Android devices, you can define whether the document refreshes
itself as it is being displayed on a mobile device. Automatic refresh is helpful if the data is
frequently updated.

Automatic refresh also applies to documents viewed in Express Mode in
MicroStrategy Web.

To enable automatic refresh in an iOS or Android document

1 In MicroStrategy Web, open the document in Design Mode.

2 From the Tools menu, select Document Properties. The Properties dialog box
opens.

3 From the left, under the Document Properties section, click Advanced.

4 Select the Automatically Refresh check box.

5 In the field, type the amount of time, in seconds, to wait before each refresh.

6 Click OK. The Properties dialog box closes.

Enabling zoom for iOS documents

For the iPhone and iPad, you can define whether you can zoom in and out of the
document by pinching and double-tapping.

To enable zooming in an iOS document

1 In MicroStrategy Web, open the document in Design Mode.

2 From the Tools menu, select Document Properties.. The Properties dialog box
opens.

3 From the left, under the Document Properties section, clickMobile.

4 Select the Enable zoom (pinch and double-tap) check box.

5 Click OK. The Properties dialog box closes.

Creating an image watermark for an Android document

An image watermark is a faint design appearing in the background of a document. A
watermark typically identifies or decorates pages. For example, a business logo can
appear in the background of an Android document.
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To create an image watermark for an Android document

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 From the Tools menu, select Document Properties. The Properties dialog box
opens.

3 To make the background of the document transparent:

a From the left, select Color and Borders.

b From the Color drop-down list, select No Fill.

4 From the left, selectWatermark.

5 To create an image watermark:

a From theWatermark drop-down list, select Image watermark.

The image file must be available to both the Intelligence Server and to the
designers of the document.

b Type the path and file name of the image in the Source field.

c By default, the image is automatically resized to fit within the document margins
while retaining its aspect ratio. To scale the image manually, select a percentage
from the Scale drop-down list.

6 Click OK to return to the document.

Allowing users to access information easily: mobile-
friendly panel stacks
In addition to the standard features supported by panels in documents, you can use the
following features to make viewing data in your app easy for users:

• Allow users to easily switch between panels by tapping on circles displayed in a
docked panel selector that appears at the bottom of a panel stack. See Allowing users
to easily switch between panels: docked panel selectors, page 37.

• Allow users to switch between panels by swiping. See Allowing users to switch
panels by swiping, page 38.

• Save screen space by using an Information Window, which is a pop-up window that
can display additional details when users tap a selector in a document or a marker in
a map widget. See Providing additional information to users: Information
Windows, page 38.

• In documents for iPad, determine whether a panel stack resets to the first panel
when an attribute selector that targets the panel stack is changed. See Resetting
panel stacks when selectors are changed, page 48.
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Allowing users to easily switch between panels: docked panel
selectors

A docked panel selector allows users to switch between panels by tapping on circles
displayed on a selector bar that appears at the bottom of a panel stack. An example of a
panel with a docked selector on the iPad is shown below:

A row of circles, each representing a panel, is displayed in the center of the selector. The
current panel is marked with a dark circle.

You can use a docked panel selector in an app to display multiple graphs or widgets in
one space. You can also use the docked panel selector with a panel stack to create an
interactive slide show, where the information in one panel progresses naturally to the
information displayed in the next.

The steps to create a docked panel selector are described below.

To create a docked panel selector

1 In MicroStrategy Web, create a new document, or open an existing document in
Design Mode.

2 From the Insert menu, choose Panel Stack. When you move the mouse cursor to
the Layout area, the pointer changes to crosshair.

3 Click and drag in the Layout area to create the panel stack.

To create and configure a selector for the panel stack

4 Right-click the panel stack, and choose Create Panel Selector. A drop-down
selector appears above the panel stack.

5 Right-click the panel selector and choose Properties and Formatting. The
Properties and Formatting dialog box appears.

6 From the left, choose the Selector category.
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7 UnderMobile, ensure that the Display selector docked to its panel stack
check box is enabled.

8 Click OK to save the changes.

To add panels and content to the panel stack

9 Hover the mouse cursor over the panel stack. A toolbar appears above the panel
stack.

10 Click Add Panel to add panels to the stack.

11 For each panel, click Add Content, and add grids or graphs to the panel.

Allowing users to switch panels by swiping

You can allow users to change panels in a panel stack by swiping the device’s screen to
move to the next or previous panel.

Prerequisites

This procedure assumes that you have created a document with the following:

• A panel stack. For steps to add panel stacks to documents, see the Dashboards and
Widgets Creation Guide.

• A selector that targets the panel stack. For steps to add selectors to documents, see
the Dashboards and Widgets Creation Guide.

To allow users to switch panels by swiping

1 Open the document in Design or Editable Mode.

2 Right-click the panel stack with the docked panel selector and select Properties
and Formatting. The Properties and Formatting dialog box opens.

3 From the left, select General.

4 Select the Allow current panel to be changed without selector check box.

5 Click OK to return to the document.

Providing additional information to users: Information Windows

Information Windows let users view additional information about a specific object by
tapping it. A pop-up window displays the additional information. A user can display an
Information Window by tapping:

• An attribute element in a grid or graph.

• A button.

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
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• An image.

• An item in a selector.

• An object in a widget. For example, a user can tap a store’s location in a Map widget
to display the store’s address, phone number, and ratings.

• A text field.

An Information Window is a panel stack that is configured to appear as a pop-up window
over the selected object, displaying an additional visualization or additional information
based on the selected object. An example of an Information Window in an iPad
document is shown below:

You can customize the data that displays in an Information Window depending on the
content of the selected object by using the object as a selector. In the above example, the
Subcategory column in the grid is used as a selector. When a user taps an element in the
column, the Information Window is displayed with data specific to that attribute
element.

You can also use an Information Window as a navigational menu that displays when a
user clicks on a button in the page. For example, in the MicroStrategy Mobile demo app
below, an Information Window is used to display a list of useful links within the app. The
Information Window is configured to slide in from the left side of the screen when the
user clicks a menu button in the app.
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To use an Information Window in a document, you must do one of the following:

• Define a panel stack to be used as the Information Window, and a Grid/Graph or
selector that uses the panel stack as an Information Window, as described in To
define an Information Window for a Grid/Graph or a selector in a mobile
document, page 40.

• Define a panel stack to be used as the Information Window, and a text field, image,
or button that uses the panel stack as an Information Window, as described in To
define an Information Window for a text field, an image, or a button in a mobile
document, page 43.

You can specify how the Information Window is displayed, by specifying how it opens
(for example, it can slide in from the right), how it closes (using a Close button or tapping
outside the window), its location, and its opacity. For examples of the different options
and steps to specify them, see Specifying the display of an Information Window on an
iPad or iPhone, page 44.

To define an Information Window for a Grid/Graph or a selector in a
mobile document

1 In MicroStrategy Web, navigate to the document to add an Information Window to.
The document must contain a Grid/Graph or a selector, which must contain data
related to the data to be placed on the panel stack. This procedure includes steps to
add a selector; for steps to create a Grid/Graph, see the Dashboards and Widgets
Creation Guide.

For example, the document shown below contains a basic grid:

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
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2 Open the document in Design Mode.

To define the panel stack for the Information Window

3 From the Insert menu, choose Panel Stack. When you move the cursor into the
Layout area, the pointer becomes a crosshair.

4 Click and drag anywhere in the Layout area to create the panel stack. The panel stack
is added to the document.

5 Right-click the panel stack, and select Properties and Formatting. The
Properties and Formatting dialog box opens.

6 From the left, click General, then type an appropriate name for the panel stack in
the Name field. This name appears as the title of the Information Window on the
mobile device.

7 Select the Use as Information Window check box.

8 Click OK to save the changes.

9 Add data related to the Grid/Graph to the Grid/Graph or selector.

For example, in the document above, a pie chart representation of Revenue for each
Year is added to the panel stack, as shown below:



Mobile Design and Administration Guide

© 2017, MicroStrategy Inc. 42

10 Do one of the following:

• If you are using a Grid/Graph, define the Grid/Graph as a selector. Follow the
steps below:

a In the report grid, right-click the attribute you want to use as the selector,
and choose Use as Selector. MicroStrategy Web automatically attempts to
find targets for the selector.

In the above example, the Region attribute is used as a selector for the
Information Window.

b To verify that the selector targets the Information Window, right-click the
attribute again, and choose Edit Selector. The Configure Selector dialog
box appears, as shown below.

c In the Selected Targets list, ensure that the Information Window panel
appears in the list.

d Click OK.

• If you are using a selector, create the selector to target the panel used as an
Information Window. Follow the steps below:

a Click the arrow next to the Selector Control icon on the Controls
toolbar, and then choose how to display the selector from the drop-down
list. When you move the mouse to the layout area, the pointer becomes
crosshairs.

b Click the section of the Layout area in which to place the selector. If you
click and drag in the section, you can size the selector.

c Right-click the selector and select Properties and Formatting. The
Properties and Formatting dialog box opens.

d From the left, choose Selector.
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e Select an attribute, custom group, or consolidation in the Source field. The
elements of the source are displayed as items in the selector.

f In the Selected list, ensure that the Information Window panel appears in
the list.

g Click OK.

11 Save the document.

For the example above, when the document is executed on an iPad, the Information
Window appears when the user taps an element in the Region column, as shown
below:

To define an Information Window for a text field, an image, or a button
in a mobile document

1 In MicroStrategy Web, navigate to the document to add an Information Window to.

2 Open the document in Design Mode.

To create the panel stack for the Information Window

3 From the Insert menu, choose Panel Stack. When you move the cursor into the
Layout area, the pointer becomes a crosshair.

4 Click and drag anywhere in the Layout area to create the panel stack. The panel stack
is added to the document.

5 Right-click the panel stack, and select Properties and Formatting. The
Properties and Formatting dialog box opens.
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6 From the left, click General, then type an appropriate name for the panel stack in
the Name field. This name appears as the title of the Information Window on the
mobile device.

7 Click OK to save the changes.

8 Add controls to the panel stack, such as Grid/Graphs or text fields.

To define the text field, image, or button that uses the Information Window

9 Add a text field, image, or button to the panel stack.

10 Right-click the text field or image, and select Properties and Formatting. The
Properties and Formatting dialog box opens.

11 From the left, click General.

12 From the Panel Stack drop-down list, select the panel stack to use as the
Information Window.

13 Click OK to save your changes.

14 Save the document.

Specifying the display of an Information Window on an iPad or iPhone

You can specify how an Information Window opens on an iPad or iPhone: by popping
up over the document, flipping up (like turning over a card), increasing in size, or sliding
in from an edge of the screen.

You can display a Close button on the Information Window or have it close when the
user taps outside the Information Window.

An Information Window can display in the best position automatically, at the position of
the panel stack, above or below the selected object, or to the right or left of the selected
object.

You can specify the transparency of the Information Window.

You specify these options by defining:

• The window Mode, which is how the Information Window opens (pop up, flip up,
scale, or slide)

• Whether the Close button is displayed

For pop-up Information Windows, you can specify the placement, or position, of the
Information Window.

• A flip-up or scaling Information Window displays in the center of the screen.

• A sliding Information Window displays at the edge that it slid from.

In the document below, a user can tap the buttons on the left to display Information
Windows.
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Each Information Window is formatted differently. If a user taps the KPI button, an
Information Window without a Close button pops up. The user can tap anywhere outside
of the Information Window to close it.
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If the user taps the Task Logger button, the Task Logger Information Window pops up.
Notice that a Close button is displayed.

When the user taps the Profit Forecast button, the Profit Forecast Information Window
slides in from the right.
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To specify how an Information Window displays on iPads and iPhones

1 In Web, open the document in Design Mode.

2 Right-click the panel stack that is used as an Information Window, and select
Properties and Formatting.

3 From the left, choose the General category.

4 To specify how to open the Information Window, select one of the following
Window mode options:

• To open the Information Window by popping it up, select Appear. (This is the
default.)

• To open the Information Window by flipping it up, like turning over a card,
select Flip Up.

• To open the Information Window by gradually increasing its size, select Scale
Up.

• To open the Information Window by sliding it from an edge of the screen, select
Slide.

5 If you selected Appear as the Window Mode, you can specify the location of the
Information Window. Select one of the following options from the Placement
drop-down list:

• To display the Information Window in the best position, select Automatic.
(This is the default.)

• To display the Information Window at the position of the panel stack, select
Fixed.

• To display the Information Window above the selected object (for example, the
item in the selector or the attribute in the grid), select Above.

• To display the Information Window below the selected object, select Below.

• To display the Information Window to the left of the selected object, select Left.

• To display the Information Window to the right of the selected object, select
Right.

6 If you selected Slide as the Window Mode, you can specify which edge to slide the
Information Window from. Select one of the following options from the Position
drop-down list:

• Right (the default)

• Left

• Above

• Below
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7 By default, Information Windows on an iPhone fill the screen when they display. To
scale the Information Window so it is the same size on the iPhone as in Web, select
the Display in partial screen per panel stack size on mobile phone check
box.

Information Windows on an iPad automatically scale so they are the same size as in
Web.

• If you selected Slide as the Window Mode, you can specify how much of the
Information Window initially displays. Users can then drag the Information
Window out to view the rest of the Information Window. Do one of the
following:

▫ If you selected Right or Left as the Information Window’s position, specify
how much of the Information Window’s left or right side displays,
respectively. Type the value, in inches, in the Initial sliding in width
field.

To display the full Information Window, type 0 (default).

▫ If you selected Above or Below as the Information Window’s position,
specify how much of the Information Window’s bottom or top side displays,
respectively. Type the value, in inches, in the Initial sliding in height
field.

To display the full Information Window, type 0 (default).

8 By default, the Information Window is closed when a user taps outside of the
Information Window. To close the Information Window by tapping a button instead,
select the Dismiss only when ‘Close’ button is tapped check box.

9 If the Information Window is set to open by flipping, increasing in size, or sliding
into the screen, you can define how transparent the Information Window displays.
Do the following:

a From the left, select Effects.

b In the Transparency field, type a percentage. A higher value displays the
Information Window as more transparent, while a lower value displays the
Information Window as more solid. The default value is 0.

c To blur the sections of the document that show through the transparent
Information Window, select Enable blur effect.

10 Click OK to save your changes and return to the document.

Resetting panel stacks when selectors are changed

In documents for iPad, you can determine whether a panel stack resets to the first panel
when an attribute selector that targets the panel stack is changed. By default, the current
panel (the panel that is displayed) does not change when an attribute selector is changed.
The steps to enable this option follow.
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To determine whether a panel stack resets when a selector is
changed

1 In MicroStrategy Web, open the document in Design Mode.

2 Right-click the panel stack, and select Properties and Formatting.

3 In the General category, select the Reset to first panel when targeted
(Mobile only) check box.

4 Click OK to save your changes.

Allowing users easy access to document content:
docked headers and footers
You can ensure that users always have access to a section of content in a mobile
document by adding the content to a docked page header or page footer. The content of
a docked page header is always displayed at the top of the screen, while a docked page
footer is always displayed at the bottom, regardless of screen size. Docked headers and
footers remain in the same place on the screen as the user scrolls up or down in the
document, allowing the user easy access to the footer’s content.

Some examples of how you can use docked headers and footers are:

• To display important information, such as the name of your company, project, or
app, copyright information, or contact information.

• To create a navigation bar of useful links. Do this if you want to create a custom
navigation bar instead of the tab bar MicroStrategy provides. For steps to create a tab
bar, see Creating a tab bar to hold buttons, page 155.

Steps are below to define a docked page header or page footer.

To dock a header or footer to the top or bottom of a document

1 Right-click the page header or page footer section that you want to define as docked,
then select Properties and Formatting. The Properties and Formatting dialog
box opens.

2 From the left, click General in the Properties section. Do one of the following:

• To display the page header or page footer as an ordinary header or footer that is
not docked to the top or bottom of the document, clear the Dock to top of
screen (Mobile only) check box or the Dock to bottom of screen
(Mobile only) check box

• To display the page header or page footer as docked, select the Dock to top of
screen (Mobile only) check box or the Dock to bottom of screen
(Mobile only) check box.
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Allowing users to copy text from documents on iOS
devices
On an iPad or iPhone, a user can copy text from a document, by tapping and holding the
text to copy. If zoom is disabled, a user can also double-tap the text.

If the document uses a document template other than an iPad or iPhone template, the
document may use a Detail section. The Detail section of a document displays one row
for each row of data in the document’s dataset. (For descriptions and examples of the
different document sections, see the Designing and Creating Documents chapter of the
Report Services Document Creation Guide.) If the text is displayed in the Detail section,
a user taps the text to copy.

For example, a document contains the heading “List of Regions” in the Detail Header
section, and the actual regions in the Detail, as shown below:

Zoom is disabled in the document, so double-tapping the word Region displays a pop-up
menu. The user can copy the selected text (Region), or select all the text in the text field
(List of Regions).

When a user taps Northeast, which is in the Detail section, the word Northeast is
selected. The pop-up menu allows the user to copy the selected text (Northeast).

For a document, you can enable copying for the whole document, and also enable or
disable copying for a specific text field, as described in the steps below. This means that
you can enable copying for all text fields on a document, but specify that a particular text
field cannot be copied.

To allow users to copy text from a text field in a document

1 In MicroStrategy Web, open the document in Design Mode.

2 To enable copying for the whole document, follow the steps below:

a From the Tools menu, select Document Properties. The Properties and
Formatting dialog box opens.

b From the list of categories on the left, under Document Properties, select
Mobile.
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c To enable copying from all text fields on the document, select the Enable copy
for text check box.

Text sub-selection is only supported outside of the Detail section. This
means that if the user selects text in the Detail section of the document,
all the text in the Detail section is selected. A user cannot select a single
word, as he can in other document sections. The example in Allowing
users to copy text from documents on iOS devices demonstrates this.

3 By default, all text fields use the document-level setting to determine whether
copying is enabled. You can enable or disable copying on a specific text field by
following the steps below:

a Right-click the text field, and select Properties and Formatting. The
Properties and Formatting dialog box opens.

b From the list of categories on the left, select General.

c Select one of the following:

▫ To enable copying on this text field, select Enable copy for this text.

▫ To disable copying on this text field, select Disable copy for this text.

d Click OK to save your changes and return to the document.

Notifying users: Displaying a badge next to the
MicroStrategy Mobile application icon
You can choose to display and update a badge displayed next to the MicroStrategy Mobile
application icon on a user’s iPhone or iPad. The badge is an alert you can use to inform
users of important information, such as new content or updates. A badge displays as a
red circle with white text.

You can:

• Update the badge each time that the user runs a document. For steps, see Updating
the MicroStrategy Mobile application badge each time that a document is run, page
51.

• Update the badge when the data in a report meets specific threshold conditions. For
steps, see Updating the MicroStrategy Mobile application badge when the data in a
report meets specific threshold conditions, page 52.

Updating the MicroStrategy Mobile application badge each time that
a document is run

You can update the badge displayed next to the MicroStrategy Mobile application icon on
a user’s iPhone or iPad each time that the user runs a document. To do so, you must add
a text field to the document which contains the value to display in the badge, as
described in the steps below. When the user runs the document, the value displayed in
the text field is automatically used to update the badge.
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To update the MicroStrategy Mobile application badge each time that
a document is run

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 You can have MicroStrategy update the badge with the value of a metric, rather than
a static value. Do one of the following:

• To update the badge with a metric value, from the Dataset Objects panel on
the left, click and drag the metric onto the layout area. A text field is
automatically created and displayed, containing shortcut text that will be
automatically replaced with the metric’s value when the document is run.

• To update the badge with a static value, from the Insert menu, select Text,
then click the location in the layout area to add the text field to. A blank text
field is automatically created and added to the document. In the field, type the
value to display, then click outside the text field to apply your changes.

3 Right-click the text field and select Properties and Formatting. The Properties
and Formatting dialog box opens.

4 Under Mobile, select the Set application badge to value of this field check
box.

5 Click OK to apply your changes.

Updating the MicroStrategy Mobile application badge when the data
in a report meets specific threshold conditions

You can update the badge displayed next to the MicroStrategy Mobile application icon on
a user’s iPhone or iPad when a metric on a report meets specific threshold conditions.
This alerts users who see the badge to data that is likely to be important for making
business decisions. To do this, you must create an alert-based subscription based on the
metric, as described in the steps below.

Prerequisites

• You must have MicroStrategy Distribution Services installed.

• MicroStrategy Web must be configured to use Distribution Services.

• Mobile device users must have the Use MicroStrategy Mobile and Mobile View
Document privileges.

To update the MicroStrategy Mobile application badge when the data
in a report meets specific threshold conditions

1 In MicroStrategy Web, run the report to use to update the application badge.
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2 Right-click the name of a metric in the report, then point to Alerts. SelectMobile
Notifications. The Alerts Editor opens.

Define the condition

3 From the Filter On drop-down list, select the attribute or metric to use to create a
condition.

4 If you are creating a condition based on a metric, do the following:

a Select a comparison operator, such as Greater Than or Less Than.

b Enter a value in the field on the right or click Select Metric to choose another
metric to compare the original metric to.

5 If you are creating a condition based on an attribute, do one of the following:

• To define your condition by typing specific attribute form values:

a Select the Qualify option.

b From the drop-down list on the left, select the attribute form on which to
base the condition. For example, you can qualify on the attribute element's
ID form, one of its description forms, or the DATE if the attribute is time-
based.

c From the next drop-down list, select a comparison operator such as Greater
Than or Less Than. The operators available for a selection depend on the
attribute form you chose above.

d Do one of the following:

— To compare the attribute form to a specified value, type the value in the
field.

— To compare the first attribute form to a second attribute form, click
Select Attribute, then select the second attribute form from the drop-
down list.

• To define your condition by selecting attribute elements from a list:

a Choose the Select option.

b From the drop-down list on the left, select In List or Not In List. If you
select Not in List, then the attribute elements in the Selected list will not be
included in the threshold condition.

c Move attribute elements from the Available list to the Selected list. Elements
in the Selected list are included in the threshold condition.

• To search for a specific element, use the Search for field. Select theMatch
case check box to return only items that match the upper and lower cases you
typed in the Search for field.

6 Click the Apply icon to define the condition.
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7 To add another threshold condition, select Add Condition, then repeat the
appropriate steps above to define the condition.

Specify delivery options

8 ExpandDelivery Settings, then enter a name for the subscription in the Name
field.

9 From the Schedule drop-down list, select a schedule or event. The schedule choices
available are created in the Developer Schedule Manager. For steps, see the
Scheduling Jobs and Administrative Tasks chapter in the System Administration
Guide.

10 If you want alerts delivered to a mobile device:

a Click To to choose an address. The Recipients Browser dialog box opens.

b You can search for contacts or a contact list in the Find field. The contacts will
appear in the Available list below.

c Click the left arrow and right arrow to add or remove contacts from the To, Cc,
and Bcc fields.

d Click OK to save the list of addresses.

11 From the Device type drop-down list, select the type of device to deliver the
notifications to.

12 From the Target Application drop-down list, select the type of application you
want to send the report to.

13 Select the Update application badge with the value of this metric check
box. From the drop-down list next to the check box, select the metric whose value
you want to display next to the application icon. Once a row of data in the report
meets the threshold condition you defined in the steps above, the value of this
metric, as displayed in the row, is shown next to the application icon. The first row
of data that meets the threshold condition is used to update the application icon.

For example, in the report displayed below, you can define a threshold condition as
“Profit greater than or equal to 200,000”. If you select Sales Team from the drop-
down list, 8 is displayed next to the application icon.

14 If you want to specify an expiration date for the subscription, expand Advanced
Options and select the Do not deliver after check box, then specify an
expiration date by choosing a date from the calendar.

15 Click OK to create the subscription.
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Creating documents that use Transaction Services to
update your data warehouse
You can create documents for iOS and Android devices that allow users to change values
in grids and then write those changes to your data warehouse. Use Transaction Services
in your apps and documents to update data, write new information to your warehouse, or
delete existing records. This feature is available when you install Transaction Services.

For an introduction to Transaction Services, see the Advanced Reporting Guide.

Some examples of how you can use Transaction Services are:

• To create a Corporate Request Center that allows users to approve or deny time off,
expenses, and purchase order requests.

• To create inspection forms. Inspectors can input data with sliders and selectors.
They can also take pictures of any issues they find. The results of their inspections
are instantly written to the database.

• To create and update budgets or calendars.

Prerequisites

• You must have Transaction Services.

• You must have the Web Configure Transaction privilege.

Overview

The following is a high-level overview of the tasks you need to perform to create a
document that uses Transaction Services. Each high-level step describes where to find
specific instructions for designing transaction-enabled documents:

• In Developer, create a Transaction Services report using the Freeform SQL Editor.
For instructions, see the Advanced Reporting Guide.

• In MicroStrategy Web, create a dataset report that includes the attributes and
metrics you added to the Transaction Services report above. For instructions, see the
Report Services Document Creation Guide.

• In MicroStrategy Web, create a document for mobile devices that uses the above
dataset report, and link it to the Transaction Services report you created above. For
instructions, see the Report Services Document Creation Guide.

For iOS devices, the document can include a transaction table, which provides a
structure to organize multiple input object controls for the same transaction. For
steps to create a transaction table, including an example, see Organizing
transactions with tables on iOS devices, page 67.

The values in documents you create using the above procedure can only be edited by
users who have the Execute Transaction privilege.
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Allowing users to filter data: prompts
A prompt is a question that the system presents to a user when a report is executed. The
user’s answer determines the data that is returned by the report. Specific prompts can be
added to a report for use on an iPhone, iPad, or Android device that has the
MicroStrategy Mobile application. These prompts are then displayed when the prompted
report, or a document that uses the prompted report as a dataset, is executed on the
device.

You can use prompts to customize the data within an app to the user. For example, an
app contains information on sales and inventory for all stores of a company nationwide,
with a prompt asking for which store(s) the user would like to view data. Store managers
in different regions typically want to see data for different stores. Including a prompt
allows you to create one app that all store managers can use.

If an app or document has more than one prompt, you can filter the options available in
the second prompt based on the user’s answers in the first prompt. To do this, add the
first prompt as a filter on the second prompt. For steps to create a filter, see the Basic
Reporting Guide.

For an introduction to prompts, the basic prompt types, prompt creation, and adding a
prompt to a report, see theBasic Reporting Guide. For instructions to add a prompt to a
document, see the Document Creation Guide.

For best practices when creating prompts for mobile devices, see Best practices for
creating prompts for mobile devices, page 57.

For steps to answer prompts in MicroStrategy Mobile, see the MicroStrategy Mobile
Analysis Guide.

You can display prompts on mobile devices in the following styles:

• Textbox: This prompt lets users type a value via a keypad to answer a prompt.

• Slider: This prompt lets users select a numeric value on a horizontal slider.

• Stepper: This prompt displays a numeric value. Users can tap the increment and
decrement buttons to increase or decrease the value for their prompt answer.

• Switch: This prompt lets users choose between two choices, On and Off.

• Wheel: This prompt displays a wheel or row of wheels that the user can scroll
through to specify a date or date and time. On Android devices, this prompt is
displayed as a stepper.

• Calendar: This prompt lets users select a date from a calendar.

• Geo Location: This prompt lets users filter results based on their current
geographical location. The prompt includes a request for permission to enable a GPS-
style locator. For more information, see Prompting users for their location: Geo
Location prompts, page 64.

• Barcode Reader: This prompt lets users answer a prompt by scanning or typing a
barcode. For more information, see Creating Barcode Reader prompts, page 65.

https://www2.microstrategy.com/producthelp/10.7/BasicReporting/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/BasicReporting/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/BasicReporting/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/manuals/en/MobileAnalysis.pdf
https://www2.microstrategy.com/producthelp/10.7/manuals/en/MobileAnalysis.pdf


Mobile Design and Administration Guide

57 © 2017, MicroStrategy Inc.

• Tree: This prompt lets users answer a prompt by selecting objects in a tree. Tapping
one object in the tree displays all objects underneath it. For more information, see
Allowing users to choose elements from multiple attributes: Hierarchy prompts,
page 63.

Prompts for mobile devices are divided into four types: value prompts, attribute element
prompts, hierarchy prompts, and object prompts. Value prompts require the user to
select a single value, such as a date or number. Attribute element prompts require the
user to select from a limited list of available attribute elements.

Hierarchy prompts require the user to select an attribute or attribute element from a
hierarchy of related attributes. For example, an app may display data for a time period
that the users specify. The app may include a prompt on the Time hierarchy, which
contains the Year, Month, and Day attributes. Users can then choose to view data for a
specific year, month, or day.

Object prompts require the user to select one or more objects from a list of available
objects. Objects prompts allow users to choose exactly what data they want to view. For
example, a document may contain a grid with the Region and City attributes. You can
add an object prompt to allow users to choose which metrics or filters to add to the grid.

Best practices for creating prompts for mobile devices
• Create prompts specifically designed for use on mobile devices. Some examples of the

prompt types are listed below:

▫ Slider, which allows users to answer the prompt by selecting a numeric value on
a slider.

▫ Stepper, which allows users to answer the prompt by using increment and
decrement buttons.

▫ Wheel, which allows users to answer the prompt by moving wheels to specify a
value.

▫ Geo Location, which allows users to filter results based on their current
geographical location.

▫ Barcode Reader, which allows users to answer the prompt by scanning or typing
a barcode.

• Prompts that are not specifically designed for mobile devices can still be used. In
general, use:

▫ The List style for single selections.

▫ The Shopping Cart style for multiple selections on iOS devices.

▫ The Geo Location style for geographical location data.

▫ The Barcode Reader style for barcode data.
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Allowing users to filter data based on a single value:
Value prompts
A value prompt lets users select a single value, such as a date or specific text string, and
filter report data based on their selection. The different types of value prompts are:

• Date and time prompt: This prompt type asks users to type or select a date, and
returns data with the Date data type that matches the user’s selection. For example,
the Date prompt can be useful when added to a filter that screens data based on
Year=2016. The prompt lets users select a specific date within the year of the filter’s
condition. Date prompts are used in filters that qualify on a date.

Date and time prompts are displayed as wheels on an iPhone or iPad, and are
displayed as a date/time stepper on an Android device.

• Numeric prompt: This prompt type asks users to type a numeric value. Numeric
value prompts accept integers or decimals up to 15 digits of precision. Numeric
prompts can be used in any filter that needs a number input from the user. For
example, a numeric prompt may be used to filter results where the minimum value
for Revenue is entered by the user.

Numeric prompts can be displayed as text boxes, numeric wheels, sliders, steppers,
switches to choose between two numeric values, and location prompts.

• Text prompt: This prompt type asks users to type a string of text in a text box.

Text prompts can be displayed as text boxes, or as barcode reader prompts.

• Big decimal prompt: This prompt type asks users for a “big decimal” value. Big
decimal value prompts accept integers and decimals up to 38 digits of precision.

Big decimal prompts can be displayed as text boxes.

For more information about value prompts, see theMicroStrategy Web Help.

To create a value prompt

1 On the MicroStrategy Web home page, click Create Prompt. The Create Prompt
page opens, with a list of the types of prompts you can create.

2 Click Value Prompt. The New Prompt page opens.

3 Specify the type of value prompt, making your selection based on your requirements:

• To let users filter for data related to either a specific date or a range of dates,
click Date and Time prompt.

• To let users filter numeric data, usually based on a metric, click Numeric
prompt.

• To let users filter text data, usually based on attribute forms, click Text
prompt.
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• To let users filter data based on a big decimal value for a metric, click Big
Decimal prompt.

4 Click the General tab.

5 Specify a title and description for the prompt in the Title and Instructions fields.

To restrict the prompt answers

6 To require users to answer the prompt before running the report, select the Prompt
answer is required check box.

7 To set the maximum and minimum values that can be entered by the user, select the
Minimum value andMaximum value check boxes and type a value in the
respective fields. You can specify a minimum value even if you do not specify a
maximum value.

To specify the layout and display style of the prompt

8 Click the Style tab.

9 From the Display style drop-down list, specify a presentation style, such as
Textbox, for the prompt. This is how the prompt is displayed to the user.

10 Depending on your requirements, choose the appropriate display style and options by
referring to the following table:

End Goal Prompt Type and
Display Style

Setup Recommendations and Requirements

Select a date
from a calendar

Prompt type:
Date & Time

Display style:

Textbox

Minimum value: Specify the earliest date that can be
used to answer the prompt.

Maximum value: Specify the latest date that can be used
to answer the prompt.

Select a date
and/or time from
a wheel

Prompt type:
Date & Time

Display style:

Textbox

Minimum value: Specify the earliest date and time that
can be used to answer the prompt.

Maximum value: Specify the latest date and time that
can be used to answer the prompt.

Allow user to select time: Specify whether the user
can select a time as well as a date to answer the prompt.

Interval (minutes): Specify the interval displayed between
each value on the wheel. For example, an interval of 30
allows users to select times in 30-minute intervals, such as
9:30 A.M., 10:00 A.M., 10:30 A.M., and so on.

Type a numeric
value to answer a
prompt

Prompt type:
Numeric

Display
style: Textbox

Minimum value: Specify the lowest value that can be
used to answer the prompt.

Maximum value: Specify the highest value that can be
used to answer the prompt.
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End Goal Prompt Type and
Display Style

Setup Recommendations and Requirements

Use a switch to
choose between
two numeric
values

Prompt type:
Numeric

Display
style: Switch

On value: Specify the numeric value used when the switch
is set to its On position. The default is 1.

Off value: Specify the numeric value used when the switch
is set to its Off position. The default is 0.

Select a numeric
value on a
horizontal slider

Prompt type:
Numeric

Display
style: Slider

Minimum value (required): Specify the lowest selectable
value in the slider.

Maximum value (required): Specify the highest
selectable value in the slider.

Interval: Specify the interval displayed between each value
on the slider. For example, an interval of 10 allows users to
specify values in increments of 10, such as 10, 20, 30, and
so on.

Use a stepper to
increment or
decrement a
numeric value

Prompt type:
Numeric

Display
style: Stepper

Minimum value: Specify the lowest value that is
displayed in the prompt.

Maximum value: Specify the highest value that is
displayed in the prompt.

Interval: Specify the interval used to increment or
decrement values in the stepper. For example, if the
stepper’s minimum value is set to 100, and the interval is 10,
users can increment the stepper value to 100, 110, 120, and
so on.

Select a numeric
value from a
wheel

Prompt type:
Numeric

Display
style:Wheel

Minimum value: Specify the lowest value that is
displayed in the prompt.

Maximum value: Specify the highest value displayed in
the prompt.

Interval: Specify the interval displayed between each value
on the wheel. For example, an interval of 30 allows users to
specify values in increments of 30.

Filter data based
on a user’s
current location

Prompt type:
Numeric

Display
style: Geo
Location

Mobile preferences: Select the Latitude or
Longitude option to filter data based on the current
latitude or longitude.

For Geo Location prompts, you must create one prompt for
the longitude, and one for the latitude.

For a detailed description of the Geo Location prompt, see
Prompting users for their location: Geo Location prompts,
page 64.

Type text to
answer a prompt

Prompt type:
Text

Display
style: Textbox

Minimum number of characters: Specify the
minimum required length of the prompt answer.

Maximum number of characters: Specify the
maximum allowable length of the prompt answer.



Mobile Design and Administration Guide

61 © 2017, MicroStrategy Inc.

End Goal Prompt Type and
Display Style

Setup Recommendations and Requirements

Scan or type an
item’s barcode

Prompt type:
Text

Display
style: Barcode
Reader

Minimum number of characters: Specify the
minimum required length of the barcode.

Maximum number of characters: Specify the
maximum allowable length of the barcode.

For a detailed description of the Barcode Reader prompt, see
Creating Barcode Reader prompts, page 65.

Type a large
number to
answer a prompt

Prompt type:
Big Decimal

Display
style: Textbox

Minimum value: Specify the lowest value that can be
used to answer the prompt.

Maximum value: Specify the highest value that can be
used to answer the prompt.

For examples of each prompt display style, see Allowing users to filter data:
prompts, page 56.

To save the prompt

11 To save the prompt, click Save As. The Save As dialog box opens.

12 Specify a name, description, and the location in which to save the prompt and click
OK. The Save As dialog box closes, and the prompt is saved.

Allowing users to choose from a list of attribute
elements: Attribute element prompts
An attribute element prompt lets users select prompt answers from a limited list of
specific attribute elements.

The table in the steps below provides a list of attribute element prompt types that you
can create in MicroStrategy Web for use on a mobile device. To create a prompt that
accomplishes a specific goal, find the task you want to perform in the first column in the
table, then see the remaining columns for the display style, recommendations, and
requirements to create the prompt. For images of each prompt display style, see
Allowing users to filter data: prompts, page 56.

For more information about attribute element prompts, see theMicroStrategy Web
Help.

To create an attribute element prompt

1 On the MicroStrategy Web home page, click Create prompt.

2 The Create Prompt page opens with a list of the types of prompts that you can create.
Click Attribute Element List.



Mobile Design and Administration Guide

© 2017, MicroStrategy Inc. 62

3 To determine the attribute whose elements the user can choose from, click Select
Attribute. Select the attribute whose elements are displayed in the prompt and click
OK.

To define the elements that the user can choose from

4 Choose one of the following options:

• To display all the attribute elements to users while they are answering the
prompt, choose List all elements (no restriction). This option is
recommended only if there are a small number of elements for the attribute.

• To create a list of attribute elements from which users can choose, select Use a
predefined list of elements. This option is recommended if users need to
choose from a specific set of elements.

To select the elements, click Add, then click OK. To remove an object, highlight
it and click Remove. To remove all items, click Clear.

• To narrow the list of available attribute elements by using a filter, choose Use a
filter to reduce the number of elements. This option is recommended for
attributes with a large number of elements.

For example, you can restrict the Customer attribute by only showing the top
100 customers. Browse to and select the filter.

Filtered attribute element prompts apply to iOS devices. On Android
devices, all attribute elements are displayed.

5 Click the General tab.

6 Specify a title and description for the prompt in the Title and Instructions fields.

7 To require users to answer the prompt before running the report, specify whether
the prompt requires an answer. Select the Prompt answer is required check
box.

8 Optionally, set the maximum and minimum number of prompt answers allowed.
Enter these numbers in theMinimum number of answers andMaximum
number of answers fields.

9 Click the Style tab.

10 You can determine the presentation style used to display the prompt to the user. The
default is Shopping Cart. From the Display style drop-down list, select the
presentation style you want to use.

11 Depending on your requirements, select the appropriate display style and options by
referring to the following table:
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End Goal Display
Style

Setup Recommendations and Requirements

Select a date-based
attribute element
from a calendar

Calendar Minimum date: Specify the earliest date that users can select.

Maximum date: Specify the latest date that users can select.

Select an attribute
element from a list

List Show search box: Specify whether users are presented with a
search box to filter the list of attribute elements.

Make search required: Specify whether to require that
users search for elements.

Use the current
geographical
location to filter
attribute elements

Geo
Location

Select location mapping level: Select the level at which to
filter attribute elements. For example, if this option is set to City,
the attribute elements will be filtered to include only those in the
current city.

Select location mapping attribute: Select the attribute to
use to filter the element list. The location mapping attribute must
contain attribute forms for latitude and longitude, and these
attribute forms must be visible on the template.

For a detailed description of the Geo Location prompt, see
Prompting users for their location: Geo Location prompts, page
64.

Scan or type the
barcode of an item
to search for an
attribute element

Barcode
Reader

Show search box: Specify whether users are presented with a
search box to filter the list of attribute elements.

Make search required: Specify whether to require that users
search for elements.

Barcode mapping attribute form: Select the attribute
form used to look up barcode information.

For a detailed description of the Barcode Reader prompt, see
Creating Barcode Reader prompts, page 65.

To save the prompt

12 To save the prompt, select Save As. The Save As dialog box opens.

13 Specify a name, description, and the location in which to save the prompt and click
OK.

Allowing users to choose elements from multiple
attributes: Hierarchy prompts
Users can answer a prompt on an iPad or iPhone by selecting attribute elements from all
of the attributes in a hierarchy, using the Hierarchy prompt.
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Use Hierarchy prompts when users want to view or compare data for different types of
attribute elements. For example, a user wants to analyze sales information across all the
products in his store. The user wants to be able to analyze sales data for specific items in
his store and analyze sales data across different product categories. You can create a
Hierarchy prompt on the Product hierarchy, which contains both the Item and Category
attributes, and add it to the report.

For steps to create a Hierarchy prompt, refer to the Basic Reporting Guide.

Allowing users to choose from a list of objects: Object
prompts
Users can answer a prompt on an iPad or iPhone by selecting from a list of objects. The
object prompt is more flexible than the attribute element prompt. Instead of choosing
from a list of attribute elements, users can choose from a list of objects, such as
attributes, metrics, and custom groups. Users can also choose which filter to apply to a
report or document.

Use Object prompts when users want to control what data they view in a report or
document. For steps to create an Object prompt, refer to the Basic Reporting Guide.

Prompting users for their location: Geo Location
prompts
The Geo Location prompt lets users answer a prompt by using their device’s current
geographical location. Geo Location prompts are typically used to filter data in a Map
widget. For example, a Map widget displays several locations as markers on the map
display. You can choose to display only those map markers that are in the user’s current
city.
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The location name that is returned by a Geo Location prompt is based on Google’s
geocoding. The prompt determines the user’s longitude and latitude using the mobile
device’s GPS receiver, and passes this information to Google Maps to return information
about the user’s location.

You can also use an attribute element prompt to filter attribute elements based on the
location of the mobile device. To support attribute element prompts, your MicroStrategy
schema must include a location mapping attribute that includes attribute forms for
latitude and longitude information.

For example, to filter a list of stores by the state in which the mobile device is located,
provide a location mapping attribute that contains attribute forms for the state name,
latitude, and longitude.

The attribute that provides the list of attribute elements that are filtered and displayed by
the Geo Location prompt, also called the display attribute, does not have to be the same
as the location mapping attribute. For example, the Customer State is both the display
attribute and the location mapping attribute. When the prompt is displayed on a mobile
device, the list of prompt answers is filtered to display the current state, as shown in the
image below. Instead, if the display attribute is the Store attribute, and the location
mapping attribute is Customer State, the list of prompt answers is filtered to display the
stores in the current state, as shown in the image below on the right. Users can select
stores from the list for which to display data.

You can:

• Create a prompt that automatically uses the device’s current latitude and longitude.
While creating the prompt, you must define two value prompts, one for latitude and
one for longitude.

For steps to create value prompts, see To create a value prompt, page 58.

• Create a prompt that filters an attribute element list using the current geographical
location, by defining an attribute element prompt with the display style set to Geo
Location.

For steps to create an attribute element prompt, see To create an attribute element
prompt, page 61.

Creating Barcode Reader prompts
The Barcode Reader prompt lets users scan or type an item’s barcode using the device to
answer a prompted report or document.

You can add a Barcode Reader prompt to a report or document by defining a prompt and
setting its display style to Barcode Reader. The prompt is then displayed as a Barcode
Reader when the report or document is executed, as shown below:
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Some examples of how you can use the Barcode Reader prompt are:

• To spontaneously view a product’s sales and inventory information.

• To view other locations where the product is stocked, as stored in your database.

• To compare the product’s popularity with other products in the same category or
with the same brand name.

The Barcode Reader prompt supports the following types of barcodes:

• QR code

• UPC-A

• UPC-E

• EAN-8

• EAN-13

You can do the following:

• To allow iPhone, iPad, and Android users to filter report results based on a product
barcode, you can define a value prompt with the display style set to Barcode Reader.

For steps to create a value prompt, see To create a value prompt, page 58.

• To allow iPhone, iPad, and Android users to search for an item in an attribute
element list, you can define an attribute element prompt with the display style set to
Barcode Reader. If an item’s barcode matches the scanned or typed barcode, its
name is returned in the search and can be selected to answer the prompt.
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For steps to create an attribute element prompt, see To create an attribute element
prompt, page 61.

To support the scanning of barcodes using MicroStrategy Mobile, you must store the
barcode data used in the associated prompt with a database data type that supports text
data. MicroStrategy recommends using the varchar data type for your database to store
the barcode data. For details about storing data in your warehouse, see the Project
Design Guide.

Allowing users to filter data using filter panels
You can allow users to filter data within a dashboard-style document using a panel of
selectors, called a filter panel. Users select different options in the filter panel, which
changes the data that is displayed in the document.

You can customize the filter panel so that each filter in the panel is collapsible, similar to
the Filters panel in dashboards. For steps, see the procedure below.

For detailed steps to add a filter panel to a document, see the Dashboards and Widgets
Creation Guide.

To make each filter in a filter panel collapsible

1 In MicroStrategy Web, open the document containing the filter panel in Design or
Editable Mode.

2 Right-click the filter panel and select Properties and Formatting.

3 Under the Panel Stack area, select the Show as collapsible panel (Mobile
only) check box.

Organizing transactions with tables on iOS
devices

A transaction-enabled document contains embedded write-back functionality for the
purposes of decision-making or initiating a transaction. Transaction Services-enabled
documents allow you to update, delete, or create new entries in your database from
within your Mobile app.

If you have multiple input object controls on a document displayed on an iOS device, you
can create a transaction table to group and organize those controls. For general
background information on transaction-enabled documents, including the prerequisites
needed to work with them, see the Transaction-enabled Documents chapter of the
Report Services Document Creation Guide.

You can create a transaction table that is displayed at all times in the document, or that
pops up as an Information Window when a user taps an object.
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The image below gives an example of a transaction table in an app for store inspectors.
The inspector fills in all the fields to complete the transaction table, and then taps
Submit to submit the changes.

The high-level steps to create and enable a transaction table are described below:

1 Create a transaction table, as described in Creating a table, page 70.

2 Link the transaction table to a Transaction Services-enabled report. Data from the
input objects defined in the Transaction Services report is displayed in the table cells
for users to edit.

3 Link each input object on the Transaction Services report to a cell in the transaction
table.

4 Determine what type of input object control is displayed to users when they view the
Transaction Services-enabled document. Analysts use these input object controls to
edit the data displayed in a document. For example, users can type text in a text field,
turn a switch on and off to specify a numeric value, select a value from a list, and so
on.

The following input control types are displayed as a list in a transaction table:

• Check box

• Likert Scale

• Radio List

• Toggle

Only the MicroStrategy Mobile-specific procedure for creating a transaction table is
included in this guide. For detailed procedures for the remaining steps to create
transactions, including descriptions of the available input object controls, see the
Transaction-enabled Documents chapter of the Report Services Document Creation
Guide.
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The parts of a table
A transaction cell is the basic component of a transaction table. A transaction cell
contains an input object control, which are the objects that allow analysts to edit the
data displayed in a document. For example, users can type text in a text field, turn a
switch on and off to specify a numeric value, select a value from a list, and so on.

An example of a transaction table in Design Mode is show below:

A transaction cell displays a title and a placeholder, as described below:

• Cell title: The title or description of the cell. An input object control cell displays
the value entered by the user. In the example above, Name, Email, and Year are cell
titles.

• Cell placeholder text: A hint for the user about the format for an input object
control. In the example above, “Last, First” and “Name@domain.com” are
placeholders. A placeholder is optional. In the example, “Make and Model” does not
have a placeholder.

If an input object control is required, the placeholder text displays “Required”
automatically for the user on a mobile device. If the placeholder is not empty, the
text “(Required)” is added to the placeholder text. When you configure the
transactions, you select whether the control is required.

A transaction table contains at least one group. Groups collect related cells together
under a descriptive title. The example above contains two groups, Customer and Vehicle,
which separate and give context to the cells that require customer information and cells
that require vehicle information.

You can create a group that is displayed to the document designer but hidden from users.
For example, you may create a cell that contains a macro to gather the mobile device’s
ID. Since no input is required from the user, only the mobile device, you may want to
hide the group. To hide a group, name the group hidden.

A transaction table also displays a Clear button and a Submit button, or Cancel and
Submit if the transaction table is used as an Information Window.

• The Submit button submits the data in the transaction table. If the transaction
table is displayed as an Information Window, the Information Window is also closed.

• The Clear button erases all the information added to the transaction table, allowing
the user to start again.
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• The Cancel button closes the Information Window without submitting the data in
the transaction table.

You can customize the button names, but they are referred to as Clear and Submit
throughout this chapter. By default, changes are cleared or submitted automatically, as
soon as the button is tapped. You can require that a confirmation message is displayed
after the Clear or Submit button is tapped.

Creating a table

Prerequisites

• You must have Transaction Services.

• You must have the Web Configure Transaction privilege.

• The Transaction Services report that you want to link to the Grid/Graph or text
fields has already been created. This report must contain the input object for each
value that you want to allow users to change. For steps to create a Transaction
Services report, see the Advanced Reporting Guide.

The high-level steps to creating a table are listed below, with links to the appropriate
steps.

1 Add a table. See Adding a table to a document, page 70 for steps to create and
format a table. The new table contains a single cell in a single group, and the Clear
and Submit buttons. You can customize the actions and name of the buttons, as
described in the procedure.

2 Add groups to the table. A group is a collection of related cells. You can add as many
groups as needed to the table. If the table contains multiple groups, you can change
the order that the groups are displayed in. For steps, see Adding and moving groups
in a table, page 75.

3 Add transaction cells to the table. You can add as many transaction cells as needed.
If the table contains multiple cells, you can change the order that the cells are
displayed in. For steps, see Adding or moving cells in a table, page 76.

Adding a table to a document

To add a table

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 From the Insert menu, select Table Control (Mobile). When you move the
cursor to the Layout area, the pointer becomes crosshairs. Click in the desired
location in the Layout area. If you click and drag in the Layout area, you can size the
table. An empty table container is added to the document, with a single cell in a
single group, and the Clear and Submit buttons, as shown below:
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To change the group title

3 To change the group title from the default of Title, double-click the group title text,
and type your title. Press ENTER to add the text.

• If you do not want to display a title for this group, double-click the group title
text and delete the text.

• If you want to hide this group from users, type hidden as the title. The title is
not case-sensitive, so you can use Hidden or HIDDEN as well.

To display the table as an Information Window

A transaction table can either be displayed at all times in the document, or it can pop
up as an Information Window when a user taps an object. To use an Information
Window, follow the steps below. To display a transaction table at all times in the
document, skip to To customize the buttons’ name and actions, page 72.

4 Add the text field, image, or button that will open the transaction table in an
Information Window.

5 Right-click the newly added object, and select Properties and Formatting. The
Properties and Formatting dialog box opens.

6 From the left, click General.

7 From the Panel Stack drop-down list, select the panel stack to use as the
Information Window.

8 Click OK to save your changes.

9 Right-click the table and select Properties and Formatting. The Properties and
Formatting dialog box opens.

10 From the left, click General.

11 Select the Use as Information Window check box.

12 To display a title bar in the Information Window, complete the following steps:

a Select the Show Title Bar check box.

b From the Title drop-down list, select Custom Title.

c Type a title in the Title field. This text is used as the title of the Information
Window.
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13 To specify how to open the Information Window on an iPad, select one of the
followingWindow mode options:

• To open the Information Window by popping it up, select Appear (default).

If you select Appear, you can specify the location of the Information Window on
an iPad. Select one of the following options from the Placement drop-down
list:

▫ To display the Information Window in the best position, select Automatic
(default).

▫ To display the Information Window at the position of the panel stack, select
Fixed.

▫ To display the Information Window above the selected object (for example,
the item in the selector or the attribute in the grid), select Above.

▫ To display the Information Window below the selected object, select Below.

▫ To display the Information Window to the left of the selected object, select
Left.

▫ To display the Information Window to the right of the selected object, select
Right.

• To open the Information Window by flipping it up, like turning over a card,
select Flip Up.

• To open the Information Window by gradually increasing its size, select Scale
Up.

• To open the Information Window by sliding it from an edge of the screen, select
Slide.

If you select Slide, you can specify which edge to slide the Information Window
from, on an iPad or iPhone. Select one of the following options from the
Position drop-down list:

▫ Right (default)

▫ Left

▫ Above

▫ Below

To customize the buttons’ name and actions

14 If the Properties and Formatting dialog box is not open, right-click the table and
select Properties and Formatting. The Properties and Formatting dialog box
opens.

15 From the left, select Buttons.

16 You can change the name displayed on the Submit button, by replacing the default
text in the Display text field in the Submit button area.
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17 You can choose to display a message asking for confirmation when a user taps the
Submit button, before the user’s changes are submitted. Do one of the following:

• To display the confirmation message, select the Require Confirmation check
box in the Submit button area.

• To submit changes without displaying a confirmation message, clear the
Require Confirmation check box in the Submit button area.

18 You can determine which action is performed after a user submits his changes.
Select one of the following under Subsequent Actions:

• To return to the document without performing any additional actions, select the
No subsequent action option.

• To refresh the display of the document, select the Refresh the current
document option.

• To run a specific report or document, complete the following steps:

a Select the Run a new report or document option. Click ... (the browse
button), navigate to and select the report or document you want to run, and
click OK.

b Specify whether the report or document will be executed using data cached
on the mobile device. Do one of the following:

— To run the report or document without using data cached on the mobile
device, select the Force Live Execution check box.

— To run the report or document using data cached on the mobile device,
clear the Force Live Execution check box.

c You can choose to use the same prompt answers that were chosen in the
source document to answer the prompts in the target report or document.
To use the same prompt answers, select the Answer prompts with the
same answers as the source check box. If both the source and target
report/document contain the same prompts, the user will not be asked to
provide prompt answers. The user will still be prompted for any prompts
that exist in the target but that do not exist in the source.

• To display a custom confirmation message after changes are submitted, select
the Display message after submitting option. Type the message in the field
below the option.

• A Transaction Services-enabled document that is pre-cached is run in the
background, and its results are stored on the mobile device on which it is
executed, improving the speed with which the document is run. You can choose
to update document results cached on a mobile device after the user submits his
changes, by using the Invalidate Mobile Device Cache setting to mark a
document’s results as in need of updating.

If the document is defined to be pre-cached, the document will be automatically
pre-cached each time the user submits his changes. If the document is not
defined to be pre-cached, the document will be automatically executed using data
cached on the Intelligence Server the next time the document is run, or executed
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against the data source if no cached data is available. For background
information on pre-caching, see Chapter 5, Administering MicroStrategy
Mobile. Do one of the following:

▫ To have the document pre-cached each time the user submits his changes,
select the Invalidate Mobile Device Cache check box.

▫ To allow the user to submit his changes without marking the data cached on
the mobile device as in need of updating, clear the Invalidate Mobile
Device Cache check box.

19 You can change the name displayed on the Clear button (or Cancel button, if the
table is displayed as an Information Window), by replacing the default text in the
Display text field in the Clear button area (or Cancel button area).

20 You can choose to display a message asking for confirmation when a user taps the
Clear button (or Cancel button, if the table is displayed as an Information Window).
Do one of the following:

• To display the confirmation message, select the Require Confirmation check
box in the Clear button area (or Cancel button area).

• To discard changes without displaying a confirmation message, clear the
Require Confirmation check box in the Clear button area (or Cancel button
area).

To format the table

21 In the Properties and Formatting dialog box, from the left, select Color and Lines.

22 From the first drop-down list at the top of the dialog box, select Table. The next
drop-down list is then automatically displayed as Body.

23 To change the background fill of the table, select the color from the Color drop-
down list.

24 To change the border around the table, select one of the following from the
Borders options:

• To hide the table border, select None.

• To use a single color for the entire border, select All. From the first drop-down
list, select the type of border (thick, thin, and so on). From the second drop-
down list, select the border’s color.

• To use different colors on different sides of the table, select Custom. For each
side (Top, Bottom, Left, and Right), select the border type and the border color.

25 From the left, select Font.

26 You can change the font for the cell title and value for all cells in the table, and for
all the group titles. For each part that you want to format, follow the steps below:

a From the first drop-down list, select Cells or Groups.
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b From the second drop-down list, select the part of the table to format. Your
options are:

▫ Title (available for cells and groups)

▫ Value (available for cells)

c Format the font, including the font type, color, size, and so on.

27 Click OK to save your changes.

Adding and moving groups in a table

A group organizes cells related to each other so that they appear together in a table. A
table can contain multiple groups or only a single group.

Prerequisite

Before you can add a group to a table, you must have already created a table, as described
in Adding a table to a document, page 70. When you create a table, a group is
automatically created in the table.

To add or move a group in a table

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 Click the Add new group button in the table. A new group is added to the table,
with a single cell.

3 To change the group title from the default, double-click the group title text, and type
your title. Press ENTER to add the text.

If you do not want to display a title for this group, double-click the group title
text and delete the text.

4 If you have multiple groups in a table, you can change the order that the groups are
displayed in the table. Select a group to move, by clicking the group, not the group
title or a cell. Then drag and drop the group to its new position. As you drag the
group, a blue arrow is displayed to indicate its new position.

Deleting a group

Prerequisite

The table must contain at least two groups to delete a group, because a table must always
have at least one group.
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To delete a group from the table

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 Right-click the group to delete, and select Delete Group.

The Delete Group option is not available if the table contains a single group.

Adding or moving cells in a table

You can add as many cells as necessary. If you add multiple cells, you can change the
order of the cells.

Prerequisites

• Before you can add a cell to a table, you must have already created a table, as
described in Adding a table to a document, page 70.

• If you want to add the cell to a group in the table, you must have already created the
group. See Adding and moving groups in a table, page 75 for steps.

When you create a table or a group, a default cell is added as well. You can
configure the cell as though you added it yourself, by following the procedure
below, skipping over the step to add a new cell.

To add or move a cell in a table

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 Hover the cursor over the group to add the cell to. Click the Add new cell button
that is displayed. A new cell is added to the table, displaying Title and Placeholder in
the cell.

3 The cell title is the description for the cell. To change the cell title from the default,
double-click the Title text, and type your title. Press ENTER to add the text.

4 The placeholder text contains a hint for the user about the format for an input object
control. For example, if the input object control is a login, the placeholder text can
be domain/user or user@domain.com. To change the text from the default, double-
click the Placeholder text, and type the new text. Press ENTER to add the text.

To move a cell

5 Select the cell to move, by clicking the cell, not the cell title or other component.
Then drag and drop the cell to its new position. As you drag the cell, a yellow bar is
displayed to indicate its new position.
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After you have created the table, you need to enable transactions for the document, as
described in the Transaction-enabled Documents chapter of the Report Services
Document Creation Guide.



3

DISPLAYING DATA AS
INTERACTIVE VISUALIZATIONS:
WIDGETS

A widget is a rich, graphical display of the results of data, which allows users to visualize
data in different ways than they can when using traditional reports. Widgets are
sophisticated visualization techniques that can combine with interactivity to enable a
better understanding of the data.

Use the following methods to define widgets for mobile devices:

• Display reports as widgets. This is recommended if you want to display only one
widget on the screen. Note that certain features, such as Information Windows for
the Map widgets, require you to create widgets in documents.

To display reports as widgets, you need to use the Custom Visualizations Editor in
MicroStrategy Web. For steps, see the MicroStrategy Web Help.

• Add widgets to documents. This is recommended if you want to display additional
information on the same layout as the widget. Instructions are included in this
chapter to create and add widgets to documents.

Adding widgets and visualizations to documents
for mobile devices

The following table contains a list of mobile widgets, the mobile devices on which they
can be displayed, and links to background information for each widget.

Widgets other than the mobile widgets in this table are displayed as grid or graph
reports on mobile devices.
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https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm


Mobile Design and Administration Guide

79 © 2017, MicroStrategy Inc.

Widget Description Displays
on

Link

Data Cloud
widget

Displays the names of attribute elements in
various font sizes to depict the differences in
metric values.

iPhone,
iPad

Displaying a Data
Cloud widget, page 81

Date
Selection
widget

Allows users to view data about events on an
interactive calendar.

iPad,
Android
tablet

Displaying an
interactive event
calendar: Date
Selection widget, page
81

Graph
Matrix
Visualization

Displays data using a variety of graph styles, such
as the line graph, bubble graph, or grid.

iPad Displaying data in an
interactive graph:
Graph Matrix widget,
page 85

Heat Map
widget

Allows users to visualize data as rectangles color-
coded and sized to depict the differences in
metric values.

iPad,
Android

Displaying data in a
Heat Map widget,
page 86

Image
Layout
widget

Allows users to visualize data as colored areas or
bubble markers overlaid on an image.

iPad,
Android

Displaying data as an
overlay on an image:
Image Layout widget,
page 87

Image
Viewer
widget

Allows users to browse through a collection of
images.

iPhone,
iPad,
Android

Displaying images:
Image Viewer widget,
page 87

Interactive
Grid widget

Displays data in a compact tabular layout. iPhone,
iPad,
Android

Displaying data in
rows and columns:
Interactive Grid
widget, page 90

Map widget Allows users to search and view information for
locations on a map.

iPhone,
iPad,
Android

Displaying
geographical data:
Map widget, page 93

Microcharts
widget

Allows users to analyze trends at a glance using
compact charts and line graphs.

iPhone,
iPad,
Android

Visualizing trends:
Microcharts widget,
page 108

Multimedia
widget

Allows users to download and view multimedia
files, such as videos, PDFs, and ePub books.

iPhone,
iPad,
Android

Downloading and
viewing multimedia
files: Multimedia
widget, page 111

Network
widget

Allows users to analyze relationships between
items and clusters as a network of connected
nodes.

iPad Visualizing
relationships: Network
widget, page 112

Photo
Uploader
widget

Allows users to upload images by taking a new
image or using an existing image on their mobile
device.

iPhone,
iPad,
Android

Uploading images:
Photo Uploader
widget, page 113

RSS Reader
widget

Allows users to view and update an RSS news
feed.

iPhone,
iPad

Displaying RSS feeds:
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Widget Description Displays
on

Link

RSS Reader widget,
page 116

Survey
widget

Allows users to interact with the survey in a
Transaction Services-enabled document and
submit their answers, which are then stored in
your data source.

iPad Gathering data from
users: Survey widget,
page 119

Timeline
widget

Allows users to view events or important
milestones in the status of a product.

iPad Displaying a Timeline
widget, page 121

Time Series
widget

Displays data for a specific period of time in a line
graph.

iPhone,
iPad,
Android

Displaying data
trends: Time Series
widget, page 125

Video Player Play video directly in a document. Videos can be
cached for offline viewing.

iPhone,
iPad

Downloading and
playing videos: Video
Player widget, page
128

If you are designing widgets for an iPhone or Android device, you can determine
whether the widget takes up the entire screen. For steps, see Displaying widgets
using the entire screen on mobile devices, page 130.

Some widgets are also available as interactive visualizations in Visual Insight, which
allows you to quickly create a customized, interactive Visual Insight dashboard.

In a dashboard, users can add or remove attributes and metrics, change the type of
visualization that is used, or create new filters and thresholds in the dashboard on-the-
fly. Consider using dashboards when your users want a high degree of interaction with
their data. Dashboards can be especially helpful in strategic business meetings to
spontaneously discover the answer to any business queries that come up.

You can create visualizations that highlight or filter other visualizations in a dashboard
when a user taps on an attribute element in the visualization.

For steps to create a dashboard, see theMicroStrategy Web Help.

The following visualizations can be viewed in a dashboard on an iPad:

• Density Map visualization

• Grid visualization

• Graph visualization

• Graph Matrix visualization

• Heat Map visualization

• Image Layout visualization

• Map visualization

• Map with Areas visualization
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• Network visualization

Displaying widgets as grids or graphs
You can determine whether mobile widgets are displayed as widgets or grid or graph
reports on mobile devices. For detailed procedures on displaying widgets, see the
Dashboards and Widgets Creation Guide.

After upgrading from MicroStrategy 9.2.1m, widgets that were previously created
to display on Android tablets may display as grids or graphs on the mobile device.
To display these widgets on Android tablets, ensure that Android Tablet is
selected as a display option for the widget. For detailed procedures on displaying
your widgets on Android tablets after an upgrade from MicroStrategy 9.2.1m, see
the Upgrade Guide.

Displaying a Data Cloud widget
A Data Cloud widget for the iPhone and iPad displays the names of attribute elements in
various font sizes to depict the differences in metric values between the elements. This
type of widget allows users to quickly identify the most significant positive or negative
contributions.

A Data Cloud widget is a list of attribute elements. The first metric on the widget’s
template determines the font size for the attribute elements. A bigger font for an element
indicates a larger metric value.

For steps to add a Data Cloud widget to a document and specify formatting options, see
the Dashboards and Widgets Creation Guide. You can also define an Information
Window that displays when an attribute element is tapped. For instructions on creating
an Information Window, see Providing additional information to users: Information
Windows, page 38.

Displaying an interactive event calendar: Date
Selection widget
The Date Selection widget displays events in an interactive calendar in either a Month,
Week, or Day view on an iPad. An example of a Date Selection widget is shown below:

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/UpgradeGuide/WebHelp/Lang_1033/index.htm
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Use the Date Selection widget as a calendar of events or appointments within your app.
Users can select an event to display an Information Window or open a link containing
information on the event. If you have Transaction Services, users can then edit or delete
events.

For instructions on creating an Information Window, see Providing additional
information to users: Information Windows, page 38. For steps to define a link in a
widget using the Links Editor, see the Providing Flash Analysis and Interactivity:
Widgets chapter in the Dashboards and Widgets Creation Guide.

You can also use the Date Selection widget as a filter for the data in your dashboard.
Users can select an event on the widget and automatically update the rest of the
dashboard with data that relates to the event. To do this, you define the Event attribute
as a selector. For steps, see the Dashboards and Widgets Creation Guide.

Prerequisites

For a Grid/Graph to be used as a Date Selection widget, it must include at least two
attributes on the rows. These attributes must meet the following criteria:

• The first attribute represents each day displayed in the calendar, and must contain
elements of the Date data type.

• The second attribute provides the events displayed in the calendar, and uses the
following attribute forms:

▫ The first attribute form contains a description of the event.

▫ The second attribute form (optional) contains the image displayed for the event
when the widget is shown in Day View. This attribute form must be of the image
data type.

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
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▫ The third attribute form (optional) contains the image displayed for the event
when the widget is shown in Week View. This attribute form must be of the
image data type.

• The third attribute (optional) provides the category name of each event in the
calendar, and is used to color-code the events. It uses the following attribute forms:

▫ The first attribute form contains the description of the category.

▫ The last attribute form (optional) contains the color in which to display the
category, stored as a hex value. The value must be of the form 0xFFFFFF or
FFFFFF.

Additional attributes, if any, are displayed when a user taps on the event in the
calendar.

You can add objects from multiple datasets to the Grid/Graph containing the widget. You
must have the correct privileges and the project must allow Grid/Graphs to use multiple
datasets. For steps to allow Grid/Graphs to use multiple datasets, see the Adding Text
and Data chapter of the Document Creation Guide.

To create a Date Selection widget for mobile devices

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 From the Insert menu, point toWidgets, thenMobile, and select Date
Selection.

3 Click the location on your document where you want to place the widget. The
Grid/Graph containing the widget is displayed.

4 Optionally, resize the widget by clicking and then dragging its handles.

5 From the Dataset Objects panel on the left, select attributes and drag them on to the
widget. Place at least two attributes on the Grid/Graph’s rows, as described in the
prerequisites above.

Formatting a Date Selection widget

You can format a Date Selection widget by:

• Selecting whether events in the Month view are grouped by day or week. For steps,
see To select the grouping of events in the Month view.

• Automatically assigning colors to event categories. The colors are based on the
elements of the categorization attribute of the widget’s dataset. For steps, see To
automatically assign colors to event categories, page 84.

• Specifying the color of each event category. For steps, see To assign a specific color
to each category, page 84.

• Selecting which view (month, week, or day) the widget displays initially. For steps,
see To set the default display view.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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Prerequisite

The following procedures assume that you have already created the Date Selection widget
you want to modify.

To select the grouping of events in the Month view

1 Open the document in Flash Mode.

2 Right-click the widget, then select iPad Properties. The iPad Date Selection dialog
box is displayed.

3 From theMonth view is displayed by drop-down list, select one of the
following:

• Day: When the widget is shown in the Month view on an iPad, events are
grouped by day.

• Week: When the widget is shown in the Month view on an iPad, events are
grouped by the week.

4 Click OK to save your changes.

To automatically assign colors to event categories

1 Open the document in Flash Mode.

2 Right-click the widget, then select iPad Properties. The iPad Date Selection dialog
box is displayed.

3 From the Color events by drop-down list, select Attribute.

4 From the Series color palettes, select the colors you want to use to display the
event categories. Each color will automatically be assigned to a category and
displayed when the widget is viewed on a mobile device.

5 Click OK to save your changes.

To assign a specific color to each category

1 Open the document in Flash Mode.

2 Right-click the widget, then select iPad Properties. The iPad Date Selection dialog
box is displayed.

3 From the Color events by drop-down list, select Attribute Form. The events are
color-coded based on the attribute form that contains the color for each category.

4 Click OK to save your changes.
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To set the default display view

1 Open the document in Flash Mode.

2 Right-click the widget, then select iPad Properties. The iPad Date Selection dialog
box is displayed.

3 From the Default View drop-down list, select one of the following:

• Month (default)

• Week

• Day

4 Click OK to save your changes.

Displaying data in an interactive graph: Graph Matrix
widget
The Graph Matrix widget allows you to quickly analyze various trends across several
metric dimensions. The widget consists of several line graphs that allow users to analyze
and compare trends in metric data.

An example of the Graph Matrix widget is shown in the image below.

For steps to add a Graph Matrix widget to a document and specify formatting options,
see the Dashboards and Widgets Creation Guide. You can also define an Information
Window that displays when a graph is tapped. For instructions on creating an
Information Window, see Providing additional information to users: Information
Windows, page 38. You can define a link in the widget to open a report or another
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document. For steps to define a link in a widget using the Links Editor, see the
Providing Flash Analysis and Interactivity: Widgets chapter in the Dashboards and
Widgets Creation Guide.

You can also use the Graph Matrix visualization in dashboards. For information on
creating analyses, refer to theMicroStrategy Web Help.

Displaying data in a Heat Map widget
The Heat Map widget for the iPad and Android tablet displays elements as rectangles and
lets users quickly grasp the state and impact of a large number of variables at one time.
An example of the Heat Map widget on the iPad is shown below:

For steps to add a Heat Map widget to a document and specify formatting options, see
the Dashboards and Widgets Creation Guide.

You can also use the Heat Map visualization in dashboards. For information on creating
analyses, refer to the MicroStrategy Web Help.

By default, the header for each group in a Heat Map widget is displayed in the middle of
the group. For example, in the Heat Map widget above, Northeast is displayed in the
middle of all elements that belong to Northeast. For steps to display headers at the top of
the widget, see the procedure below.

You can define an Information Window that displays when a rectangle is tapped. For
instructions on creating an Information Window, see Providing additional information
to users: Information Windows, page 38.

You can create a link on one of the attributes in the widget that opens a report or
another document. For steps to define a link in a widget using the Links Editor, see the
Providing Flash Analysis and Interactivity: Widgets chapter in the Dashboards and
Widgets Creation Guide.

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
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Displaying data as an overlay on an image: Image
Layout widget
You can add an Image Layout widget to a document to display an image overlaid with
colored areas or bubble markers. For example, you can display a map of the United
States, with a bubble marker displayed over each state. You can have states with a high
number of stores displayed using large bubble markers, and states with a low number of
stores displayed using small bubble markers. As another example, you can display the
layout of a store in the widget, with each aisle displayed as a separate region, then have
MicroStrategy automatically color each aisle based on the number of visits each aisle
receives. The image below shows an Image Layout widget with a map of a store, in which
each section of the store is displayed as a separate colored region.

You can display the Image Layout widget on an iPad or Android tablet with
MicroStrategy Mobile. For steps to add an Image Layout widget to a document and
specify formatting options, see the Dashboards and Widgets Creation Guide.

A shape file is an HTML file that contains the image that you want to display in the
widget, as well as the location of each bubble marker or area you want to display on top
of the image. MicroStrategy provides several default shape files for you to choose from,
including a map of countries of the world and a map of states in the United States.

You can define your own shape file for use in the widget, such as the layout of a store or
floor in a building, using the same steps as you would to customize an Image Layout
visualization. You can also create multiple shape files and have the user choose which
shape file displays in the widget. For steps, see the Dashboards and Widgets Creation
Guide.

You can also define an Information Window that displays when a marker or an area is
tapped. For instructions on creating an Information Window, see Providing additional
information to users: Information Windows, page 38.

Displaying images: Image Viewer widget
You can use the Image Viewer widget to display images and image description in a
document on an iPhone, iPad, or Android device with MicroStrategy Mobile. Users can



Mobile Design and Administration Guide

© 2017, MicroStrategy Inc. 88

zoom in and out of the images.

For iPhone and iPad, you can choose to display the images in a slide show, filmstrip, or
matrix layout, specify the captions to display for each image, format the background and
border color of the widget, and so on.

You can define:

• An Information Window that displays when an image is tapped. For instructions on
creating an Information Window, see Providing additional information to users:
Information Windows, page 38.

• A link in the widget to open a report or another document. For steps to define a link
in a widget using the Links Editor, see the Providing Flash Analysis and
Interactivity: Widgets chapter in the Dashboards and Widgets Creation Guide.

Prerequisites

• You must create an attribute to place on the widget’s Grid/Graph, with the following
attribute forms:

▫ The first attribute form contains the location in which each image is saved.

▫ The second attribute form contains a description of each image.

▫ The third attribute form contains the unique numeric ID of each image.

To add an Image Viewer widget to a document

1 Open the document in Design or Editable Mode.

2 From the Insert menu, point toWidgets, then point toMobile, and select
Image Viewer.

3 Click the location on your document where you want to place the widget. The
Grid/Graph containing the widget is displayed.

4 Optionally, resize the widget by clicking and then dragging its handles.

5 From the Dataset Objects panel on the left, select attributes and metrics, and drag
them on to the Grid/Graph, as described in the prerequisites above.

To choose the attribute forms displayed for an attribute in the widget, right-click
the header of the attribute, point to Attribute Forms, then select the attribute
forms to display.

Configure the widget’s display properties

6 Right-click the widget, then select Properties and Formatting. The Properties
and Formatting dialog box opens.

7 From the left, selectWidget.

8 Click theWidget Properties icon. The Image Viewer Properties dialog box opens.
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9 From the Display Style drop-down list, select the display style to use to show
images in the widget, as follows:

• To display the images in an interactive slideshow, select Slideshow (default).
Users can switch between images by performing a horizontal swipe motion on
the mobile device.

• To display the images in a filmstrip layout, select Filmstrip. Users can scroll
through images vertically or horizontally, as determined by the Scroll Direction
option described below.

• To display the images in a table layout, with evenly spaced rows and columns,
selectMatrix. You can specify the number of rows and columns displayed in
the table using the Number of Rows and Number of Columns options described
below.

10 You can determine whether to display images in the widget in a vertical or horizontal
layout. This option is only available if the Display Style option is set to Filmstrip.
From the Scroll Direction drop-down list, select one of the following:

• To display images in a vertical layout, select Vertical (default). Users can
perform a vertical swipe motion on the mobile device to scroll through the
images.

• To display images in a horizontal layout, selectHorizontal. Users can perform
a horizontal swipe motion on the mobile device to scroll through the images.

11 You can determine how many rows of images are displayed in the widget. In the
Number of Rows field, type the number of rows to display. This option is only
available if the Display Style option is set to Matrix.

12 You can determine how many columns of images are displayed in the widget. In the
Number of Columns field, type the number of columns to display. This option is
only available if the Display Style option is set to Matrix.

13 From the First Caption Line drop-down list, select the attribute form that
contains the first line of captions you want to display for images in the widget.

14 From the Second Caption Line drop-down list, select the attribute form that
contains the second line of captions you want to display for images in the widget.

15 You can specify the default action (such as drilling on an attribute or opening a
report or document) to perform when the user taps an image caption in the widget.
From the Default Action Form drop-down list, select an attribute form. The
action defined for this attribute form will automatically be performed when the user
taps the caption.

16 From the Background Color palette, select the background color of the widget by
doing one of the following:

• To display a transparent background color, click No Fill.

• To display a solid background color, select the background color from the
palette. You can access additional colors by clickingMore Colors.

17 From the Border Color palette, select the color of the border to display around the
images in the widget by doing one of the following:
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• To display the borders as transparent, click No Fill.

• To display a solid border color, select the border color from the palette. You can
access additional colors by clickingMore Colors.

18 From the Border Width drop-down list, select the thickness of the border to
display around the images. The default value is 5 pixels.

19 Click OK to return to the Properties and Formatting dialog box.

20 Click OK to save the changes.

Displaying data in rows and columns: Interactive Grid
widget
The Interactive Grid widget allows you to display data in a compact tabular layout on an
iPhone, iPad, or Android device. Attributes and metric values are displayed in columns in
the widget, as shown below. You can specify multiple display options for the widget, such
as whether to apply banding to the rows in the widget, whether to display multiple
attributes or metrics in a column as stacked together in a single row or allow users to
toggle between the values displayed in the column, and so on.

You can allow users to directly edit the data displayed in the widget using a mobile device.
For example, you create a widget to display a list of time off requests. A user can tap a
button next to each request to display a check mark for approved requests and an X for
rejected requests, then submit their changes to their data source. To accomplish this, you
must link the widget's Grid/Graph to a Transaction Services report. For steps and
background information about Transaction Services, see the Advanced Documents
chapter in the Report Services Document Creation Guide.

You can allow users to perform an action when they tap an attribute or metric in the
widget on a mobile device. To do this, you must assign the action to the attribute or
metric on the widget's Grid/Graph in Web. For example, if several customer regions are
displayed in an Interactive Grid widget, you can allow users to tap the name of a
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customer region to update the data displayed in another grid in the document. Only one
action can be performed for each attribute or metric. If more than one action is enabled
for an attribute or metric, the action with the highest priority is performed. You can
enable the following actions for a value in the widget, in order of highest to lowest
priority:

• Edit data for the attribute or metric, by displaying the attribute or metric as an input
object control in a Transaction Services-enabled document. For steps and
background information about Transaction Services, see the Advanced Documents
chapter in the Report Services Document Creation Guide.

• Use an attribute or metric in the widget as a selector. To do this, you must define the
attribute or metric as a selector on the widget's Grid/Graph. For steps, see the
MicroStrategy Web Help.

• Open a link to a report or document. For steps to define a link in a widget using the
Links Editor, see the Providing Flash Analysis and Interactivity: Widgets chapter in
the Dashboards and Widgets Creation Guide.

• Drill on an attribute element. For steps to enable drilling in a Grid/Graph, see the
Displaying Reports in Documents: Grid/Graphs chapter in the Report Services
Document Creation Guide.

The steps to add an Interactive Grid widget to a document follow.

Prerequisites

For a Grid/Graph to be used as an Interactive Grid widget, it must meet the following
requirements:

• At least one attribute on the rows. The elements of this attribute are displayed in the
first column of the widget.

• At least one metric on the columns. The metric values are displayed in additional
columns in the widget.

You can add objects from multiple datasets to the Grid/Graph containing the widget. You
must have the correct privileges and the project must allow Grid/Graphs to use multiple
datasets. For steps to allow Grid/Graphs to use multiple datasets, see the Adding Text
and Data chapter of the Document Creation Guide.

To create and add an Interactive Grid widget to a document

1 Open the document in Design or Editable Mode.

2 From the Insert menu, point toWidgets, thenMobile, and select Interactive
Grid.

3 Click the location on your document where you want to place the widget. The
Grid/Graph containing the widget is displayed.

4 Optionally, resize the widget by clicking and then dragging its handles.

5 From the Dataset Objects panel on the left, select attributes and metrics, and drag
them on to the Grid/Graph, as described in the prerequisites above.
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Configure the widget’s display properties

6 Right-click the widget, then select Properties and Formatting. The Properties
and Formatting dialog box opens.

7 From the left, selectWidget.

8 Click theWidget Properties icon . The Interactive Grid Properties dialog box

opens.

9 If you added more than one attribute to the widget, you can group the data displayed
in the widget based on the first attribute in the widget’s Grid/Graph. Do one of the
following:

• To group the data displayed in the widget, do the following:

a Select the Apply Grouping to check box. The first attribute on the
widget’s Grid/Graph is automatically used to group the data when the widget
is viewed.

b You can change the background color used for the attribute elements in the
grouping. From the Grouping background drop-down list, select the
color you want to use as the background for the attribute elements. In the
example image above, Grouping background is set to gray.

To remove the grouping background you applied, select No Fill.

c You can change the font size used for the attribute elements in the grouping.
From the Grouping Font Size drop-down list, select the size of the font
you want to use. In the example image above, Grouping font size is set to 16.

d To change the font size of the column headings, from theHeader Font
Size drop-down list, select the size of the font you want to use.

e To change the font size of the data displayed in the Interactive Grid, from
the Values Font Size drop-down list, select the font size you want to use.

• To display the widget without grouping its data, clear the Apply grouping to
check box.

10 From the Color Theme drop-down list, select a color theme to use to display the
background color, border color, and header color of the widget.

11 By default, the rows of the widget are not banded. To apply banding to the widget,
select the Banding check box.

12 By default, the width of the columns in the widget is automatically determined. To
manually specify the width of each column, clear the Automatic column sizing
check box. In theWidth (%) fields, specify the width of each column as a
percentage. The widths for all columns should add up to 100.

13 You can select a default action (such as drilling on an attribute, opening a report or
document, or acting as a selector) to perform for attributes and metrics that have no
action defined on the widget’s Grid/Graph. From the Default Action Form drop-
down list, select an attribute. The action defined for this attribute will automatically
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be performed when a user taps a value in the widget for which no action is explicitly
defined.

It is recommended that you assign an action to only one attribute form in the
widget. For example, if you want one attribute to act as a selector, ensure that
drilling is disabled for the Grid/Graph, and that the attribute does not link to
another report or document.

14 If you place multiple attributes or metrics in a column, you can choose whether to
display each attribute element or metric value stacked together in a single row in the
widget, or to allow the user to tap the header of a column to change which attribute
or metric value is displayed. Do one of the following:

• To allow users to tap a column header to change which object is displayed, select
the Toggle check box.

• To display each object as stacked values in a single row, clear the Toggle check
box. Column headers are not displayed when values are displayed as stacked.

15 You can create, rearrange, or delete columns in the widget:

• To rearrange report objects within the columns, click a report object and drag it
to a new location.

• To add a new column to the widget, click Add Column. The new column is
added and displayed.

• To delete a column, click to the right of the column.

The first two columns in the widget are added to the widget by default and
cannot be deleted.

16 Click OK to return to the Properties and Formatting dialog box.

17 Click OK to save the changes.

Displaying geographical data: Map widget
With a Map widget, users can search and view information for locations on a map on an
iPhone, iPad, or Android device. You can specify the geographical location of each
location on the map by either supplying the location as a spatial point, or by providing
separate values for the longitude and latitude.

Locations on the map are displayed as map markers, bubble markers, color-coded areas,
or points along a path displayed on the map. Tapping a location displays an Information
Window with additional details about the selected location, as shown below:
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You can display data in the Map widget in the following ways:

• Display your data using static images as map markers. You can define a threshold on
this metric to change the image used for the map markers. For information on
defining thresholds on a metric, see theMicroStrategy Web Help.

• Display your data using bubble markers. The size of each bubble marker is
automatically determined based on the value of the metric on the columns of the
widget. You can define a threshold on this metric to change the color of the bubble
markers. For information on defining thresholds on a metric, see theMicroStrategy
Web Help.

• For iPhone and iPad documents, display your data as areas color-coded based on the
population density of locations on the map. For example, you can display areas with
a high concentration of stores in red, and areas with a low concentration of stores in
blue.

• Display your data as points on a path displayed on the map. The line used to
represent the path is displayed as thicker for larger metric values and thinner for
smaller metric values. For example, you can display ridership at different stops along
a train route, with the most popular stations displayed with the thickest lines
extending from the station.

• For iPhone and iPad documents, color-code geographical regions, based on your
data. For example, you can give each country displayed on a map a different color,
based on their type of government. MicroStrategy provides maps with pre-defined
regions, such as countries of the world or states in the US.

• Create and format a custom Information Window, which is a pop-up window that
displays additional data, for the Map widget. For steps to define an Information
Window, see Providing additional information to users: Information Windows,
page 38.

• Filter the locations displayed on a Map widget to view only those locations that meet
certain criteria. For example, if store locations are displayed on the widget, you can
limit the displayed stores to only those within a specified zip code. For more
information on filtering by geographical location, see Using the Geo Location
prompt in the Map widget, page 102.
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• For iPhone and iPad documents, once you create a Map widget, you can display lines
that show relationships between locations on the map. For steps to use lines for
relationships, see Using lines to display relationships between locations in a Map
widget, page 105.

To display your data in the Map widget, you must provide geographical information for
each location in the map using attributes or attribute forms. You can provide this data in
the following ways:

• During the import data process, you can define an attribute and assign it a geo role to
identify what type of geographical information it contains. For example, you can
create an attribute called City, which contains the names of multiple cities, then
assign it the City geo role. Web automatically creates the City attribute with the
attribute forms Latitude and Longitude, which contain the latitude and longitude of
each city. You can then use the City attribute to provide latitude and longitude
information for locations in the widget. Web automatically adds latitude and
longitude information as attribute forms to data columns with the Country, State, Zip
Code, City, or Location geo roles. You can also use attributes that have been assigned
the Latitude or Longitude geo roles to provide geographical information as attributes,
as described in the prerequisites below. For background information on importing
data into MicroStrategy Web, including steps to assign a geo role to an attribute, see
the MicroStrategy Web Help. For steps to assign a geo role to an attribute in
Developer, see the Developer Help.

• Your administrator can create attributes containing location data to support the Map
widget. Steps to create location data are included in theWarehouse Structure for
Your Logical Data Model chapter in the Project Design Guide.

https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/ProjectDesignGuide/WebHelp/Lang_1033/index.htm
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Creating a Map widget

Prerequisites

The Grid/Graph for the Map widget must meet the following requirements:

• Place the attribute or attributes containing the geographical information on the
rows. The attributes must provide this information in one of three ways:

▫ If you want to display geographical regions on the map, you must provide an
attribute whose values match the names of regions in a map provided by
MicroStrategy. You select the map you want to use in the steps below.

For example, MicroStrategy provides a map called Countries of the World. To
display a map that contains a colored area for each country in which your
company has sales representatives, you can create an attribute called Country,
which contains the names of these countries, then use the Country attribute to
provide location information in a widget that uses the Countries of the World
map.

▫ To provide the geographical information using attributes, you must provide one
of the following:

— One attribute that contains the latitude of each location and one attribute
that contains the longitude of each location. For example, you can provide
an attribute that has been assigned the Latitude geo role and an attribute
that has been assigned the Longitude geo role.

— One attribute that provides geographical information for each location as a
point.

▫ To provide the geographical information using attribute forms, you must provide
one of the following:

— One attribute, which provides the latitude and longitude of each location
using separate attribute forms. For example, you can provide an attribute
that has been assigned the Country, State, Zip Code, City, or Location geo
roles.

— One attribute that provides geographical information for each location as a
point, using a single attribute form.

If you are using attribute forms, be sure that the attribute forms
containing the geographical information are visible in the grid. Right-click
the header of the attribute, point to Attribute Forms, then select the
attribute forms you want to display.

• Place at least one metric on the columns. You can define a threshold on this metric
to change the display of markers on the map. For more information on thresholds,
see the MicroStrategy Web Help.

You can add objects from multiple datasets to the Grid/Graph containing the widget. You
must have the correct privileges and the project must allow Grid/Graphs to use multiple

https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
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datasets. For steps to allow Grid/Graphs to use multiple datasets, see the Adding Text
and Data chapter of the Document Creation Guide.

To create and add a Map widget to a document for mobile devices

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 Go to Insert >Widgets >Mobile >Map.

3 Click the location on your document where you want to place the widget. The
Grid/Graph containing the widget is displayed.

4 Optionally, resize the widget by clicking and then dragging its handles.

5 From the Dataset Objects panel on the left, select attributes and metrics, and drag
them on to the Grid/Graph, as described in the prerequisites above.

Configure the widget’s display properties

6 Right-click the widget, then select Properties and Formatting. The Properties
and Formatting dialog box opens.

7 From the left, selectWidget.

8 On the right, ensure that the check boxes for the mobile devices you are designing
for are enabled, as applicable.

9 Click theWidget Properties icon . The Map Properties dialog box opens.

10 You can replace map markers with static images, bubble markers, color-coded areas
based on the population density of locations on the map, or geographical regions. Do
one of the following:

• To use map markers to mark locations on the map, select the Use Image
Markers option. From the drop-down list, select the marker image to use to
display locations on the map. A preview of the selected marker style is displayed
to the right of the drop-down list.

• To use bubble markers to mark locations on the map, select the Use Bubble
Markers option. The size of each bubble marker is automatically determined
based on the value of the metric on the columns of the widget.

• To use shades of color to indicate the concentration of locations on the map,
select the Use Density Maps option. From the drop-down list, select the color
theme to use to automatically color areas on the map. A preview of the selected
color theme is displayed to the right of the drop-down list.

• To display locations on the map as points on a path, select the Use as a Path
on the Map option. From the drop-down list, select the color of the line to use
to display the map path.

• To display geographical regions on the map, select the Show Areas option.
From the drop-down list, select the regions you want to use in the map.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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11 You can determine how to size bubble markers representing negative metric values.
From the Negative Values are Represented As drop-down list, select one of
the following:

• To use the absolute value of the metric to size the bubble marker, select
Absolute Numbers. For example, a bubble representing a metric value of -
2,500 will be displayed as the same size as a bubble representing 2,500.

• To display bubble markers representing negative metric values as bubbles with a
size of 7 pixels, select Bubbles Sized at 7 Pixels.

12 You can determine whether to apply threshold formatting to image markers or
bubble markers in the widget. Do one of the following:

• To enable threshold display, select the Apply threshold for the map check
box.

• To disable threshold display, clear the Apply threshold for the map check
box.

13 You can choose to provide geographical information for the widget using attributes
or attribute forms. From the Use Attribute or Form drop-down list, select one of
the following:

• To provide geographical information using attributes, select Use Attribute.

• To provide geographical information using attribute forms, select Use
Attribute Form.

14 You can determine whether to provide geographical information to the widget as a
point, or as separate latitude and longitude values. Do one of the following:

• To define the location as a point:

▫ From the Select Data Type drop-down list, select the Point option.

▫ If the Use Attribute or Form drop-down list is set to Use Attribute
Form, from the Select Attribute drop-down list, select the attribute that
contains the attribute form you want to use to display the widget.

▫ From the Select Point drop-down list, select the attribute or attribute form
that contains the point information.

• To define the location as a latitude and longitude:

▫ From the Select Data Type drop-down list, select the
Latitude/Longitude option.

▫ If the Use Attribute or Form drop-down list is set to Use Attribute Form,
from the Select Attribute drop-down list, select the attribute that contains
the attribute forms you want to use to display the widget.

▫ From the Select Latitude drop-down list, select the attribute or attribute
form that contains the latitude information.

▫ From the Select Longitude drop-down list, select the attribute or attribute
form that contains the longitude information.
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15 From the Selection Display Attribute/Form drop-down list, select the attribute
to use to display data in the Information Window when the user selects locations in
the widget.

16 By default, if multiple locations in the widget have the same latitude and longitude—
for example, two stores located in the same building—a separate map marker is
displayed for each location. If you are designing this widget to be displayed on an
iPhone or iPad, you can choose to display a separate map marker for each store, or
display a single map marker for all of the stores at that location. Do one of the
following:

• To display a single map marker, select the For repeated rows, display only
one marker for same location check box. When the user taps the map
marker on the document, information for each location at the selected latitude
and longitude is displayed. If map markers in the widget are displayed as bubble
markers and a group of locations are located at the same latitude and longitude,
the bubble marker for this group is sized and colored based on the last location
in the group, as displayed in the widget. If subtotals are displayed in the widget,
the subtotal for the group is used to size and color the bubble marker.

• To display a separate map marker for each location, clear the For repeated
rows, display only one marker for same location check box.

17 On a mobile device, tapping a map marker on the map displays additional
information about the location in an Information Window.

You can define a layout in the document to use as a custom Information Window,
and format its appearance. Select the Display Information Window from
document layout check box. For instructions to configure the layout to use as the
Information Window, see To specify a layout as an Information Window in a Map
widget, page 101.

If you are designing the document for both iOS and Android devices, it is
recommended that you use a panel stack as the Information Window. For
detailed steps to define panel stacks as Information Windows, see Providing
additional information to users: Information Windows, page 38.

• From the Select Layout to use drop-down list, select the name of the layout
to use as the Information Window.

18 You can specify the display theme to use to display the widget. For example, you can
display the map as a satellite image, a map with topographical details, and so on.
From the Default View drop-down list, select a display theme.

19 You can specify the type of magnification to apply to the map when the user selects a
location in the widget. From the Redraw Behavior on Selector Action drop-
down list, select one of the following:

• To maintain the widget's current level of magnification, select Keep the
Current Zoom.

• To refit the contents of the widget to the selected area, select Refit the
Content.
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20 You can let users select areas, zoom in and out of the widget, and so on using the
map toolbar. Under Map Elements Visibility Options, choose from the following:

• To display the map toolbar at the top of the widget, select theMap toolbar
check box. This option is selected by default.

• To allow the user to select which display theme to use to display the map, select
theMap view options check box. This option is selected by default.

• To display a slider that allows the user to zoom in and out of the map, select the
Zoom bar (Web only) check box. This option is selected by default.

• To allow the user to view a list of the areas he has selected in the widget, select
the Selection list bucket (Mobile only) check box. This option is selected
by default.

• To display the Current Location icon, which allows MicroStrategy to access an
iPad user's current location, select the Current location (Mobile only)
check box. If this option is selected, the icon is displayed even if the document
does not have a Geo Location prompt. This option is cleared by default.

Complete the widget

The plus sign (+) at the top of the interface allows you to add additional
datasets to the Map widget for display in MicroStrategy Web. For steps to add
additional datasets for Web, see the GIS Integration Help.

21 Click OK to return to the Properties and Formatting dialog box.

22 Click OK again to save changes.

Using a layout as an Information Window in a Map widget

When a user taps a map marker in a Map widget on an iPhone, iPad, or Android device,
a pop-up window is displayed. This Information Window provides additional details
about the location, such as the location name and related metric values, as shown below:
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Information Windows are automatically displayed for all markers, using a default layout
and format. You can create and format a custom Information Window to display for a
Map widget. To define a custom Information Window, you create a document layout,
using either Developer or Web. You then enable the layout to be displayed as an
Information Window and specify the layout as the Information Window in the Map
widget’s properties. Layouts enabled as an Information Window are not displayed with
the other layouts in a document and are only displayed on mobile devices.

If you define an Information Window in a separate document, you can reuse the
Information Window layout by importing it into other documents. For instructions on
importing layouts, see the Document Creation Guide.

Prerequisite

This procedure assumes you have already added a Map widget to the document. For
instructions, see To create and add a Map widget to a document for mobile devices,
page 97.

To specify a layout as an Information Window in a Map widget

1 In MicroStrategy Web, open the document that contains the Map widget in Design
Mode.

Create the layout to use as the Information Window

2 Choose Insert > Layout. The Insert Layout dialog box opens.

3 Do one of the following to define a style for the new layout:

• To define a layout style, click the Layout tab, then select a layout style.

• To import a layout from a saved document, click the Document tab, then select
a previously saved document.

4 Click OK. The new layout is displayed.

Add content to the layout

5 The content that you add to this layout is displayed in the Information Window. You
can add any controls to the layout, including text fields, Grid/Graphs, images,
shapes, and so on. For instructions, about designing documents, see the Report
Services Document Creation Guide.

The container that displays the Information Window on the iPhone is 1.5
inches wide. Its height is defined to fit to the content, with a maximum height
of 1 inch.

Enable the layout to be displayed as an Information Window

6 From the Tools menu, select Document Properties. The Properties dialog box
opens.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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7 From the Layout Properties section on the left, selectMobile.

8 Select the Use as Information Window check box.

9 Click OK. The layout is enabled as an Information Window.

Specify the Information Window layout to be displayed in the Map widget's
properties

10 Select the tab of the layout that contains the Map widget, then right-click the widget.

11 Select Properties and Formatting. The Properties and Formatting dialog box
opens.

12 From the left, selectWidget.

13 Click theWidget Properties icon . The Map Properties dialog box opens.

14 Select the Display Information Window from document layout check box.

15 From the Select Layout to use drop-down list, select the name of the layout to
use as the Information Window.

16 Click OK to apply the changes.

17 Click OK to return to the document.

Using the Geo Location prompt in the Map widget

The Geo Location prompt lets users answer a prompt by using the device’s current
geographical location. In a Map widget, a Geo Location prompt is typically used to filter
data in the widget. For example, you can choose to display only those map markers that
are in your current state.

You cannot add a prompt directly to a document; you must define the prompt on
the dataset reports used for the document. For more information on using
prompts in documents, see the Document Creation Guide.

You can create the Geo Location prompt to do the following:

• To automatically use the device’s current longitude and latitude to filter the widget’s
results, define value prompts with the display style set to Geo Location. You must
define two value prompts, one for latitude and one for longitude. The prompts are
then automatically answered and do not display in the interface.

• To filter an attribute element list using the current geographical location, you can
define an attribute element prompt with the display style set to Geo Location.

Geo Location prompts are defined in MicroStrategy Web. For instructions, see
Prompting users for their location: Geo Location prompts, page 64.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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Filtering data based on geographical distance from a mobile device

You can filter data in a report to display information based on the distance between a
location on the report, and the current location of an iPhone, iPad, or Android device.
For example, in the image below, a report displays a list of stores.

When the report is viewed on a mobile device, the user can choose to display only stores
within a ten mile radius, as shown in the image below.

If the report is displayed as a Map widget, only map markers for stores within a ten mile
radius are displayed, as shown below.

To filter data based on the distance from a point of interest to a mobile device, you must
first create a metric to calculate this distance. The steps to create this metric are
described below.

Once you have created the distance calculation metric, you can use it to filter data by
creating a prompt or filter using the metric. For example, you can:

• Create a prompt to allow users to display only data for locations within a specified
radius of the mobile device.
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• Create a filter to automatically display data only for locations greater than a certain
distance from the mobile device.

• In a Map widget, display map markers only for locations within a specified radius.

Prerequisites

• You must create an attribute with attribute forms containing the latitude and
longitude of each location to use for the distance calculation. For example, the Store
attribute in the example above has two attribute forms, Latitude and Longitude,
which contain the latitude and longitude information for each store.

• You must create two Geo Location prompts, one each for the latitude and longitude.
The prompts must be created as value prompts, as described in Allowing users to
filter data based on a single value: Value prompts, page 58.

To create a metric to calculate the distance between locations and a
mobile device

1 In Developer, from the Filemenu, point to New, and thenMetric. The New
Metric dialog box opens.

2 Click OK to create a new metric. The Metric Editor opens.

3 In the Definition pane, type the formula of the metric you want to create. Use the
syntax in the table following this procedure for the metric’s definition.

4 Click Save and Close. The Save As dialog box opens.

5 In the Object name field, type the name of the new metric. Use the name provided
in the table below.

6 Navigate to the location in which you want to save the new metric, then click Save.
The new metric is created.

7 Repeat the appropriate steps above to create each of the metrics required to calculate
the distance to each store.

8 Once you have created the distance calculation metric, Point_Distance, you can
create any of the following prompts to use the metric:

• A Metric Qualification prompt. You can add the prompt to a report to let users
specify a distance radius for which to display data. For information on creating
Metric Qualification prompts, see the MicroStrategy Web Help.

• A Metric Set Qualification filter. You can add the filter to a report or to a dataset
report in a document, to automatically filter the data using the current location
of the mobile device.

• A prompt or filter that will use the metric, added to a report displayed as a Map
widget, or to the dataset report of a Map widget in a document. When the Map
widget is displayed on a mobile device, only the map markers for locations
within the specified distance from the mobile device are displayed.

https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
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Metric Name Metric Definition

Location_Lat Max(AttributeName@LatitudeFormName)

Replace AttributeName with the name of the location attribute, and replace
LatitudeFormName with the attribute form that contains the latitude information
for each location. For example, for an attribute named Store with the attribute forms
Latitude and Longitude, create a metric with the name Location_Lat, with the
definition Max(Store@Latitude).

Location_
Long

Max(AttributeName@LongitudeFormName)

Replace AttributeName with the name of the location attribute, and replace
LongitudeFormName with the attribute form that contains the longitude
information for each location. For example, for an attribute named Store with the
attribute forms Latitude and Longitude, create a metric with the name Location_
Long, with the definition Max(Store@Longitude).

DeltaLat/2 (Radians(([Location_Lat] -
?LatitudePromptName)) / 2)

Replace LatitudePromptName with the name of the value prompt for latitude. For
example, if the value prompt is named Latitude, the definition is (Radians
(([Location_Lat] - ?Latitude)) / 2).

DeltaLong/2 (Radians (([Location_Long] -
?LongitudePromptName))/2)

Replace LongitudePromptName with the name of the value prompt for longitude.
For example, if the value prompt is named Longitude, the definition is (Radians
(([Location_Long] - ?Longitude)) / 2).

A ((Sin([DeltaLat/2]) * Sin([DeltaLat/2])) +
(((Cos(Radians(?Latitude)) * Cos(Radians
([Location_Lat]))) * Sin([DeltaLong/2])) * Sin
([DeltaLong/2])))

C (2 * [Atan2](Sqrt((1-A)), Sqrt(A)))

Point_
Distance

(3959 * C)

This value is based on the radius of the Earth, 3,959 miles or 6,371 km. To calculate
the distance between the stores and the mobile device using a different unit of
distance, replace 3959 with the radius of the Earth in the units you want to use to
measure distance. For example, to calculate distance in kilometers, the metric
definition is (6371 * C).

Using lines to display relationships between locations in a Map
widget

Once you create a Map widget for an iPhone or iPad, you can show relationships
between locations on the map when the widget is displayed on the device. To do this, you
display lines between the map markers. You can choose to display these lines using
different thicknesses or colors depending on the relationship between locations.
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Prerequisites

• The procedure assumes that you have created a Map widget. For more information
on the requirements for this widget, see Creating a Map widget, page 96.

• If you provided the location of each map marker in the Map widget using attribute
forms, the Latitude, Longitude, and ID attribute forms of the location attribute
should be displayed in the Map widget.

• If you provided the location of each map marker in the Map widget using attributes,
you must include the lookup attribute on the Map widget.

• You must create a Grid/Graph that is used to display lines in the widget. This
Grid/Graph includes the metrics used to determine the color and thickness of lines
between map markers, and attributes containing the IDs of the starting and ending
locations of each line. The IDs provided must correspond to the IDs used to identify
map marker locations in the Map widget. The steps to create this Grid/Graph are
below.

To display lines between map markers in a Map widget

1 Open the document in Design or Editable Mode.

To create the Grid/Graph for the relationships

2 From the Insert menu, select Grid/Graph.

3 Click the location on your document in which you want to place the Grid/Graph.
This Grid/Graph will not be visible when the widget is displayed on the device, and
should be in the same document section as the Map widget.

4 From the Dataset Objects panel on the left, select attributes and metrics, and drag
them on top of the Grid/Graph, as described below:

• You must place two attributes on the rows of the Grid/Graph, which must
provide the IDs of the starting and ending locations of each line in the widget.
The IDs provided must correspond to the ID forms in the attribute used to
identify map marker locations in the Map widget. Place the attributes as follows:

▫ The first attribute is the lookup attribute for the widget. It must contain a
single attribute form containing the ID of the starting location for each line.

▫ The second attribute must be a single attribute form containing the ID of the
ending location for each line.

• Place at least one metric on the Grid/Graph’s columns:

▫ The first metric automatically determines the thickness of each line
displayed in the widget, with thick lines representing large metric values. For
example, if airports are displayed in the Map widget, and the lines represent
flights between each airport, you can add the Passenger Count metric to the
Grid/Graph. When the widget is displayed on a mobile device, the flights
with the most passengers are displayed with thick lines, while flights with
less passengers are displayed with thin lines.
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To display each line using the same thickness, you can provide a metric
with a constant value.

▫ The second metric is used to determine the color of each line in the widget.
By default, each line in the widget is displayed using the default color. You
can override the default color by defining a threshold to change the font
color of the metric values that meet the threshold condition. For
information on creating thresholds, refer to theMicroStrategy Web Help.

If only one metric is placed on the columns, all lines will display using the
default color.

5 The ID attribute form of each attribute must be displayed in the Grid/Graph you just
created. If they are not displayed, for each attribute, right-click the header of the
attribute, point to Attribute Forms, then select the attribute forms you want to
display.

6 If you provided the location of each map marker in the Map widget using attributes,
you must include the lookup attribute on the Grid/Graph that you just created to
display lines between the map markers. Place the lookup attribute on the rows of the
Grid/Graph, directly before or directly after the attributes providing the latitude and
longitude of each map marker.

To enable the line display

7 Right-click the Map widget, then select Properties and Formatting. The
Properties and Formatting dialog box opens.

8 From the left, click Advanced.

9 Clear the Enable incremental fetch on grid check box, and click Apply.

10 From the left, selectWidget.

11 Click theWidget Properties icon . The Map Properties dialog box opens.

12 To enable the display of lines, select the Display Affinity Lines/Arcs check box.

13 If the Use Attribute or Form option is set to Use Attribute, from the Select Lookup
Attribute drop-down list, select the lookup attribute.

14 From the Select Affinity Data drop-down list, select the Grid/Graph that you
created above.

15 From the Draw Arcs/Lines drop-down list, select Arcs to display curved lines or
Lines to display straight lines.

16 From theMax Line Thickness drop-down list, select the maximum thickness that
can be used to display lines in the widget. The thickness of each line is automatically
determined based on the value of the first metric on the new Grid/Graph’s rows. The
default value is 5.

17 Click OK to return to the Properties and Formatting dialog box.

18 Click OK to save changes and return to the document.
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Visualizing trends: Microcharts widget
The Microcharts widget for iOS and Android devices lets users visualize trends in a
metric at a quick glance. Depending on the number of metrics used in the underlying
report, the Microcharts widget can display one, two, or three microcharts. For example,
bar and sparkline microcharts convey trends in a metric, and bullet microcharts compare
a metric’s actual value to its targets. An example of a Microcharts widget is shown below:

The Microcharts widget can be used in the following modes:

• Grid mode: This is the default setting. In this mode, all attributes except the last one
from the left are grouped and displayed as rows in the widget.

▫ You can display Grid mode in Tree mode, which groups the rows in the widget
logically. Users can collapse and expand the rows as needed to see more detailed
data. You must enable Tree mode for users to access it; steps are provided in the
Dashboards and Widgets Creation Guide.

▫ If the widget is displayed on an iPhone or iPad, users can sort the widget based
on a column in the widget. Users can sort the widget based on:

— Attribute elements or metric values

— Elements in a consolidation

— Attribute elements or metric values with thresholds applied

If your widget contains subtotals, you can control where the subtotals are
displayed when the widget is sorted. Edit the subtotals to display at the top or
bottom of each group. For steps, see the Document Creation Guide.

• KPI List mode: In this mode, key performance indicators (KPIs), such as Profit,
Revenue, and so on, are displayed in a list. Each KPI is represented by its own row of
microcharts.

Ticker mode and Vertical Scroll mode are not available for mobile devices.

You can also define Information Windows that display when the widget is tapped. For
instructions on creating an Information Window, see Providing additional information
to users: Information Windows, page 38.

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
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Creating a Microcharts widget

Prerequisites

In a document, create a Grid/Graph that meets the following minimum requirements:

• For a Microchart widget in Grid mode, the report must have at least two attributes in
the rows. The last attribute from the left is used as the X-axis for the bar graph and
sparkline microchart.

• For a Microchart widget in KPI List mode, the report must have only one attribute in
the rows.

• At least two metrics in the columns. The first metric from the left determines the
height of the bars for the bar microchart, and the peaks of the sparkline microchart.
The second metric displays a horizontal reference line for both microcharts.

For steps to create a Microcharts widget, and for more information on
creating Grid/Graphs that meet the data requirements for the Microcharts
widget, as well as variations of the widget based on the number of metrics
used, see the Dashboards and Widgets Creation Guide.

You can add objects from multiple datasets to the Grid/Graph containing the widget. You
must have the correct privileges and the project must allow Grid/Graphs to use multiple
datasets. For steps to allow Grid/Graphs to use multiple datasets, see the Adding Text
and Data chapter of the Document Creation Guide.

Displaying the Microcharts widget in KPI List mode

By default, if the Grid/Graph has only one attribute row, the Microcharts widget displays
in KPI List mode. To configure other properties of the widget, you must run the
document in Flash Mode in MicroStrategy Web, and then change the properties, as
described in the steps below.

You must determine how many of the metrics to use for each KPI. For example, if you
specify three metrics for each KPI, the first three metrics from the left are used for the
first KPI, the next three for the second, and so on.

To display the Microcharts widget in KPI List mode

1 In MicroStrategy Web, navigate to the document where you have defined the
Microcharts widget, and open it in Flash Mode. The document should open with the
Microcharts widget displayed.

2 Right-click the Microcharts widget, and select Properties. The Microcharts
properties dialog box opens.

3 From the drop-down list at the top left, chooseMode. If your widget has a single
attribute row, the KPI List Mode check box is enabled by default.

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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If the widget contains more than one attribute, the KPI List Mode check
box is disabled.

4 In theMetrics per KPI field, type the number of metrics to use for each KPI.

5 Click OK.

6 Click Save to save the document.

Enabling Smooth Scroll mode

You can enable Smooth Scroll mode to ensure that the metric columns displayed in the
widget on an iPad or Android with MicroStrategy Mobile have enough space.

In Smooth Scroll mode, if there is enough space on the mobile device to display all the
attribute columns in the widget plus at least one metric, the attribute columns are
allowed to take up as much space as they require. If space is limited, however, priority is
given to displaying the metrics in the widget, and attributes are displayed in the
remaining space. Users can perform a horizontal swipe gesture to view the metric
columns that cannot fit on a single page.

To enable Smooth Scroll mode for a Microcharts widget

1 In Flash Mode, right-click the widget and select Properties. The Microcharts dialog
box opens.

2 From the drop-down list, selectMode.

3 Select the Enable Smooth Scroll Mode for Metrics (Mobile Only) check
box.

4 From theMetric Column Spacing drop-down list, determine how to size and
display columns in the widget by selecting one of the following:

• To display columns as more compact in width, select Compact.

• To display columns using the default width, select Normal.

• To display columns as wider than the default, select Large.

5 Click OK to apply your changes.

Selecting a display theme for the widget

You can select a display theme to use to display the Microcharts widget on a mobile
device. Display themes are used only for widgets displayed on mobile devices, not for
widgets displayed in Flash Mode.
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To select a display theme for the Microcharts widget

1 In Flash Mode or Interactive Mode, right-click the widget and select Properties.
The Microcharts dialog box opens.

2 From the drop-down list, select Options.

3 From the Choose Theme drop-down list, select a color theme to use to display the
widget, as follows:

• To display the widget using a light-colored theme, select Light (default).

• To display the widget using a dark-colored theme, select Dark.

• To display the widget using custom color options that you define, select
Custom. The colors that you select for the widget in the Microcharts dialog box
will be used to display the widget on a mobile device.

4 Click OK to apply your changes.

Downloading and viewing multimedia files: Multimedia
widget
You can allow users to browse and view files in a web folder, such as documents, images,
and videos, using a Multimedia widget. When viewed on a mobile device, the Multimedia
widget displays a list of available files, along with information about each file, including
the file name, description, and file type. Users can tap the Download icon next to a file
displayed in the widget to download and view the file. When the mobile device is offline,
users can view files that have been downloaded and automatically stored on their mobile
device. Files that have not been stored on the mobile device are grayed out and cannot be
viewed offline.

Users can view the following types of files using the Multimedia widget:

• Audio and video files

• ePub files

• Excel

• HTML

• Image

• PDF

• Plain text

• PowerPoint

• Word

PDF files are displayed in-app using a native PDF reader.

Prerequisites
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Before creating a Multimedia widget, you must perform the following tasks:

• Create the document in which to insert the Multimedia widget.

• Configure an XQuery database instance to retrieve web folder contents. For steps to
configure this database instance, see the Custom SQL Queries: Freeform SQL and
Query Builder chapter in the Advanced Reporting Guide.

• Create an XQuery report to use to access the web folder that contains the files to
display in the widget. Add the XQuery report as a dataset report in the document.
For steps to create the XQuery report, see the Custom SQL Queries: Freeform SQL
and Query Builder chapter in the Advanced Reporting Guide.

To create and configure a Multimedia widget

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 From the Dataset Objects panel on the left, click and drag the dataset report to the
area of the document in which to display the widget. The attributes on the
Grid/Graph of the dataset report should be displayed in the following order:

• MW_URL

• MW_Name

• MW_ModifiedOn

• MW_ModifiedOnText

• MW_DBIGUID

• MW_ThumbnailURL

• MW_Description

3 Right-click the dataset report, then select Properties and Formatting. The
Properties and Formatting dialog box opens.

4 From the left, clickWidget.

5 From theWidget drop-down list, point toMobile, then selectMultimedia.

6 Click OK to save your changes and return to the document.

Visualizing relationships: Network widget
You can create a Network widget to allow analysts to quickly and easily identify
relationships between related items and clusters, such as when visualizing a social
network or displaying a market basket analysis. Attribute elements are displayed as nodes
in the visualization, with lines (called edges) drawn between the nodes to represent
relationships between elements. Once the visualization is created, users can view
characteristics of the nodes and the relationships between them, using display options
such as node size, edge thickness, and edge color.
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For steps to add a Network widget to a document and specify formatting options, see the
Dashboards and Widgets Creation Guide. You can also define Information Windows that
display when a node is tapped. For instructions on creating an Information Window, see
Providing additional information to users: Information Windows, page 38.

You can also use the Network visualization in dashboards. For information on creating
analyses, refer to the MicroStrategy Web Help.

Uploading images: Photo Uploader widget
Analysts can use the Photo Uploader widget to upload images from an iPhone, iPad, or
Android device. A user can choose to take a new photo to use as an image, use an
existing image on his mobile device, or delete images.

For example, you can add the Store attribute to the widget’s Grid/Graph, and then add a
prompt to the document to allow users to select a store. Users can run the document,
then select the store in which they are taking a picture with their mobile devices. When
the image is uploaded, the name of the store is stored in the user’s data source, along
with the description of the image and the location in which the image is stored. For steps
to create prompts, see Allowing users to filter data: prompts, page 56.

Prerequisites

• You must have Transaction Services.

• You must have the Web Configure Transaction privilege.

• This procedure assumes you have already created attributes and metrics to place on
the widget. The widget is used to store information about the images before they are
uploaded and must contain a placeholder row of data for each image you want to
upload. The data in these rows is updated when users upload images. The following
attributes and metrics must be created:

▫ One attribute that contains the following attribute forms:

— The first attribute form is the location in which each image is saved. The
values may be blank or placeholders, and are updated with new paths when
users upload images.

— The second attribute form contains a description of each image, as provided
by the user.

— The third attribute form (optional) contains a unique numeric ID of each
image that the user uploads.

Note the following:

• The number of placeholder rows in the widget determines the
maximum number of images users can upload. For example, if you
create a widget with 20 rows, users can upload a maximum of 20
images.

• To choose the attribute forms displayed for an attribute in the widget,
right-click the header of the attribute, point to Attribute Forms,
then select the attribute forms to display.

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
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▫ Two metrics, as follows:

— The first metric is used to indicate whether the image has been uploaded.

— The second metric (optional) contains the sum of the values in the first
metric, and is used to display the number of images the user has uploaded.

▫ You can provide additional information about an uploaded image by placing
additional attributes and metrics on the widget. For example, you can add the
Store attribute to the widget, and then add a prompt to the document to allow
users to select a store. Users can run the document, then select the store in
which they are taking a picture with their mobile devices. When the image is
uploaded, the name of the store is stored in the user’s data source, along with the
description of the image and the location in which the image is stored. For steps
to create prompts, see Allowing users to filter data: prompts, page 56.

▫ You can add objects from multiple datasets to the Grid/Graph containing the
widget. You must have the correct privileges and the project must allow
Grid/Graphs to use multiple datasets. For steps to allow Grid/Graphs to use
multiple datasets, see the Adding Text and Data chapter of the Document
Creation Guide.

• This procedure assumes you have created a Transaction Services report to link to the
widget. There must be an attribute form or metric displayed in the widget (described
above) for each input object in the Transaction Services report. For steps to create a
Transaction Services report, see the Advanced Reporting Guide.

To add a Photo Uploader widget to a document

1 Open the document in Design or Editable Mode.

2 From the Insert menu, point toWidgets, then point toMobile. Select Photo
Uploader.

3 Click in your document where you want to place the widget. A Grid/Graph
containing the widget is added to the document.

4 Optionally, resize the widget by clicking and then dragging its handles.

5 From the Dataset Objects panel on the left, select attributes and metrics, and drag
them on to the Grid/Graph, as described in the prerequisites above.

6 To specify the size and quality of images uploaded through the Photo Uploader, the
camera used to take images, and other properties, right-click the widget and select
Properties and Formatting, then click the gear icon next to Widget Properties.

You can specify the following options:

a The quality of the images that are uploaded. From the Image Quality drop-down
list, selectHigh,Medium, or Low (default).

b The size of the images uploaded. From the Image Size drop-down list, select
Small,Medium (default), Large, or Actual.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/AdvancedReportingGuide/WebHelp/Lang_1033/index.htm
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c Whether users can upload multiple images at one time. From the Allow Multiple
Photos drop-down list, select Yes (default) or No.

d Whether users can use photos already stored on their mobile device. From the
Allow Existing Pictures drop-down list, select Yes (default) or No.

e The camera used to take photos by default. Users can still switch between the
cameras. From the Default Camera drop-down list, select Back (default) or
Front.

7 To link the widget to the Transaction Services report, right-click the widget’s
Grid/Graph, then select Configure Transaction. The Configure Transactions
dialog box opens.

8 Click … (the Browse button), then navigate to and select the Transaction Services
report to link to.

9 A list of the attributes and metrics that can be modified in the Transaction Services
report is displayed in the Transaction Input column. Perform the following steps for
each input object:

a From the Grid Object drop-down list, select the attribute form or metric to
link to the input object.

b You can choose whether users can edit the value of each input object. Do one of
the following:

— To allow users to edit the value of the input object, select the Editable
check box.

— To prevent users from editing the value of the input object, clear the
Editable check box.

You must define the first metric on the columns of the widget to be
editable. This metric indicates whether the image has been uploaded.

c From the Transaction Input drop-down list, choose a control to display the
input as, such as a text box, slider, and so on.

10 Repeat the appropriate steps above to define and format the control to display for
each input object.

11 Click OK to save your changes and return to the document.

12 To create a button for users to submit a photo, from the Insert menu, point to
Selector, then select Action Selector Button.

13 Click the section of the Layout area in which you want to place the selector. Right-
click the selector, then select Properties and Formatting. The Properties and
Formatting dialog box opens.

14 From the left, click General, then in the Display Text field, type the text you want
to display on the button or link; for example, Submit.

15 By default, a descriptive title bar is displayed for the selector. You can determine
whether to display the title bar. Do one of the following:
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• To display the title bar, select the Show Title Bar check box and type the title
you want to display in the field.

• To display the selector button or link without the title bar, clear the Show Title
Bar check box.

16 From the left, click Selector. From the Action Type drop-down list, select
Submit.

17 By default, the selector button or link targets each Grid/Graph and panel stack in the
document section in which it is placed. You can choose the targets of the selector
manually instead. To do so, click Click here, then use the right arrow to move the
target Grid/Graph or panel stack from the Available list to the Selected list. For
additional information on working with selectors, see the MicroStrategy Web Help.

18 Select the appropriate options to define the selector. For the full steps to define an
action selector button, see the Document Creation Guide.

19 Click OK to save your changes and return to the document.

Displaying RSS feeds: RSS Reader widget
You can provide an RSS feed on the iPhone and iPad. RSS (Rich Site Summary, or Really
Simple Syndication) is a data format used to display updated content from a website. An
RSS document is called a feed. It contains either a summary of the content from an
associated website or the full text.

The RSS Reader widget allows users to compare data in the dashboard with information
from external news feed sources. The widget retrieves news from an RSS news feed and
displays it alongside the other components of the dashboard. The RSS feed is
automatically reloaded to display the most up-to-date news about a variety of topics that
you specify.

You can add an RSS Reader widget to a document, then display the widget when the
document is viewed on a mobile device, as shown in the image above. Users can select an
RSS feed to display a list of news items, then select an item to display from the list. For
steps to create an RSS Reader widget and add it to a document, see the Dashboards and
Widgets Creation Guide.

https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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Formatting an RSS Reader widget for mobile devices

You can format how the widget is displayed when viewed on the mobile device. For
example, you can change the color in which the titles of RSS feeds are displayed, or the
background color used for news items that are selected in the widget.

The table below suggests formatting ideas and provides steps to format how an RSS
Reader widget is displayed on the mobile device.

What to
Format in
the Widget

How to Format It

Specify
the URL of
the RSS
feed to
display in
the widget

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theGeneral tab, type the URL of the RSS feed in theDefault RSS Field. To specifymultiple
URLs, type ??between each URL. For example:

http://www.businessweek.com/rss/bwdaily.rss??http://news.google.com/news?ned=us&topic=h&o
utput=rss

3 ClickOK to apply your changes.

Specify
the title of
the RSS
feed
displayed
in the
widget

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theGeneral tab, type the title of the RSS feed in theRSS Reader Title field. To specify titles for
multiple RSS feeds, type ??between each title. For example, you can type Business??World News to
create two RSS feeds, one named Business and the other named World News.

3 ClickOK to apply your changes.

Select the
color in
which the
titles of
RSS feeds
are
displayed

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theGeneral tab, select a color from theRSS Reader Title Color palette.

3 ClickOK to apply your changes.

Select the
backgroun
d color of
the widget

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theGeneral tab, select a color from the Background Color palette.

3 ClickOK to apply your changes.

Select the
color of
the
widget’s
border

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theGeneral tab, select a color from the Border Color palette.

3 ClickOK to apply your changes.

Select the
backgroun
d color to
use to
display
news
items in
the widget

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theNewsItem tab, selectColors from the first drop-down list.

3 SelectBackground from the second drop-down list.

4 Select a color from the Background color palette.

5 ClickOK to apply your changes.
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What to
Format in
the Widget

How to Format It

Select the
backgroun
d color
displayed
for news
items
when a
cursor
hovers
over the
item in the
widget

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theNewsItem tab, selectColors from the first drop-down list.

3 SelectRollover Background from the second drop-down list.

4 Select a color from theRollover Background color palette.

5 ClickOK to apply your changes.

Select the
font color
to use to
display
news
items in
the widget

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theNewsItem tab, selectColors from the first drop-down list.

3 SelectFont from the second drop-down list.

4 Select a color from the Font Color palette.

5 ClickOK to apply your changes.

Select the
font color
to use to
display
news
items
when a
cursor
hovers
over the
item in the
widget

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theNewsItem tab, selectColors from the first drop-down list.

3 SelectRollover Font from the second drop-down list.

4 Select a color from theRollover Font Color palette.

5 ClickOK to apply your changes.

Select the
font color
to use for
news
items that
have been
read

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theNewsItem tab, selectColors from the first drop-down list.

3 SelectRead Articles from the second drop-down list.

4 Select a color from theRead Articles color palette.

5 ClickOK to apply your changes.

Select the
backgroun
d color to
use to
display
news
items that
are
selected
in the
widget

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theNewsDetail tab, select a color from the Background Color palette.

3 ClickOK to apply your changes.
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What to
Format in
the Widget

How to Format It

Select the
font color
to use to
display
news
items that
are
selected
in the
widget

1 In Flash Mode, right-click the widget and selectProperties. The RSS Reader dialog box opens.

2 On theNewsDetail tab, select a color from the Font Color palette.

3 ClickOK to apply your changes.

Gathering data from users: Survey widget
The Survey widget allows an analyst to interact with a survey on an iPad and submit
answers, which are then stored in your data source. You can create a survey in a database
or on a third-party survey creation website, then display your survey in a Transaction
Services-enabled document on an iPad.

The Survey widget provides an easy way to dynamically generate and maintain surveys. If
you want to modify the survey after its creation (for example, by adding or editing survey
questions), you can update the survey information provided by the attributes and metrics
placed on the widget’s grid. These changes will automatically be reflected and displayed
in the widget, without requiring any additional configuration changes to the widget in
the document.



Mobile Design and Administration Guide

© 2017, MicroStrategy Inc. 120

You can add a Survey widget to a document, then display the widget when the document
is viewed on a mobile device, as shown in the image above.

A Survey widget displayed on an iPad can contain the following question types:

Question
Type

Description

Text
field

A field consisting of one line in which users can enter text. Text fields are suited for
questions in which users provide a single line of text, such as an email address.

Text
area

A field in which users can type multiple lines of text. Text areas are suited for
comments sections in which users provide multiple lines of written content.

Radio
button

A list of radio buttons, displayed in a table. Users can select one radio button at a
time.

Check
box

A list of check boxes, displayed in a table. Users can select more than one check
box at the same time.

Drop-
down
list

A list of options, displayed in a table. Users can select one option from the drop-
down list at a time.
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Question
Type

Description

Likert
scale

A series of radio buttons, displayed in a table, that users can choose from to rate
an item on a numeric scale. For example, users can choose 1 to strongly disagree
with a statement, or 5 to strongly agree.

Drag
and
drop
ranking

A list containing options that users can click and drag to rank them from highest to
lowest.

Star
ranking

A row of stars that users can use to submit a specific star rating out of five stars
(such as four out of five stars).

Group
question

When you display questions in a question group or table, you specify which
question is treated as the main question. The main question is displayed as a
header above the rest of the questions.

In the example above, the second question is displayed as a table of choices. The iPad
displays the text “Required” for required questions (as shown for First Name in the
example). For steps to create a Survey widget and add it to a document, including
descriptions of the question types, see the Dashboards and Widgets Creation Guide.

Displaying a Timeline widget
The Timeline widget allows analysts using an iPad to view events or important milestones
in the status of a product. For example, the image below shows a Timeline widget for a
company that leases commercial jets to different airlines.

Each line represents a different commercial jet. An icon is displayed to mark events in
the jet’s lifetime, such as a new lease, a lease expiring, a new purchase, and so on. The
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metric values on the right are the key performance indicators (KPIs) for each jet, and the
values at the bottom are the KPIs for each year.

Creating and adding a Timeline widget to a report or document

The following are instructions to define a Timeline widget for display on a mobile device.
You can also define Information Windows for the widget, which can display additional
information when users tap a section of the timeline. You can define a link in the widget
to open a report or another document. For steps to define a link in a widget using the
Links Editor, see the Providing Flash Analysis and Interactivity: Widgets chapter in the
Dashboards and Widgets Creation Guide.

Prerequisites

• You must have a total of three datasets for the Timeline widget, which contain data
as follows:

▫ A main dataset, which must have the following objects:

— One attribute on the rows. Each attribute element is shown as a row on the
Timeline widget. In the example above, the Asset attribute is placed on the
rows.

— The Year and Quarter attributes, in that order, on the columns.

— One metric for Status, with codes for the asset’s status, such as leased, sold,
and so on. This metric determines the color of the timeline for a particular
status. You can define the colors using thresholds on the Status metric.

— One metric for Event, with codes for events in the asset’s timeline. You can
define the appearance of the event marker by defining a threshold on the
Event metric.

— Optionally, one metric for the count of events for each asset, which contains
the number of events that have occurred in a given quarter. If this value is
greater than 1 for a specific quarter, a number badge for the quarter is
displayed in the widget in place of an event icon. This number badge
contains the number of events that affected the asset during the quarter.

▫ A dataset that relates the asset to the KPI metrics. The metrics are displayed on
the right side of the widget. The dataset must contain the following objects:

— On the rows, the attribute for which timelines are displayed. In the example
above, this is the Asset attribute.

— On the columns, the metrics for the KPIs.

▫ A dataset that relates the Year to the KPI metrics. The metrics are displayed at
the bottom of the widget. The dataset must contain the following objects:

— On the rows, the Year attribute.

— On the columns, the metrics for the KPIs.
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To create and configure the Timeline widget for mobile devices

1 In Web, open the document in Design or Editable Mode.

2 From the Insert menu, point toWidgets, thenMobile, and select Timeline.

3 Click the location on your document where you want to place the widget. The
Grid/Graph containing the widget is displayed.

4 Optionally, resize the widget by clicking and then dragging its handles.

To define the grid for the main dataset

5 From the Dataset Objects panel on the left, place the objects from the main
dataset on to the widget. The requirements for these objects are described in the
prerequisites above.

6 To color-code the line for each asset in the widget based on the asset’s status, you
must define a threshold on the status metric to change the color in which metric
values are displayed, as described below:

a Right-click the widget, then point to Thresholds, and select Visual. The
Visual Threshold Editor opens.

b Select the appropriate options to define your threshold. For detailed steps to
define a threshold, see the Formatting a Report chapter in the Basic Reporting
Guide.

7 To display an image icon when an event occurs to an asset in the widget, you must
define a threshold on the event metric to replace metric values with the image you
want to display, as described below.

a Right-click the widget, then point to Thresholds, and select Visual. The
Visual Threshold Editor opens.

b Select the appropriate options to define your threshold. For detailed steps to
define a threshold, see the Formatting a Report chapter in the Basic Reporting
Guide.

To define the grid for displaying metrics by asset

8 From the Insert menu, select Grid, then click the area in the Layout area in which
you want to place the grid.

This grid will not be visible when the widget is displayed.

9 From the Dataset Objects panel, drag the objects from the second dataset, which
relates the assets to metrics, on to the grid.
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To define the grid for displaying metrics by year

10 From the Insert menu, select Grid, then click the area in the Layout area in which
you want to place the grid.

This grid will not be visible when the widget is displayed.

11 From the Dataset Objects panel, drag the objects from the third dataset, which
relates the year to metrics, on to the grid.

To configure the widget

12 Right-click the Timeline widget, then select Properties and Formatting. The
Properties and Formatting dialog box opens.

13 On the left, clickWidget.

14 In the Available list under Secondary Data Providers, select the grid with the asset
attribute, then click > to move it to the Selected list. Select the grid with the Year
attribute and click > to move it to the Selected list.

15 Click theWidget Properties icon . The Timeline Properties dialog box opens.

16 You can choose the starting point from which to display data in the timeline when
the widget is displayed. From the Initial column display properties drop-down
list, select one of the following:

• To display data in the timeline starting with the most recent dates available,
select Right Justified.

• To display data in the timeline starting with the earliest dates available, select
Left Justified.

17 You can determine whether to show labels for each quarter displayed in the timeline.
Do one of the following:

• To show the labels for each quarter, select the Show labels check box.

• To display the timeline without labeling each quarter, clear the Show labels
check box.

18 Click OK to save your changes and return to the Properties and Formatting dialog
box.

19 Click OK to save your changes.

Displaying additional information: Information Windows

You can define Information Windows, which are pop-up windows that display additional
information when the user taps an area in the widget when the widget is displayed on
the mobile device. To do so, you must first define a panel stack containing the
information you want to display, then define specific attributes as selectors targeting the
panel stack, as follows:
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• To display an Information Window when the user taps a section of the timeline for a
specific asset and quarter, you must define the Asset, Year, and Quarter attributes on
the Timeline widget as selectors targeting the panel stack.

• To display an Information Window when the user taps the name of an asset in the
widget, you must define the Asset attribute in the grid containing the metrics to be
displayed by Asset (the second Grid/Graph you added to the document) as a selector
targeting the panel stack.

For detailed steps to create Information Windows, see Providing additional information
to users: Information Windows, page 38.

Displaying data trends: Time Series widget
The Time Series widget displays data over a specific period of time on an iPhone, iPad, or
Android device. This widget is displayed as a line graph on the device. You can configure
the widget to display multiple data series on the same graph. An example of a Time Series
widget on an iPhone is shown below.

You can configure the Time Series widget to provide data across multiple time intervals.
For example, in the image above, data is displayed for a one-month time period.
However, the widget can also display data for one year, several years, or for the entire
time period. You can add intervals to a widget by configuring the widget’s properties.

The number of data points displayed in a Time Series widget is determined by the
maximum number of rows displayed in the grid on which it is based. For steps to change
the number of data points displayed in a Time Series widget in a document, see To
determine the maximum number of data points displayed in a document, page 128.

For iPhones and iPads, you can define:

• Information Windows that display when the widget is tapped. For instructions on
creating an Information Window, see Providing additional information to users:
Information Windows, page 38.
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• A link in the widget to open a report or another document. For steps to define a link
in a widget using the Links Editor, see the Providing Flash Analysis and
Interactivity: Widgets chapter in the Dashboards and Widgets Creation Guide.

Prerequisites

For a Grid/Graph to be used as a Time Series widget, it must meet the following
requirements:

• At least one attribute on the rows. The attribute provides the values along the
horizontal axis of the widget, and should be time-based.

• At least one metric on the columns. The metric values are graphed in the widget.

• To view data for multiple series, place at least one attribute on the columns. The
attribute elements are graphed on the widget’s axis.

• Ensure that the row and column headers of the report are not merged.

You can add objects from multiple datasets to the Grid/Graph containing the widget. You
must have the correct privileges and the project must allow Grid/Graphs to use multiple
datasets. For steps to allow Grid/Graphs to use multiple datasets, see the Adding Text
and Data chapter of the Document Creation Guide.

To create and add a Time Series widget to a document

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 From the Insert menu, point toWidgets, thenMobile, and select Time Series.

3 Click the location on your document where you want to place the widget. The
Grid/Graph containing the widget is displayed.

4 Optionally, resize the widget by clicking and then dragging its handles.

5 From the Dataset Objects panel on the left, select attributes and metrics, and drag
them on top of the widget, as described in the prerequisites above.

Android devices can only display up to two metrics in a Time Series widget.

To configure the widget’s display properties

6 Right-click the widget, then select Properties and Formatting. The Properties
and Formatting dialog box opens.

7 From the left, selectWidget.

8 Click theWidget Properties icon . The Time Series Properties dialog box

opens.
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To add an interval selector to the widget

Interval selectors let users select the time period for which they want to view data in
the widget, allowing them to analyze data at different levels of detail. You can add,
rearrange, or delete interval selectors in a Time Series widget, as described below.

9 To add an interval selector, complete the following steps:

a Click Add. The new selector is added and displayed.

b Type a name for the selector in the Name field.

c From the Template drop-down list, select the control in the document that
contains the time-based attribute you want to use to create the interval selector.
The granularity is automatically determined by the last (right-most) attribute on
the Grid/Graph's rows, as described above.

d From the Interval unit drop-down list, select the units in which you want to
specify the length of the time interval. For example, to define a six-month
interval, you can selectMonth as the interval unit.

e Type the number of units you want to include in the interval in the Interval
size field. For example, if the Interval unit is defined asMonth, you can type 6
to specify a six-month time interval.

f A summary of the interval selector's properties is displayed in the bottom pane.
Repeat the appropriate steps above to add additional interval selectors.

10 You can rearrange the order in which an interval selector is displayed. ClickMove
up orMove down to change the position of the selector.

11 To delete an interval selector, select the interval selector’s name in the Interval
Selector list to the left, then click Remove. The interval selector is removed.

To use the slider as a selector

12 You can use the slider to filter the data in your dashboard, so that only the data
selected in the slider is displayed. Select the Use slider as selector check box.

To format colors, labels, and the axis scale

13 Click the Formatting tab.

14 To change the background color of the widget, select a color from the Background
palette.

15 To change the color of the text and lines, select a color from the Line and Text
palette.

16 The color of each series is displayed in the Series palettes. To change the color of a
series, select a color from the corresponding palette.

17 From the Background transparency drop-down list, select a level of
transparency. The higher the percentage, the more transparent the background is.
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18 By default, axis labels are condensed, which means the widget allocates more space
to the chart area than to the labels. You can change this behavior by clearing the
Condense labels check box.

19 You can specify the minimum and maximum values of the axis, by completing the
following steps:

a Select the Custom axis scale check box.

b Type theMaximum axis value.

c Type theMinimum axis value.

20 Click OK to return to the Properties and Formatting dialog box.

21 Click OK again to save changes.

To determine the maximum number of data points displayed in a
document

Increasing the number of rows that can be displayed in a grid may affect
performance when the document is displayed.

1 Open the document containing the widget in Design or Editable Mode.

2 Right-click the widget’s Grid/Graph and select Properties and Formatting. The
Properties and Formatting dialog box opens.

3 From the left, select Grid.

4 Select the Enable incremental fetch in Grid check box.

5 From the Count By drop-down list, select Individual Rows.

6 Type the maximum number of data points to display in the widget in theMaximum
number of rows per page field.

7 Click OK to save changes.

Downloading and playing videos: Video Player widget
On an iPhone or iPad, the Video Player widget loads and plays a video from a remote
location or from the local cache. The widget can display:

• An online video from a streaming service such as YouTube.

• An online video from a file server location.

• A cached video from the WebDAV cache, in offline mode. The WebDAV cache can
be populated by a manual download request.

If the mobile device is online, the Video Player widget loads the video from the remote
location, unless a local cache already exists on the device’s WebDAV cache store. Caching
should be set up whenever possible.
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When a user requests a video:

1 The widget checks for a local copy stored on the device, regardless of whether the
device is connected. If a cached file is used, the widget can start playing the video
without loading the full file into memory.

2 If the video is not yet cached, then the widget requests the video from the source.
The video can be a streaming video, such as a YouTube video, or a full video
download file served by a web server.

• A streaming video is buffered and played as it downloads. By default, the
downloaded video file is discarded when the MicroStrategy Mobile application is
closed. You can ensure that the video is downloaded and stored on the mobile
device for offline use. For steps, see Pre-caching online content on the mobile
device for offline use, page 211.

• A file download video is downloaded fully to the client. Once the video is fully
downloaded, the video can be played. You can pre-cache the video to download
the video before the user requests it. This allows a faster response time when the
video is requested. For steps, see Pre-caching online content on the mobile
device for offline use, page 211.

The video is saved to the WebDAV Content Manager cache store so that it can be
shared by other instances of the Video Player widget or the Multimedia widget.
The video source URL is used as the key of the cache so it can be matched by
other requests to the same video.

You can configure the Video Player widget to use one source for online live requests that
are initiated by the user, and a second source for a full file that can be downloaded and
cached by a manual download request. For example, the live source can be set to a
YouTube location while the offline cache source points to a URL that serves the full
video file.

In a different scenario, such as a company that hosts its videos on its own servers, both
sources can use the same URL. For the live request, the device directly accesses the video
from the hosting web server, if a matching cache is not found on the local cache.

For steps to configure a WebDAV folder, see the Advanced Reporting Guide.

To create and add a Video Player widget to a document

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 From the Insert menu, point toWidgets, thenMobile, and select Video Player.

3 Click the location on your document where you want to place the widget.

4 Optionally, resize the widget by clicking and then dragging its handles.

5 Right-click the widget, then select Properties and Formatting. The Properties
and Formatting dialog box opens.

6 From the left, selectWidget.
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7 Click theWidget Properties icon . The Video Player Properties dialog box

opens.

8 Do one of the following to define the video’s source:

• To stream the video:

a Select Video streaming.

b The Embed video HTML field is used for online live requests initiated by
users. Type or copy the HTML needed to embed the video in a site. For
example, the HTML for a MicroStrategy Express demo on YouTube is:

<iframe width="560" height="315"
src="//www.youtube.com/embed/AH4Z9fEybF8"
frameborder="0" allowfullscreen></iframe>

c The Alternate download URL is a cache source that serves the full video
file. Type the URL in the field.

• To download the video:

a Select Video download.

b Type the Video URL.

9 To display a thumbnail for the video, type the Video thumbnail URL.

If the video is streamed but an alternate URL is not provided, the Video
thumbnail URL field is not available.

10 Click OK to return to the Properties and Formatting dialog box.

11 Click OK to save changes.

Displaying widgets using the entire screen on
mobile devices

By default, when you add a widget to a layout in a document, the widget is sized to take
up the entire screen when displayed on an iPhone or Android device. Any additional
grids, graphs, or widgets you add to the layout are not displayed. You can choose to
display the widget without taking up the entire screen, and allow the display of other
grids, graphs, or widgets together in the layout.

To determine whether to display a widget using the entire screen on a
mobile device

1 Open the document in Design or Editable Mode.



Mobile Design and Administration Guide

131 © 2017, MicroStrategy Inc.

2 Right-click the Grid/Graph containing the widget and select Properties and
Formatting. The Properties and Formatting dialog box is displayed.

3 From the left, selectWidget. Do one of the following:

• To size the widget to fit the entire screen, select the Full Screen check box.

• To display the widget without taking up the entire screen, and allow the display
of other grids, graphs, or widgets in the layout, clear the Full Screen check
box.

Displaying widgets on iOS devices with a dark
or light theme

On the iPad and iPhone, you can display widgets using a dark or light theme. To do this,
change the theme of the document containing the widget. In the image below, the date
selection widget on the left uses the dark theme, while the date selection widget on the
right uses the light theme.

You can change the theme for the following widgets:

• Map

• Heat Map

• Time Series

• Date Selection

• Survey

• Microchart

For steps to change a document’s theme, see Displaying documents on iOS devices with
a dark or light theme, page 33.



4
USING LINKS IN DOCUMENTS

You can create the experience of navigating through a native app by adding links between
documents. Each document becomes a page or panel in your app, which a user can
access from, for example, a button or tab bar.

You can also create links that perform actions or open other applications. For example, a
document designer can include a link that dials a store phone number. The following
topics are covered:

• Opening a device’s installed applications from documents, page 132. You can use
links that interact with applications installed with mobile devices, such as email or
text messaging.

• Linking to reports and documents from a mobile document, page 138. A link lets
the user execute another document or report (the target) from a document (the
source). Parameters can be passed to answer any prompts or set any selectors that
are in the target.

• Using links to access features within the MicroStrategy Mobile application, page
150. You can use links in a document to access specific features within the
MicroStrategy Mobile application for iPhone or iPad. Examples are viewing a folder
and emailing a screenshot of the document.

• Linking from documents with buttons and tab bars, page 152. A button can send a
user to the various screens, such as the Home screen or the Report List, on an iPad,
iPhone, or Android device. A button can open a web page, or run a report or
document. You can add a single button to a dashboard, multiple buttons with
different formatting in different locations on the dashboard, or a bar of buttons that
are all formatted the same, called a tab bar.

• Storing links on NFC tags on Android devices, page 160. You can store a link on
Near Field Communications (NFC) tags to open a report, document, or folder on an
Android device.

Opening a device’s installed applications from
documents

A document displayed on an iPhone, iPad or Android device can interact with the
applications that are installed with the device. For example, a document can send
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addresses to maps for directions or open a video. These applications include:

• Web browser

• Email

• Phone (applicable to mobile phones only)

• SMS (applicable to mobile phones only)

• Maps

• Videos

To allow users to open an external application in a document, you must create a
hyperlink. The hyperlink connects a text field or an image to a web page or application
(the target). When the document is viewed on a device, the user can click the control to
navigate to the target.

For example, you create a document for the regional managers for a chain of stores. This
document contains information about each of the stores in the manager’s region, as
shown in the image below.

The information includes the store’s address, phone number, the store manager’s email
address, its inventory figures, and so on. When regional managers view this document on
their iPhones, they can:

• View a map of the store’s location and get directions from their current location

• Email the store manager

• Call the store
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To create a link with a larger area that is easier to select, you can define a link that
includes both the text and the area around it, or create an image button that users can
select. To do this, you can:

• Create an image to use as the button and add a link to it.

• Insert a transparent image into the document, then enlarge and/or position it to
cover the desired link area. Link the transparent image to the target. The user can
then tap any area covered by the image to open the link. A sample transparent image
is located by default in
C:\Program Files\MicroStrategy\Intelligence Server\
images\1ptrans.gif.

When you create a hyperlink to open an external application, you must use the syntax
outlined in the table below. Two examples are included for each type of hyperlink. The
first example replaces the italicized variables in the syntax with specific, static text, while
the second replaces it with an attribute, so that the hyperlink can change according to
the data in your document.

To... Use This Syntax....

Email <a href="mailto:EmailAddress">Name</a>

Examples:

<a href="mailto:jdoe@example.com">John Doe</a>

<a href="mailto:{StoreMgrEmail}">{StoreMgr}</a>
where StoreMgrEmail and StoreMgr are attributes

<a href="mailto:{Store@StoreMgrEmail}">
{Store@StoreMgr}</a>
where StoreMgrEmail and StoreMgr are attribute forms of the Store attribute

Email with a s
ubject

<a href=”mailto:EmailAddress?cc=EmailAddress&subject
=SubjectLine&body=Message”>Text</a>

Example:

<a
href=”mailto:jdoe@example.com?cc=msmith@example.com&subjec
t
=Greetings%20from%20MicroStrategy!
&body=I%20have%20reviewed%20your%20store’s%20sales%20resul
ts%20and%20have
”%20the%20following%20feedback%20for%20you:>Contact John
Doe</a>

Call
(applicable to
mobile
phones only)

<a href="tel:PhoneNumber">PhoneNumber</a>

Examples:

<a href="tel:1-555-555-5555">1-555-555-5555</a>

<a href="tel:{StorePhone}">{StorePhone}</a> where StorePhone is
an attribute
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To... Use This Syntax....

Use SMS links
(applicable to
mobile
phones only)

<a href="sms:SMSNumber">Text</a>

Examples:

<a href="sms:1-555-555-5555">I’ll be there soon</a>

<a href="sms:{MgrPhone}">New Message</a> where MgrPhone is an
attribute

Pass location
to Google
Maps

<a href="http://maps.google.com/maps?q=City">City</a>

Examples:

<a
href="http://maps.google.com/maps?q=Chicago">Chicago</a>

<a href="http://maps.google.com/maps?q={CustomerCity}">
{CustomerCity}</a>
where CustomerCity is an attribute

<a href=“geo:38.915645,-77.220796”>MicroStrategy HQ</a>,
where the numbers in the link are the latitude and longitude respectively.

For links to maps.google.com on Android devices, you may be asked to
choose
whether to open the link using your default browser, or using Maps.

Get directions
from Google
Maps

<a
href="http://maps.google.com/maps?daddr=
Destination&saddr=Start
">Text</a>

Examples:

<a href="http://maps.google.com/maps?daddr=Washington+,DC
&saddr=Chicago">Directions</a>

<a href="http://maps.google.com/maps?daddr=
{CustomerAddress}
&saddr={StoreAddress}">Directions from {StoreName} to
{CustomerName} location</a>
where CustomerAddress, StoreAddress, StoreName, CustomerName are attributes

Open a video Example:

<a href="http://phobos.apple.com/WebObjects/MZStore.woa
/wa/viewAlbum?i=?id=375385132"> <img height="15"
width="61"
src="http://ax.phobos.apple.com.edgesuite.net/images/badge
itunes61x15dark.gif"
alt="Tech News Today"></img> </a>
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To... Use This Syntax....

Display a web
page in the
internal web
browser (iPad)

By default,
web pages
open in Safari

WebPageURL?inApp=1

Replace WebPageURL with the URL of the web page you want to display in the
internal web browser.
If the URL contains a ? (question mark) followed by a list of parameters,
such as
http://news.google.com/news?ned=us&topic=h&output=rss,
type & (ampersand) followed by inApp=1. For example,
http://news.google.com/news?ned=us&topic=h&output=rss&inAp
p=1.

Otherwise, the URL of the web page you want to display must end with a /
(forward slash), followed by ?inApp=1. For example, to link to the Google web
page,
the URL is http://www.google.com/?inApp=1.

You use the hyperlink properties to define links to the device’s applications, as described
below.

To create a hyperlink to an application on the device

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 To use a text field for the hyperlink, complete the following steps (see the next step
for instructions to add an image instead):

a From the Insert menu, select Text.

b Click in the section of the document where you want to place the text field. If
you click and drag in the section, you can size the text field.

To ensure that the area of a link is large enough to recognize a user selecting
it, make sure it has a height and width of at least 40 pixels.

c Type the text to be displayed to users into the text field. You can add static text,
dynamic text (in the form of data fields and auto text codes), or a combination to
the text field:

• To add static text, type the static text into the text field.

• To add a data field, drag and drop a dataset object from the Dataset Objects
panel into the text field.

• To add an auto text code, from the Insert menu, select Auto-text, then select
the code to insert.

For background information about adding text to documents, see the Report
Services Document Creation Guide.

3 To use an image for the hyperlink, complete the following steps:
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a From the Insert menu, select Image.

b Click in the section of the document where you want to place the image. If you
click and drag in the section, you can size the image. The Properties and
Formatting dialog box opens.

To ensure that the area of a link is large enough to recognize a user selecting
it, make sure it has a height and width of at least 40 pixels.

c Type the address of the image file to insert in the Source field. Navigate to and
select the image file to insert in the document.

d Click OK. The image appears in the document.

For background information about adding images to documents, especially to
ensure that the image is available as needed, see the Document Creation
Guide.

4 Right-click the text field or image that you just added, and select Properties and
Formatting. The Properties and Formatting dialog box opens.

5 From the left, click General, then select the Is hyperlink check box.

6 In theHyperlink field, delete the “http://” text that is automatically filled in.
Following the syntax in the table on click here, type the hyperlink into the
Hyperlink field. You can type static text, dynamic text (in the form of data fields
and text codes), or a combination, as described below:

• To add static text, type the static text into the text field.

• To add a data field (that is, an object from a dataset report), type the object’s
name within braces, such as {Revenue} or {Region}. The name must match
either the name of an object in a dataset or its alias. If either name contains
spaces or special characters, you must type it in square brackets [ ] within the
braces; for example, {[Manager Name]}.

A special character is any character other than a - z, A - Z, 0 - 9, #, _, and
. (period).

• To add an auto text code (that is, document and dataset report information), type
the code within braces. As with data fields, if an object’s name contains spaces or
special characters, enclose it in square brackets within the braces. For
background information about available auto text codes, see the Document
Creation Guide.

7 Click OK to return to the document. Notice that the text field is now underlined,
indicating that it is a hyperlink.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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Linking to reports and documents from a mobile
document

A link is a connection in a document to another document or a report. A link lets a user
execute another document or report (the target) from a document (the source), and to
pass parameters to answer any prompts that are in the target. You can link from a text
field, an image, or a button.

For example, if a user is viewing a document containing regional sales, he can select a
particular region to execute another document that displays sales for the stores in that
region. This is a form of drilling, where the user has drilled from region to store. If the
document contains a selector, the user can select a specific region in the selector, then
tap a link to another document that displays sales for the months in that year. The
source document could also link to the underlying dataset report, to display profit and
cost values as well.

Most links can be created using the Link Editor. If you want to specify the page-by or
report view (grid or graph) of a report, or specify the layout or grouping of a document,
use the hyperlink properties and create the link URLs manually, by using the object ID
and link syntax. For steps to create links using the Link Editor, see Creating a link for a
mobile document, page 139. For steps to create links using manual URLs, see Creating a
link URL to specify page-by, report view, layout, or grouping for the target, page 145.

Links you can create for iOS devices
You can use links to do the following on an iPhone or iPad:

• Execute a report, specifying the page-by, prompt answers, and report view (grid,
graph, or both grid and graph).

• Execute a document, specifying the layout, grouping, prompt answers, and selector
values.

▫ A multi-layout document contains multiple documents, each in its own layout,
creating a “book” of documents. Each layout functions as a separate document,
with its own grouping, page setup, and so on, but the layouts are generated into a
single PDF document.

▫ Grouping a document helps users understand the data better. Grouping the data
sets up a type of hierarchy within the document, and an inherent or implied sort
order for the data.

You can change the grouping or layout for the currently displayed document,
or for a target document. If you change the grouping or layout for the
currently displayed document, you still must use the entire link URL, including
the document ID, event parameter, and so on.

• Reprompt a report or document.

• Display the Home screen, Shared Library, Report List, Settings screen, Status screen,
or Help screen.
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Links you can create for Android devices
You can use links to do the following on an Android device:

• Execute a report, specifying whether it is displayed as a grid, a graph, or both a grid
and graph

• Execute a document

• Run a report or document from a different project or server

Creating a link for a mobile document
Prerequisites

• The source document and any target reports/documents must be created.

• If the target report/document contains prompts, you must know what types of
prompts the targets require and how they will be answered by the link (or by the
user). For details on each prompt answer method, see Specifying how prompts are
answered in the target, page 143.

• If you want to pass selector values from the source document to the target
document, both the source and the target must contain the same selector. This
means that either both documents must contain a selector with the same name
(such as Region Selector), or both documents must contain a selector that uses the
same source object (such as Region).

To create a link for a mobile document

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 You can link from a text field, an image, or a button. Do one of the following:

• To link from a text field, complete the following steps:

a From the Insert menu, select Text.

b Click in the section of the document where you want to place the text field.
If you click and drag in the section, you can size the text field.

To ensure that the area of a link is large enough to recognize a user
selecting it, make sure it has a height and width of at least 40 pixels.

c Type the text to be displayed to users into the text field. You can add static
text, dynamic text (in the form of data fields and auto text codes), or a
combination to the text field:

— To add static text, type the static text into the text field.

— To add a data field, drag and drop a dataset object from the Dataset
Objects panel into the text field.
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— To add an auto text code, from the Insert menu, select Auto-text,
then select the code to insert.

For background information about adding data fields and auto text codes
to documents, see the Document Creation Guide.

d Right-click the text field, and select Edit Links. The Links dialog box
opens.

• To link from an image, complete the following steps:

a From the Insert menu, select Image.

b Click in the section of the document where you want to place the image. If
you click and drag in the section, you can size the image. The Properties and
Formatting dialog box opens.

To ensure that the area of a link is large enough to recognize a user
selecting it, make sure it has a height and width of at least 40 pixels.

c Type the address of the image file to insert in the Source field.

d Click OK. The image appears in the document.

For background information about adding images to documents, see the
Report Services Document Creation Guide.

e Right-click the image, and select Edit Links. The Links dialog box opens.

• To link from a button, complete the following steps:

a Create the button, as described in Linking from documents with buttons
and tab bars, page 152.

b Right-click the button, and select Properties and Formatting. The
Properties and Formatting dialog box opens.

c Click to configure actions on the button. The Links dialog box opens.

3 In the Links dialog box, if other links already exist on this document, click the New
icon to create a new link.

4 Type a name for the link in the URL display text field. Since the name appears in
the link, it should be descriptive and informative to help users identify the target of
the link.

To define the link

5 Perform the appropriate steps below, depending on whether you are linking to a web
page or to a report/document:

• To link to a web page:

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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a Select Navigate to this URL. This option is available only if you selected
to create a link from a text field or image.

b Type the target URL in the field below Navigate to this URL.

c Continue this procedure at To define additional links and determine link
behavior, page 142.

• To link to a screen on the mobile device:

a Select Perform this.

b From the Perform this drop-down list, select the screen to link to.

c Continue this procedure at To define additional links and determine link
behavior, page 142.

• To link to a report or document:

a Select Run this report or document.

b Click the browse button (...) below Run this report or document to
find and select the target report or document.

To apply prompt answers to targets that contain prompts

6 The box below Run this report or document contains a list of any prompts
included in the target report/document. Select a target prompt from the box.

7 Select a prompt answer method from the drop-down list. For examples of each
prompt answer method, see Specifying how prompts are answered in the target,
page 143.

• Answer with the same prompt from the source: Select this option if you
want to use the same prompt answers for both the source report and the target
report/document. This option requires that both the source and target
documents use the same prompt.

• Prompt user: Select this option if you want the user to type prompt answers
after he taps the link to run the target report/document.

• Answer with an empty answer: Select this option if you want to ignore the
prompt in the target report/document. The prompt is not answered. This option
requires that the prompt in the target is not required. If the prompt in the target
is required, the user is prompted to provide an answer.

• Use default answer: Select this option if you want the prompt in the target to
use the default answer defined by the prompt’s designer. This option requires
that a default answer is defined for the prompt in the target.

The following methods are not intended to be used with buttons. For a button, use
one of the previous methods.

• Answer dynamically: Select this option if you want to answer the prompt
using the object selected in the source. This option is only available for attribute
element prompts and value prompts.
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• Answer using current unit: Select this option if you want to answer the
prompt using the object selected in the source. This option is only available for
hierarchy prompts.

• Answer using all valid units: Select this option if you want to answer the
prompt in the target with any object to the left of or above the object that the
user selects in the source document. This method passes all pertinent selections
in the source, rather than just the selection made for the link. This option is
available only for hierarchy prompts.

8 For each prompt in the target report/document, repeat the step above.

To specify the prompt answer method for prompts not in the list

9 Any other prompts are those prompts that are not in the target report/document
when you are creating the link. For example, these prompts can include prompts
added to the target later. By default, the Prompt user answer method is selected
for these prompts, but you can change the method. To do this, follow the steps
below:

a Select Any other prompts in the list.

b Select a prompt answer method from the list; these are the only methods
available for the Any other prompts option. For examples of each answer
method, see Specifying how prompts are answered in the target, page 143.

▫ Answer with the same prompt from the source

▫ Prompt user (default)

▫ Answer with an empty answer

▫ Use default answer

To apply selector values to a target document that contains selectors

10 Choose a selector value method from the Pass all selector values drop-down list.
For an example of passing selector values, see Passing selector values from the
source to the target, page 144.

• To match selector values by the selector’s source attribute (that is, the object
displayed in the selector), selectMatch Selectors by Source Attribute.

• To match selector values by the name of the selector, selectMatch Selectors
by Control Name.

To define additional links and determine link behavior

11 Repeat the steps above if you want to create additional links. You can create multiple
links on the same object.

12 Select the Open in new window check box to have the target report/document
open in a new window. This allows the target and the source documents to be visible
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simultaneously. If this check box is cleared, the target report/document or web page
opens and replaces the source document.

13 If the object has more than one link, select the link that you want to make the
default link, and click the Set as Default icon . When a user taps the object, the
default link is automatically used. To access other links, the user tabs and holds the
object, which displays a list of links that he can choose from.

14 Click OK to return to the source document and to save your link.

Specifying how prompts are answered in the target
This section contains only a brief overview of prompt answer methods. For more
detailed descriptions of the different prompt answer methods, including examples,
see the Linking Documents chapter of the Document Creation Guide. For
background information on prompts, see the description of prompt types in
Building Query Objects and Queries chapter in the Basic Reporting Guide.

To pass parameters to the target, the target must contain a prompt. When you create a
link, you define how the target’s prompt is answered, by selecting one of the following
prompt answer methods:

• Answer with the same prompt from the source. The same prompt answers
that were used to execute the source are used in the target. This option requires that
the source and target use the same prompt. If the same prompt does not exist in the
source and in the target, the user is prompted to provide an answer when the target
is executed.

• Prompt user. When the target is executed, the user is prompted to provide answers
manually.

• Answer with an empty answer. The prompt in the target is ignored, which
means that the prompt is not answered. No prompt answer is provided from the
source and the user is not prompted to provide answers.

The prompt must not be required, because if the prompt is required, the user
is prompted to provide an answer when the target report is executed by
clicking the link.

The Answer with an empty answer method, when used in conjunction with
the dynamic prompt answer method, allows a source document to answer one
prompt in a target with the user selection, while ignoring any other prompts.

• Use default answer. The prompt is answered by the default prompt answer for
the prompt in the target. If the target prompt does not have a default answer, the
Answer with an empty answer method is used. In this case, the prompt is not
answered, unless it is required, in which case the user is prompted to provide an
answer.

The following prompt answer methods are not intended to be used with buttons, since a
button does not select an object in the source. If you use one of them with a button, the
user is prompted for an answer. For a button, use one of the methods described above.

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/BasicReporting/WebHelp/Lang_1033/index.htm
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• Answer dynamically. The object selected in the source is passed to the prompt in
the target. If this object does not answer the target prompt, the Answer with an
empty answer method is used. In this case, the prompt is not answered, unless it
is required, in which case the user is prompted to provide an answer.

Available only for attribute element prompts and value prompts.

• A hierarchy prompt allows users to select prompt answers from one or more
attribute elements from one or more attributes. This prompt gives users the largest
number of attribute elements to choose from when they answer the prompt to
define their filtering criteria. The Answer using all valid units prompt answer
method passes selections made on the source document, rather than just the
selection made for the link, to the target. To restrict the prompt answer to just the
selected attribute element, use the Answer using current unit prompt answer
method. Like the Answer dynamically method, only the attribute element that is
selected is passed to the target.

These two prompt answer methods are available only for hierarchy prompts.

▫ Answer using current unit. The prompt is answered using the object
selected in the source. If the user selects an attribute header rather than a
specific attribute element, the Answer with an empty answer method is
used. In this case, the prompt is not answered, unless it is required, in which
case the user is prompted to provide an answer.

▫ Answer using all valid units. Any object to the left of or above the user
selection in the source is used as the prompt answer for the target. In other
words, this method passes all the selections made on the source, rather than just
the selection made for the link. If the user does not select any valid objects (for
example, the user selects an attribute header rather than a specific attribute
element), the Empty answer method is used. That is, the prompt is not
answered, unless it is required, in which case the user is prompted.

You can select a prompt answer method for prompts that are not in the target when you
are creating the link. These can be either:

• Prompts added to the target after the link is created

• Prompts that are created as the result of an answer to one of the original prompts in
the target, such as a prompt-in-prompt answer

These prompts are listed as the Any other prompt option in the list of prompts in the
Link Editor.

Passing selector values from the source to the target
A selector allows each user to interact with a document to display only the subset of data
that he is interested in or only specific attribute elements or metrics. For background
information on selectors, see the description of selector types, including examples and
steps to create them, in the Selectors chapter in the Dashboards and Widgets Creation
Guide.

The selector values that the user chooses in the source document can be passed to the
selectors in the target document.

https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DashboardsWidgets/WebHelp/Lang_1033/index.htm
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For example, the Regional Revenue document contains a selector for Region, so that the
user can view revenue for a specific region. The document contains a link to the Category
Revenue by Region document, which also contains a Region selector. If you select
Central in the selector, only the Central region, with its revenue, is displayed in the
document. If you tap the link for the Category Revenue by Region document, that
document is displayed. The selector is set to Central, the same as the selector in the
Regional Revenue document. Only Central’s data is displayed, by category.

To pass selector values from the source document to the target document, both the
source and the target must contain the same selector. This means that either both
documents must contain a selector with the same name (such as Region Selector), or
both documents must contain a selector that uses the same source object (the object
displayed in the selector, such as Region). When you create a link that passes selector
values, you can choose to match the selector values either by the selector name or the
source object.

Creating a link URL to specify page-by, report view,
layout, or grouping for the target
The Link Editor provides a quick and easy way to link to documents and reports. For
steps to create a link using the Link Editor, see Creating a link for a mobile document,
page 139.

For a document on an iPhone or iPad, you can specify a report’s page-by or report view,
or a document’s layout or grouping. For a document on an Android device, you can
specify a report’s report view. (The report view is whether a report is displayed as a grid, a
graph, or both a grid and graph.) To specify these parameters, use the hyperlink
properties and create the link URLs manually, by using the object ID and link syntax, as
described below.

Prerequisites

Before creating links, create any target documents and reports, and use the following
procedure to obtain their IDs:

1 Navigate to the folder location of the report or document.

2 Right-click the report or document, and select Properties. The Properties dialog
box is displayed, with the object's ID displayed in the ID field. You can highlight and
copy this ID to use in a link URL.

To create a link using a manual URL

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 To use a text field for the hyperlink, complete the following steps (if you are adding
an image, skip this step):

a From the Insert menu, select Text.

b Click in the section of the document where you want to place the text field. If
you click and drag in the section, you can size the text field.
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To ensure that the area of a link is large enough to recognize a user
selecting it, make sure it has a height and width of at least 40 pixels.

c Type the text to be displayed to users into the text field. You can add static text,
dynamic text (in the form of data fields and auto text codes), or a combination to
the text field:

▫ To add static text, type the static text into the text field.

▫ To add a data field, drag and drop a dataset object from the Dataset
Objects panel into the text field.

▫ To add an auto text code, from the Insert menu, select Auto-text, then
select the code to insert.

For background information about adding data fields and auto-text codes
to documents, see the Document Creation Guide.

3 To use an image for the hyperlink, complete the following steps:

a From the Insert menu, select Image.

b Click in the section of the document where you want to place the image. If you
click and drag in the section, you can size the image. The Properties and
Formatting dialog box opens.

To ensure that the area of a link is large enough to recognize a user
selecting it, make sure it has a height and width of at least 40 pixels.

c Type the address of the image file to insert in the Source field.

d Click OK. The image appears in the document.

For background information about adding images to documents, see the
Document Creation Guide.

4 Right-click the image or text field, and select Properties and Formatting. The
Properties and Formatting dialog box opens.

5 From the left, click General, then select the Is Hyperlink check box.

6 Type the link URL in theHyperlink field:

• To have the link execute a document, use the syntax:

http://
MSTRMobileURL
?&src=
source
&evt=2048001&currentViewMedia=2&documentID=objectID

• To have the link execute a report, use the syntax:

https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/DocCreationGuide/WebHelp/Lang_1033/index.htm
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http://
MSTRMobileURL
?&src=
source
&evt=4001&reportViewMode=view&reportID=objectID

• To add additional parameters to the URL, such as providing answers for the
target document’s prompts, see Using links to display document layouts and
group data, and run reports and documents on other servers and projects,
page 147.

Replace the italicized variables, as listed in the following table:

Variable Replace With

MSTRMobileURL To use an absolute path to your Mobile Server, use one of the following:

• For .NET

MobileServer/MicroStrategy/asp/Main.aspx

• For J2EE

MobileServer/MicroStrategy/servlet/mstrWeb

Replace Mobileserver with the name of your MicroStrategy Mobile Server.

To use a relative path to your Mobile Server, use mstrWeb.

source The page component that should handle the action and the event:

• For a document using J2EE format, mstrWeb.2048001

• For a document using .NET format, Main.aspx.2048001

• For a report using J2EE format, mstrWeb.4001

• For a report using .NET format, Main.aspx.4001

view Report view mode:

• For grid view: 1

• For graph view: 2

• For grid and graph view: 3

objectID The object ID of the target document or report

7 Click OK to return to the document.

Using links to display document layouts and group data, and run
reports and documents on other servers and projects

Once you have created a link to run a report or a document on an iPhone or iPad, you
can add parameters to the URL to perform additional tasks, such as providing answers
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for prompts in the linked document, or specifying the layout to display when a document
is run.

For Android and iOS devices, you can run reports or documents from a different project
or server. The project or server that you link to must be defined in the mobile
configuration for the device.

The table below lists the tasks you can perform, and the syntax for the link parameters to
perform them. You can add these parameters to a link URL by separating each parameter
with an ampersand (&). The link parameters are case sensitive. For example, the
following URL contains parameters to display the first layout in a document:

Main.aspx?evt=2048001&currentViewMedia=2&documentID=E8
663E7A4D8CDF05C060129D0061692&layoutIndex=0

Task Syntax

Run a report or
document from
a different
project or server

Server=
servername
&Project=
projectname&uid=username&pwd=password

Replace servername, projectname, username, and password with the
name of the server, project, and the login name and password to use to log in
respectively.

By default, if the URL does not specify a server and project, the current server and
project are used. You can specify these parameters, called session parameters, to
execute a report or document in a different server or project, and provide the
appropriate login name and password.

For more information on session parameters, see the Customizing MicroStrategy
Web section, in Part I: Fundamentals of Customization in theWeb Software
Development Kit, available in theMicroStrategy Developer Library (MSDL),
which is part of the MicroStrategy SDK.

Display a
specific layout
in a document

layoutIndex=layout

Replace layout with the number of the layout you want to display. The first layout
in the document is 0, the second is 1, and so on.

Specify the
group-by
element in a
document

groupByElements=
groupByUnitID
;groupByUnitType;groupByElementID

Replace the italicized variables with the following:

• groupByUnitID: The ID of the group-by attribute or consolidation. You can
use {&AttributeName@GUID}, to provide the ID automatically. Replace
AttributeName with the name of the attribute or consolidation.

• groupByUnitType: Use 12 for an attribute, or 47 for a consolidation.

• groupByElementID: The ID of the group-by element. You can use
{&AttributeName@LongElementID}, to provide the ID automatically.
Replace AttributeName with the name of the attribute or consolidation.

You can specify multiple group-by elements by separating each set of group-by
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Task Syntax

parameters with a caret (^), as follows:

groupByElements=
groupByUnitID1
;
groupByUnitType1
;
groupByElementID1
^
groupByUnitID2
;groupByUnitType2;groupByElementID2

Specify the
page-by
element in a
report

pageByElements=
pageByUnitID;pageByUnitType;pageByElementID

Replace the italicized variables with the following:

• pageByUnitID: The ID of the page-by attribute or consolidation. You can use
{&AttributeName@GUID}, to provide the ID automatically. Replace
AttributeName with the name of the attribute or consolidation.

• pageByUnitType: Use 12 for an attribute, or 47 for a consolidation.

• pageByElementID: The ID of the page-by attribute or consolidation. You can
use {&AttributeName@LongElementID}, to provide the ID
automatically. Replace AttributeName with the name of the attribute or
consolidation.

You can specify multiple page-by elements by separating each set of page-by
parameters with a caret (^), as follows:

pageByElements=
pageByUnitID1
;
pageByUnitType1
;
pageByElementID1
^
pageByUnitID2
;pageByUnitType2;pageByElementID2

For information about finding the ID of an individual attribute element, see To
obtain the ID of a specific attribute element in a document, page 149.

To obtain the ID of a specific attribute element in a document

1 To obtain the ID of a specific element in an attribute, you must first obtain the ID of
the attribute. Navigate to the folder location of the attribute.

2 Right-click the attribute, then select Properties. The Properties dialog box is
displayed, with the attribute's ID displayed in the ID field.
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3 Highlight the ID, then copy it to the clipboard.

4 Open the document that contains the attribute in Editable Mode.

5 Right-click the header of the attribute in the Grid/Graph, then point to Attribute
Forms, and select ID. The ID of each element in the attribute is displayed.

6 The full attribute element ID is the ID of the element’s attribute, followed by a colon
(:) and the ID of the element displayed in the grid. For example:

8D679D4B11D3E4981000E787EC6DE8A4:2

Using links to access features within the
MicroStrategy Mobile application

You can use links in a document to access specific features within the MicroStrategy
Mobile application for iPhone or iPad. For example, you can add a link to display the My
Reports folder or email a screenshot of the document.

You can use the Link Editor to quickly create the following links, instead of typing
the URL into a hyperlink, to display the:

• Help

• Home screen

• Report List

• Shared Library

• Status screen

• Settings screen

For steps, see Creating a link for a mobile document, page 139.

The procedure to create the following hyperlinks is identical to that for creating
hyperlinks to the device’s installed applications. For steps, see To create a hyperlink to
an application on the device, page 136.

The table below lists the types of links you can create, and the URL to use to create
them.

Task URL

View a folder mstr://?evt=2001&folderID=foldernumber

Replace foldernumber with the ID of the folder you want to display.
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Task URL

Display the
Shared Reports
folder

mstr://?evt=2001&systemFolder=7

Display the My
Reports folder

mstr://?evt=2001&systemFolder=20

Email a
screenshot of
the document

mstr://?evt=3037

The screenshot is added to the email as an attachment. To add a subject to the
email, add &emailSubject=subject to the end of the URL, then replace
subject with the subject. For example, to send an email with the subject “Your
requested report”, type
mstr://?evt=3037&emailSubject=Your+requested+report.

Annotate and
Share the report
or document

mstr://?evt=3175

Print the current
document

mstr://?evt=3103

Print a target
document

mstr://evt=2048001&src=
source
.2048001&visMode=0&currentViewMedia=20&documentID=
objectID

Where:

• source is the page component that should handle the action and the event.

• objectID is the object ID of the target document.

Display the Help mstr://?evt=3994

Display the
Home screen

mstr://?evt=3995

Display the
Shared Library

mstr://?evt=3996

Display the
Reports or
Subscriptions
screen, as
applicable

mstr://?evt=3997

Display the
Status screen

mstr://?evt=3998

Display the
Settings screen

mstr://?evt=3999

Log out the user mstr://?evt=4000

Return to the mstr://?evt=3124
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Task URL

previously
viewed
document

Select a specific
panel in a panel
stack

mstr://?evt=2048076&psName=PANEL_STACK_NAME&pName=PANEL_
NAME

Replace the italicized variables as follows:

• PANEL_STACK_NAME: The name of the panel stack to target

• PANEL_NAME: The name of the panel to select

To select panels from multiple panel stacks, use the following format:

mstr://?evt=2048076&psKey=
PanelStack1|PanelStack2|…&pKey=PanelK1|PanelK2|…

Replace the italicized variables as follows:

• PanelStack1, PanelStack2, etc.: The names of the panel stacks to
target.

• PanelK1, PanelK2, etc.: The names of the panels to select, in the order of
the panel stack. For example, PanelK1 is a panel in PanelStack1.

Display a specific
Information
Window

mstr://?evt=2048500&panelName=Name

Replace Name with the name of the panel stack you have created to use as the
Information Window.

Display a
selection screen
that allows you
to specify the
element to use
to group data

mstr://gb/?e={&AttributeName@ElementID}&a=
{&AttributeName@GUID}&s=style

Replace AttributeName with the name of the attribute you want to use to
group data. Replace style with one of the following:

• To display the attribute elements in a directory-like list: 0

• To display the attribute elements on a wheel: 1

Re-prompt the
document

mstr://pr

Linking from documents with buttons and tab
bars

A button can send a user to the various screens, such as the Home screen or the Report
List, on an iPad, iPhone, or Android device. A button can run a report or document, or
open a web page or Information Window. An Information Window lets users view
additional information in a pop-up window. In MicroStrategy Web, a button can open a
web page, or run a report or document.
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For example, the document shown below contains several buttons. Notice that all the
buttons are displayed in white.

A button can change its appearance after a user taps it. When a user taps the Customer
button, for example, the button changes to blue, as shown below. This is referred to as its
highlight state. The button’s initial state (when it is not selected) is referred to as its
normal state.

A customer analysis document is displayed. If a user tapped the Sales Analysis button
instead, a regional sales document is displayed. If a user taps the button with the
envelope, the email program is launched.

The different button styles determine whether a caption, icon, or both are displayed. A
caption is the text that describes the button’s action. The icon is a small image that
represents the button’s action. If both a caption and an icon are displayed, the button
style also determines where the caption and icon are located in relation to each other.
The icon can be to the left or the right of the caption, or it can be above the caption.

You can also select the custom style, which allows you to select an image to display as the
button. The image can be any shape, size, and color. The image is displayed on your
mobile device without any additional formatting. You can use two different images, one
for the normal state and the other for the highlighted state. The example above uses
custom style buttons.

Each button can have more than one link. The same button can be linked to multiple
web pages, reports, and documents. If a default link has been defined, that link is
executed when the button is tapped. To open a list of links, tap and hold the button. If a
default link has not been defined, tapping the button opens the list of links.

You can add a single button to a document, or add multiple buttons with different
formatting in different locations on the document; see Creating a button to link from a
Mobile document, page 157 for steps. For documents displayed on an iOS device, you can
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create a bar of buttons that are all formatted the same, called a tab bar. A tab bar displays
at the bottom of the screen, similar to tab bars in other iOS applications.

You create the tab bar as a navigation document, which contains only the tab bar. This
allows the tab bar to display all the time, even when a user changes panel stacks or
layouts on a document, or switches to a different document. In effect, you are creating a
navigation system for the set of Mobile documents that are linked with the tab bar. The
tab bar is shown only when navigating the documents linked in the tab bar. The tab bar
is not displayed if either of the following cases:

• A user opens a linked document from a folder, not from the navigation document or
tab bar.

• A user opens a document that is not linked in the tab bar.

The navigation document becomes the home page or launch site for this set of
documents. When a user opens the navigation document, the tab bar and the document
linked in the first button are displayed.

For example, a navigation document, called Store Dashboards, has been created for a
project. The user opens Store Dashboards, and the Overview dashboard is displayed,
along with the tab bar, as shown below:

Notice that the button for Overview is selected in the tab bar. The user taps the button
for Customer, which causes that document to display, as shown below:
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Notice that the button for Customer is selected in the tab bar, and there is no Back
button at the upper left.

Creating a tab bar to hold buttons
A tab bar is a bar of navigation buttons, displayed at the bottom of an iOS document. The
tab bar is displayed all the time, even when a user changes panel stacks or layouts on a
document, or switches to a different document. In effect, you are creating a navigation
system for a set of Mobile documents.

You create the tab bar as a navigation document, which contains only the tab bar. You
can customize the background tint of the tab bar, and the color of the selected button’s
icon (the highlight state). When the tab bar is displayed on a mobile device, the caption
and icon colors use a generic iOS format to enhance readability. In the examples above,
the background of the tab bar has a tint of black, with the selected button’s icon
highlighted in blue. The selected button’s caption is automatically displayed in white,
while the captions of the other buttons automatically remain gray.

You can add buttons to the tab bar, remove buttons from the tab bar, and move the
buttons around on the tab bar. For each button on the tab bar, you define the link and
the icon. If you define more than five buttons for an iPhone document or eight for an
iPad document, a button labeled More is automatically added to the tab bar.

Take into account the height of the tab bar, which is 49 points, when you design a
document that will be linked from a tab bar.
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Best practices for creating the button image

The button’s image is used by iOS to create the icon that is displayed in Mobile, so you do
not need to create a full-color image for the button. Some best practices to create the
image for the button include:

• Use pure white with the appropriate alpha transparency.

• Do not use a drop shadow.

• Use anti-aliasing.

• Bevels should be 90°. The bevel should look like a light source is positioned at the
top of the image.

To ensure that the tab bar icon renders sharply on devices with different resolutions,
follow these suggestions:

• If you are designing the tab bar to be displayed on a high-resolution (retina display)
device, design your button icon to be about 60 x 60 pixels. Add the text @2x as the
suffix of the image name, for example, icon@2x.jpg. For devices with very high-
resolution screens, such as the iPhone 6 Plus, use the suffix @3x. The image is shown
as designed on a high resolution device, without any stretching or shrinking at the
pixel level. On low resolution devices, the image is scaled to support the lower
resolution.

• If you are designing the tab bar for low-resolution devices, design your button icon to
be about 30 x 30 pixels. Do not include the @2x suffix in the image name. The image
is shown as designed on low resolution devices, without any stretching or shrinking
at the pixel level. On high resolution devices, the image is scaled to four times its
original size at the pixel level, causing the image to look blurry.

To add a tab bar for an iPad or iPhone document

1 In MicroStrategy Web, click the MicroStrategy icon at the top of any page and

select New Document. The Create Document page opens.

2 Select either Navigation for iPad or Navigation for iPhone, and click OK. The
Document Editor opens in Design Mode. A tab bar is already displayed in the
document template, with two buttons, in the Document Footer. No other document
sections are available.

To select the tab bar’s colors

3 Right-click the tab bar (not a button) and select Properties and Formatting. The
Properties and Formatting dialog box opens.

4 From the left, select Color and Lines.

5 From the Color drop-down list, select the tint of the tab bar’s background.
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6 From theHighlight state color drop-down list, select the color of a button’s icon
after it is tapped. All buttons on the tab bar use the same color in their highlight state
(after being tapped).

7 Click OK to save your changes and return to the document.

The tab bar and buttons do not change color in Design Mode; the colors apply
when the document is displayed in MicroStrategy Mobile.

Now you can add buttons to the tab bar, as described in Creating a button to link from a
Mobile document, page 157 below. You can add as many buttons as necessary. If you
define more than five buttons for an iPhone document or eight for an iPad document, a
button labeled More is automatically added to the tab bar.

Creating a button to link from a Mobile document
Prerequisites

• If you are adding a button to a tab bar, you must have already created the tab bar.
For steps, see Creating a tab bar to hold buttons, page 155.

• If you are using an icon on the button, you need to know the location of the images
to be used. You can specify a single image, or you can specify an image to display
before the button is tapped and a different image after it is tapped. If the button is
part of a tab bar, the images should be monochromatic for the best display.

To add a button

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 You can add a stand-alone button or add a button to a tab bar:

• To add a stand-alone button, from the Insert menu, point to Button, and then
select a style. When you move the cursor to the Layout area, the pointer
becomes crosshairs. Click in the desired location in the Layout area to add a
button of the default size. If you click and drag in the Layout area, you can size
the button.

• To add a button to a tab bar, click the Add Button icon on the tab bar. A

new button is added to the tab bar, with the correct size.

3 If the selected button style displays a caption, double-click the caption text box. Type
the caption to display, and press ENTER.

4 Right-click the button, and select Properties and Formatting. The Properties
and Formatting dialog box opens.

5 From the left, select Button.

You can change the button style, if the button is stand alone.
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6 If the selected button style displays an icon or a custom image, specify the source of
the images.

• The normal state is displayed before the user taps it. Type the location and file
name of the image to display in the normal state, in the Normal state source
field.

• The highlighted (or selected) state is displayed after the user taps it. Type the
location and file name of the image to display in the highlighted state, in the
Highlight state source field.

If the button is displayed in a tab bar, the images should be monochromatic.

7 If the button style is set to Caption only, you can determine whether the button is
displayed as highlighted only:

• To display the button as highlighted only after a user taps it, clear the Show
button in highlight state by default check box.

• To display the button as highlighted only, select the Show button in
highlight state by default check box. When a user taps the button, the action
is triggered, but the button does not change.

8 Click OK to save your changes and return to the document.

Next, you define the link or the Information Window for the button. For steps to define
the link, see Creating a link for a mobile document, page 139. For steps to define an
Information Window, see Providing additional information to users: Information
Windows, page 38.

Formatting a stand-alone button

To format a stand-alone button, you can:

• Size the button

• Select the button’s background color before and after it is tapped

• Select whether to display a border around the button when the document is viewed
in MicroStrategy Web

• Format the font of the button’s caption

• Select the button’s caption font color before and after the button is tapped

This formatting applies to a stand-alone button, because a tab bar specifies the same
formatting for all of its buttons. Steps to format the tab bar’s colors and the caption’s
font are included in the procedure to create a tab bar; see To add a tab bar for an iPad
or iPhone document, page 156. For a button with a custom style, you can size the
button, but all other formatting comes from the image that you select.

Prerequisite

Before you can format a stand-alone button, you must have created the button. For
steps, see Creating a button to link from a Mobile document, page 157.
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To format a stand-alone button

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.

2 Right-click the button and select Properties and Formatting. The Properties and
Formatting dialog box opens.

To size the button

3 From the left, select Layout.

4 In the Size area, type theWidth andHeight in the fields. The icon and caption, if
both are used, are automatically resized to maintain their proportions in the button.

To select the button’s colors

These options are unavailable for a button with a custom style, since the image is
displayed as is.

5 From the left, select Color and Lines.

6 From the Style drop-down, select one of the following:

• Flat

• Glossy

7 From the Normal state color drop-down, select the button’s color before it is
tapped.

8 From theHighlight state color drop-down, select the button’s color after it is
tapped.

9 Determine whether the button has a border, by doing one of the following:

• To hide borders, select None.

• To display borders, select All. From the drop-down list, select the color of the
borders around the button.

To format the caption’s font

These options are unavailable for a button with a custom style, since the image is
displayed as is.

10 From the left, select Font.

11 Select the Font, Style, and Size of the caption text.

12 From the Normal state color drop-down, select the caption’s color before the
button is tapped.
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13 From theHighlight state color drop-down, select the caption’s color after the
button is tapped.

14 Click OK to save your changes.

Storing links on NFC tags on Android devices
You can store a link on Near Field Communications (NFC) tags to open the Home
screen, Settings screen, Help screen, or the contents of the Shared Library folder on an
Android device through MicroStrategy Mobile. An NFC tag is a small piece of hardware
that broadcasts short-range wireless signals to compatible devices. When a Mobile user
places her NFC capable Android device within the required range of the NFC tag, a link is
broadcast to her device. This link opens MicroStrategy Mobile on the Android device and
displays the specified screen.

A Mobile user can only view the projects that her device has been configured to
access. When creating a link for NFC tags, ensure that your target audience is using
a mobile configuration that provides access to the specified report, document, or
folder.

To store a link on your NFC tags, use a third-party NFC programming app on an NFC
capable Android device. The table below lists the types of links you can create on NFC
tags, and the URL to use to create them. The URLs in the table open the default
MicroStrategy Mobile application. If your organization has a customized version of
MicroStrategy Mobile, replace mstr:// with your customized URL prefix.

Task URL

Display the Home screen mstr://?evt=3995

Display the Settings screen mstr://?evt=3999

Display the Help screen mstr://?evt=3994

Display the contents of the Shared Library folder mstr://?evt=3996

Display the previously viewed screen (Back) mstr://?evt=3124



5
ADMINISTERING
MICROSTRATEGY MOBILE

This section explains how to install and configure MicroStrategy Mobile on an
Intelligence Server, and how to install and configure the MicroStrategy Mobile
application on mobile devices. It also explains how to subscribe to reports, and the ways
in which administrators can manage multiple subscriptions simultaneously.

Prerequisites
• This section is primarily intended for system administrators. As such, readers are

assumed to have various MicroStrategy system administrator privileges.

The topics covered in this section include:

• Overview: MicroStrategy Mobile architecture, page 161

• Installing and configuring Mobile Server, page 162

• Working with projects and managing Intelligence Server, page 168

• Configuring and viewing logs and statistics, page 177

• Deploying and configuring the MicroStrategy Mobile application, page 183

• The Mobile subscription workflow, page 221

• Managing Mobile report subscriptions, page 222

• Customizing error messages for mobile devices

• Troubleshooting MicroStrategy Mobile, page 237

Overview: MicroStrategy Mobile architecture
The following diagram shows MicroStrategy Mobile as a part of the MicroStrategy
architecture:

© 2017, MicroStrategy Inc. 161
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There are two main components in a MicroStrategy Mobile deployment:

• The MicroStrategy Mobile client applications, installed on an iPhone, iPad, or
Android device. The client applications send requests for reports and documents to
Mobile Server, and display the reports when they are received. For steps to deploy
and configure client applications, see Deploying and configuring the MicroStrategy
Mobile application, page 183.

• MicroStrategy Mobile Server, which performs the following functions:

▫ Maintains the configurations for devices, and connects the devices to projects on
Intelligence Server.

▫ Receives reports and documents from Intelligence Server, and delivers them to
the iPhone, iPad, or Android device.

For steps to install Mobile Server, see Installing and configuring Mobile Server,
page 162.

Installing and configuring Mobile Server
To install MicroStrategy Mobile Server, select theMicroStrategy Mobile Server
component of MicroStrategy Mobile during your MicroStrategy installation. For system
requirements and specific instructions on how to install or upgrade MicroStrategy, see
either theMicroStrategy Installation and Configuration Guide or theMicroStrategy
Upgrade Guide.

MicroStrategy Mobile affects several specific areas that may require an administrator’s
attention. These include:

• Authentication settings for the Mobile Server application, page 163



Mobile Design and Administration Guide

© 2017, MicroStrategy Inc. 163

• Privileges and permissions, page 163

• SSL encryption, page 164

• Client authentication with a certificate server, page 164

• Destination folder for the Photo Uploader widget and Signature Capture input
control, page 168

Authentication settings for the Mobile Server
application

The following instructions apply only to authenticating the Mobile Server
application on the machine that it runs on. For instructions on setting up user
authentication for your MicroStrategy environment, such as LDAP or single sign-
on authentication, see the System Administration Guide.

If you are using the ASP.NET version of Mobile Server, make sure that you configure the
IIS authentication settings for the Mobile Server application. Otherwise certain reports
and documents may display incorrectly or fail to execute.

You must make sure that IIS uses anonymous authentication to access all directories at
the Mobile Server application level. In addition, you must enable integrated Windows
authentication for all directories except the following image directories:

• MicroStrategyMobile/asp/images

• MicroStrategyMobile/images

Integrated Windows authentication must be disabled for these directories.

For instructions on how to configure the authentication settings in your version of IIS,
see the IIS documentation.

Privileges and permissions
Reports viewed in Mobile are subject to the same security restrictions as reports viewed
in any other MicroStrategy client. In particular, access control lists (ACLs) and security
filters are applied to reports viewed in Mobile in the same way as in MicroStrategy Web
or Developer.

To view reports in Mobile, users must have the Use MicroStrategy Mobile privilege for all
projects containing reports they want to view. In addition, to view Report Services
documents in Mobile, users must have the Mobile View Documents privilege for all
projects containing documents they want to view. Both these privileges can be found in
the MicroStrategy Mobile privilege group.

It is the responsibility of the system administrator to ensure that MicroStrategy Mobile
users have the privileges and permissions necessary to view reports and documents. In
general, this means that users should have the Execute permission for any reports they
are subscribed to, and for any objects contained in those reports.

For information about setting user privileges and object permissions, see the Setting Up
User Security chapter in the System Administration Guide, or theMicroStrategy

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm


Mobile Design and Administration Guide

164 © 2017, MicroStrategy Inc.

Developer Help ). For a complete list of user privileges, see the List of Privileges chapter
in the Supplemental Reference for System Administration.

SSL encryption
MicroStrategy Mobile is equipped to take advantage of Secure Socket Layer (SSL)
encryption, to ensure that your data remain secure at all stages of transmission. SSL
transmissions can be identified by the https:// prefix, instead of the standard
http:// prefix.

For detailed instructions on configuring Mobile Server to use SSL, see the Enabling
Secure Communication chapter in the System Administration Guide.

If you are using MicroStrategy Mobile for Android devices, you can specify a location for
trusted certificates in the Connectivity Settings tab in the Mobile Configuration.

Client authentication with a certificate server
MicroStrategy Mobile Server can use a certificate server to authenticate the identity of
Android and iOS mobile clients. This certificate server can run on the same application
server as the Mobile Server, or on a different one.

When client authentication is enabled and a certificate server is configured, a valid
certificate must be issued to mobile clients that allows them to gain access to the Mobile
Server. This process ensures that each mobile device is authorized to access the system,
and allows you to deny authentication requests from devices which may have been
compromised.

To set up the client certificate server

1 Set up SSL between mobile devices and MicroStrategy Mobile using the procedure in
the Administering MicroStrategy Web and Mobile chapter in the System
Administration Guide.

2 Install the certificate server using the ASP or JSP installation file from your
MicroStrategy installation folder. The ASP files are located in
MicroStrategy\Mobile Server ASPx\CertificateServer. The JSP file is
located in MicroStrategy\Mobile Server JSP\CertificateServer.war.

Note the following:

• To set up a certificate server with Microsoft Internet Information
Services (IIS) 6.0, you must have the Read Scripts and Run Scripts
permissions, and you must deploy the certificate server as a virtual
directory.

• To set up a certificate server with Microsoft Internet Information
Services (IIS) 7.0 or newer, you must deploy the certificate server as an
application.

https://www2.microstrategy.com/producthelp/10.7/SupplementalAdmin/WebHelp/Lang_1033/index.htm
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3 You must choose a signed certificate from a third party certificate authority to
configure the certificate server. Either use the same certificate generated for SSL, or
obtain a different one.

4 Once you have the certificate, install it on your application server, add it to a
previously created trust list, and enable client authentication. Refer to your
application server documentation for information on installing the certificate,
creating a trust list, and configuring the application server to use client
authentication.

Configuring the certificateServerConfig.xml file

5 Specify the Intelligence Server and project name in the
certificateServerConfig.xml file, located by default in
MicroStrategy\Mobile Server ASPx\CertificateServer\ WEB-
INF\xml\certificateServerConfig.xml for the ASP version, or
MicroStrategy\Mobile Server JSP\ CertificateServer\WEB-
INF\xml\ certificateServerConfig.xml for the JSP version. This
information is used to authenticate clients before they have obtained a certificate.

6 In the certificateServerConfig.xml file, ensure that the correct provider is
selected. This information is dependent on the MicroStrategy Mobile Server
platform, as displayed in the following example for Tomcat application servers:

<provider class="com.microstrategy.web.certificate.Tom
catCertificateProvider"/>

7 In the certificateServerConfig.xml file, ensure that the X.509 parameters
are correctly configured for your environment.

8 In the certificateServerConfig.xml file, specify your signing certificate
format as either Java Keystore (JKS) or Distinguished Encoding Rules (DER).

9 To enable the certificate server to revoke specified client certificates, set up the
Certificate Revocation List (CRL) on the application server. Also configure the CRL
Distribution Point (CDP) to designate a URL where the application server can check
for CRLs. Configure the CDPLocation parameter in the
certificateServerConfig.xml file by specifying the URL for the CRL. Refer
to your application server documentation for information on configuring the CRL
and CDP.

Enabling the certificate server in the Mobile configuration

10 When creating your MicroStrategy Mobile configuration, in the iPhone Settings,
iPad Settings, Phone Settings, or Tablet Settings tab, select the Use
Certificate Server check box, and in the text field, specify a URL for the
certificate server. Because the certificate server must be configured with SSL, ensure
that the URL employs the fully qualified name of the certificate server, and begins
with https://, as in the following examples.

ASP:

https://fully_qualified_domain_name:port/
CertificateServer/asp/certificate.aspx
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JSP:

https://fully_qualified_domain_name:port/
CertificateServer

or

https://fully_qualified_domain_name:port/
CertificateServer/servlet/certificate

where:

• fully_qualified_domain_name:port is the location and port of your
certificate server. For example, machine_name.domain.com:8443.

For more information on creating a mobile configuration, see Configuring
MicroStrategy Mobile for iPhone or iPad, page 186 or Configuring MicroStrategy
Mobile for Android, page 194.

Downloading a certificate to a mobile client

11 When a client requires a certificate, the Mobile user is prompted to begin the
download. When a user clicks OK to begin the download, she is prompted to log in to
the project specified in the certificateServerConfig.xml file.

Users can also manually download a client certificate from the Advanced
Settings screen of the MicroStrategy Mobile application. For more
information, see Downloading a client certificate from the certificate server,
page 216.

Managing certificates with the certificate server API

12 To obtain a certificate for each mobile device through the API, use one of the
following URLs.

ASP:

https://fully_qualified_domain_name:port/
CertificateServer/asp/certificate.aspx?action=GetCer
tificate&loginParams=<auth><device_id>mobile_
device</device_id><pkcs12_password>keystore_
password</pkcs12_password><field n="pwd" v="MSTR_
password"/><field n="login" v="MSTR_login"/></auth>

JSP:

https://fully_qualified_domain_name:port/
CertificateServer/servlet/certificate?action=GetCert
ificate&loginParams=<auth><device_id>mobile_
device</device_id><pkcs12_password>keystore_
password</pkcs12_password><field n="pwd" v="MSTR_
password"/><field n="login" v="MSTR_login"/></auth>

where:
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• fully_qualified_domain_name:port is the location and port of your
certificate server. For example, machine_name.domain.com:8443.

• mobile_device is the UUID of the mobile device.

• keystore_password is the pkcs12 password that is used for the generated
keystore.

• MSTR_password is the user’s MicroStrategy password for the project specified
in certificateServerConfig.xml.

• MSTR_login is the user’s MicroStrategy login for the project specified in
certificateServerConfig.xml.

13 To view a list of certificates on the certificate server through the API, the application
server administrator uses one of two URLs, as displayed in the examples below.

ASP:

https://fully_qualified_domain_name:port/
CertificateServer/asp/CertificateAdmin.aspx?action=G
etCertificateList

JSP:

https://fully_qualified_domain_name:port/
CertificateServer/servlet/certificateAdmin?action=Ge
tCertificateList

where fully_qualified_domain_name:port is the location and port of your
certificate server. For example, machine_name.domain.com:8443.

14 To revoke a specific certificate through the API, the application server administrator
uses one of two URLs, as displayed in the examples below.

ASP:

https://fully_qualified_domain_name:port/
CertificateServer/asp/CertificateAdmin.aspx?action=R
evokeCertificate&serialNumber=serial_number

JSP:

https://fully_qualified_domain_name:port/servlet/
certificateAdmin?action=RevokeCertificate&serialNumb
er=serial_number

where:

• fully_qualified_domain_name:port is the location and port of your
certificate server. For example, machine_name.domain.com:8443.

• serial_number is the serial number of the certificate to be revoked. This
number can be retrieved from the list of certificates.

15 To revoke all certificates for a specific mobile device through the API, the application
server administrator uses one of two URLs, as displayed in the examples below.
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ASP:

https://fully_qualified_domain_name:port/
CertificateServer/asp/CertificateAdmin.aspx?action=R
evokeCertificate&uuid=device_uuid

JSP:

https://fully_qualified_domain_name:port/servlet/
certificateAdmin?action=RevokeCertificate&uuid=
device_uuid

where:

• fully_qualified_domain_name:port is the location and port of your
certificate server. For example, machine_name.domain.com:8443.

• device_uuid is the universally unique identifier of the mobile device.

Destination folder for the Photo Uploader widget and
Signature Capture input control
The Photo Uploader widget allows Mobile users to upload images from their mobile
devices to a central location that is specified in the microstrategy.xml file on the
Mobile Server. Images of signatures provided using the Signature Capture input control
in a Transaction Services-enabled document are also uploaded to this location. By
default, the microstrategy.xml file is located in your MicroStrategy installation
location in MicroStrategy\Mobile Server ASPx\WEB-INF or in
MicroStrategy\Mobile Server JSP\WEB-INF, depending on the application
server that runs your Mobile Server.

Configure the desired location for saved images by specifying a relative or absolute path
in the value field of the resourcesFolderSavedImage parameter in the
microstrategy.xml file. If you have clustered Mobile Servers in your environment
and you would like to store all saved images in a central location, specify an absolute path
to the desired location in the microstrategy.xml file of each individual Mobile
Server, and ensure that all Mobile Servers are able to access that location.

Working with projects and managing
Intelligence Server

To allow MicroStrategy Mobile users to access MicroStrategy projects, you must create a
connection between a MicroStrategy Intelligence Server and Mobile Server. You can
create connections between Intelligence Server and Mobile Server, disconnect from
Intelligence Server, and specify additional options, such as whether traffic between
mobile devices, Mobile Server, and Intelligence Server is encrypted or whether to enable
Single Sign-on (SSO) authentication for MicroStrategy Mobile with third-party trusted
authentication providers such as Tivoli or SiteMinder.
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Users can also log into MicroStrategy Mobile using MicroStrategy Usher. Usher enables
users to electronically validate identity using the Usher Security app on their
smartphones, instead of entering a password.

For steps, see the appropriate links below:

• Creating a new connection to Intelligence Server, page 169

• Connecting to an available Intelligence Server, page 171

• Disconnecting from an Intelligence Server, page 172

• Specifying default connection, load balance, and timeout settings, page 172

• Encrypting session information, page 174

• Maintaining TCP/IP connections through a firewall, page 174

• Enabling single sign-on authentication for Mobile, page 175

• Enabling Usher authentication for Mobile, page 177

Creating a new connection to Intelligence Server
To allow Mobile users to access projects, you must create a connection between a
MicroStrategy Intelligence Server and Mobile Server.

Mobile automatically recognizes new Intelligence Servers added to a cluster of
Intelligence Servers in the MicroStrategy system. Once an Intelligence Server is added to
the system from MicroStrategy Developer, it is automatically listed in Mobile as a part of
the Intelligence Server cluster.

You must connect to an Intelligence Server of the same product version as the
Mobile client you have installed. If the Intelligence Server is an older version, an
error message prompts you to upgrade your Intelligence Server to a compatible
version.

To create a new Mobile-to-Intelligence Server connection

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 In the Add a server manually field, specify the DNS name of the Intelligence
Server machine.

3 Click Add. The Server Properties page opens and displays server name, connection
status, and server port number.
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4 Select one of the following to determine when and how Mobile connects to the
Intelligence Server.

• To ensure that Mobile server automatically reconnects to the Intelligence Server
when the Mobile server is started or restarted, select Automatically connect
to Intelligence Server when Mobile Server or Intelligence Server is
restarted.

• To ensure that the administrator must manually create a connection to the
Intelligence Server by clicking Connect, select User manually connects
Mobile to Intelligence Server. This is the default option.

5 In the Port field, specify the port number used to connect to the Intelligence Server.

6 If the Intelligence Servers are in a cluster, you can determine the number of
connections within the "pool" of connections. The pool is the number of
connections between Mobile Server and the Intelligence Servers. This is defined at
the Intelligence Server level, not at the cluster level. This allows you to grant more or
fewer initial connections depending on the size of the Intelligence Server machines.

• Define the pool size for each Intelligence Server in the cluster in the Initial
pool size field. The default initial pool size is 5.

• Define the maximum pool size for the Intelligence Servers in theMaximum
pool size field. The default maximum pool size is 50.

7 Specify how jobs are balanced between Intelligence Servers in a cluster by entering a
value in the Load balance factor field. For more powerful servers in a cluster, this
value can be increased to provide an appropriate balance. A larger load balance factor
means the server supports a greater load in the server cluster in which it resides. For
example, if two servers make up a cluster, one server has a balance factor of 3 and
the other has a balance factor of 2, and 20 users log in, 12 are supported by the first
server and 8 by the second. The default Load balance factor value is 1. For detailed
information about load balancing, see Clustering in the System Administration
Guide.

8 If there is a firewall between Mobile Server and Intelligence Server, you can ensure
that the firewall does not remove connections between Mobile Server and
Intelligence Servers. To do this, select the Keep the connection alive between
the Mobile server and Intelligence Server check box. When this setting is
enabled, Mobile Server sends a signal to Intelligence Server on each open TCP
connection periodically, so that the firewall does not see the connection as idle. For
detailed information, seeMaintaining TCP/IP connections through a firewall, page
174.

9 If no authentication providers are configured for single sign-on authentication, a
Setup button is displayed next to Trust relationship between Mobile Server
and MicroStrategy Intelligence Server.

Click Setup to create a trust relationship. The Setup Trust Relationship with
MicroStrategy Intelligence Server page opens. Do the following:

a Select an authentication mode, and then enter the user name and password for
that authentication mode. For additional details about the authentication modes,
see Authentication inf the System Administration Guide.

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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b Enter the path to the Mobile Server application in theMobile Server
Application field.

c Click Create Trust Relationship.

10 Click Save. The Intelligence Server is added to the Connected Servers list. You can
connect to this server by clicking Connect.

Related topics

• Connecting to an available Intelligence Server, page 171

• Maintaining TCP/IP connections through a firewall, page 174

Connecting to an available Intelligence Server
To allow Mobile users to access reports and documents, you must connect Mobile Server
to one or more Intelligence Servers. If you or another administrator has already created
a connection from Mobile Server to an Intelligence Server in the system, you can
connect to the Intelligence Server.

Available Intelligence Servers are listed in the Unconnected servers list in the Servers
page of the Mobile Server Administrator page.

Prerequisite

• It is assumed that a connection between Mobile and Intelligence Server has already
been created by an administrator. For steps to create a new connection between
Mobile and an Intelligence Server, see Creating a new connection to Intelligence
Server, page 169.

To connect Mobile to an available Intelligence Server

1 Access the Mobile Server Administrator page:

• In Windows: Chose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select Servers.

3 In the Action column in the Unconnected servers list, click Connect for the
Intelligence Server to connect to. The Intelligence Server moves to the Connected
servers list and Mobile Server is connected to the Intelligence Server.

Related topics

• Creating a new connection to Intelligence Server, page 169
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Disconnecting from an Intelligence Server
You may need to disconnect Mobile from an Intelligence Server if, for example, you are
performing maintenance on the Mobile Server machine. Disconnecting Mobile from an
Intelligence Server disables Mobile users from accessing projects on the Intelligence
Server.

To disconnect Mobile from an Intelligence Server

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select Servers.

3 In the Action column in the Connected servers list, click Disconnect for the
Intelligence Server to disconnect from. The Intelligence Server moves to the
Disconnected servers list and Mobile is disconnected from the Intelligence Server.

Related topics

• Creating a new connection to Intelligence Server, page 169

• Connecting to an available Intelligence Server, page 171

Specifying default connection, load balance, and
timeout settings
You can specify default connection, load balance, pool size, and timeout settings for all
connections to Intelligence Servers.

These default settings can be changed for an individual server. However, certain settings
can be specified only at this default Intelligence Server level that apply to all server
connections. For example, timeout settings cannot be applied to specific Intelligence
Server connections, but can be applied to all Intelligence Server connections.

To specify default connection, load balance, and timeout settings

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.
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• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select Default properties. The Default Server
Properties page opens.

3 Select one of the following to determine when and how Mobile Server connects to
Intelligence Servers.

• To ensure that the Mobile Server automatically reconnects to Intelligence
Servers when the Mobile Server is started or restarted, select Automatically
connect to Intelligence Server when Mobile Server or Intelligence
Server is restarted.

• To ensure that the administrator must manually create a connection to
Intelligence Servers by clicking the Connect button, select the User manually
connects Mobile Server to Intelligence Server. This is the default option.

4 In the Port field, specify the default port number for all Intelligence Server
connections.

5 If the Intelligence Servers are in a cluster, you can determine the number of
connections within the "pool" of connections. The pool is the number of
connections between Mobile and the Intelligence Servers. This is defined at the
Intelligence Server level, not at the cluster level. This allows you to grant more or
fewer initial connections depending on the size of the Intelligence Server machines.

• Define the pool size for each Intelligence Server in the cluster in the Initial
pool size field. The default initial pool size is 5.

• Define the maximum pool size for the Intelligence Servers in theMaximum
pool size field. The default maximum pool size is 50.

6 Specify how jobs are balanced between Intelligence Servers in a cluster by entering a
value in the Load balance factor field. For more powerful servers in a cluster, this
value can be increased to provide an appropriate balance. A larger load balance factor
means the server supports a greater load in the server cluster in which it resides. For
example, if two servers make up a cluster, one server has a balance factor of 3 and
the other has a balance factor of 2, and 20 users log in, 12 are supported by the first
server and 8 by the second. The default Load balance factor value is 1.

7 Establish default server and request timeout settings, as follows:

• Specify the length of time (in seconds) that a Mobile request should wait for a
connection from the connection pool, if the maximum number of connections
are all busy. Enter this value in the Server busy timeout field. The default
value is 10.

• Specify the length of time (in seconds) that Mobile waits to receive a response
from Intelligence Server. Enter this value in the Request timeout field. The
default value is 40.

8 If there is a firewall between Mobile Server and Intelligence Server, you can ensure
that the firewall does not remove connections between Mobile Server and
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Intelligence Servers. To do this, select the Keep the connection alive between
the Mobile Server and Intelligence Server check box. When this setting is
enabled, Mobile Server sends a signal to Intelligence Server on each open TCP
connection periodically, so that the firewall does not see the connection as idle. For
detailed information, see Maintaining TCP/IP connections through firewalls.

9 Click Save.

Encrypting session information
You can control whether traffic between mobile devices, Mobile Server, and Intelligence
Server is encrypted. By default, this data is not encrypted because encrypting the data
increases the load on the Intelligence Server, which may result in reduced performance
in Mobile.

To determine how session information is encrypted, cached, and
stored

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select Security. The Security page opens.

3 In the Encryption area, select one of the following options:

• AES Tunneling: Uses the AES encryption algorithm to secure data between
Web and Intelligence Server.

This option increases the load on the Intelligence Server and may result in
reduced performance in MicroStrategy Web.

• SSL: Uses Secure Socket Layer (SSL) encryption to secure data between Mobile
Server and Intelligence Server. This is the recommended option for secure
communications. If you want Mobile Server to verify Intelligence Server's SSL
certificate before setting up a connection, select Validate Intelligence Server
certificate. For background information and instructions to set up SSL
encryption for Web, see the System Administration Guide.

4 Click Save.

Maintaining TCP/IP connections through a firewall
If there is a firewall between Mobile Server and Intelligence Server, the firewall may
cause the TCP connection to Mobile Server to time out after it has been idle for a length
of time. In this case, the firewall closes the connection to Mobile Server (outside the

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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firewall), but not to Intelligence Server (inside the firewall). This results in Intelligence
Server never closing the TCP connection. Eventually, Intelligence Server's connection
limit is reached, and no more connections are allowed until Intelligence Server is
restarted.

You can configure either of the following to address this potential issue:

• Put Intelligence Server and Mobile Server on the same side of the firewall.

• Configure Mobile Server to constantly refresh all TCP/IP connections with
Intelligence Server. Steps for this configuration are below.

To configure Mobile Server to keep connections alive

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select Servers.

3 In the Properties column, selectModify for the Intelligence Server connection to
edit. The Default Server Properties page opens.

4 Select the Keep the connection alive between the Mobile Server and
Intelligence server check box.

5 Click Save. Mobile Server will periodically send a signal to Intelligence Server on
each open TCP connection, so that the firewall will not identify the connection as
idle.

Enabling single sign-on authentication for Mobile
You can enable single sign-on (SSO) authentication for MicroStrategy Mobile with third-
party trusted authentication providers such as Tivoli or SiteMinder. Once a user is
authenticated in the third-party system, the user's permissions are retrieved from a user
directory, and access is granted to MicroStrategy Mobile.

Prior to enabling trusted authentication for MicroStrategy Mobile, you must complete
the initial third-party authentication setup. To create users and links in a third party
system, see the Authentication chapter in the System Administration Guide.

To enable users to log in to MicroStrategy Mobile using SSO authentication, you must
enable trusted authentication as an available authentication mode in MicroStrategy
Mobile.

To enable trusted authentication in MicroStrategy Mobile

1 Access the Mobile Server Administrator page:

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select Default properties. The Default Server
Properties page opens.

3 From the Trusted Authentication Providers drop-down list, select Tivoli or
SiteMinder. For information about adding custom authentication, see the
MicroStrategy Developer Library (MSDL).

4 At the bottom of the page, click Save.

To enable the authentication token to pass from the third-party authentication provider
to MicroStrategy Mobile, and then to Intelligence Server, a trust relationship must be
established between MicroStrategy Mobile and Intelligence Server.

To establish trust between MicroStrategy Mobile and Intelligence
Server

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select Servers.

3 Confirm that MicroStrategy Mobile Server is currently connected to an Intelligence
Server. If an Intelligence Server is not connected, in the Unconnected Servers table,
under Action, click Connect for the appropriate Intelligence Server.

4 In the Connected Servers table, under Properties, clickModify. The Server
Properties page opens.

5 Next to Trust relationship between Mobile Server and Intelligence Server, click
Setup.

6 Type aUser name and Password in the appropriate fields. The user must have
administrative privileges for MicroStrategy Mobile.

7 From the options provided, select the authentication mode used to authenticate the
administrative user.

8 In theMobile Server Application field, type the URL for MicroStrategy Mobile.
For example, you might provide the URLs for the application using Tivoli, as follows:
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https://MachineName/JunctionName/MicroStrategyMobile/a
sp

9 Click Create Trust Relationship.

10 Click Save to create the trust relationship.

For steps to verify or delete the trust relationship, see Authentication in the System
Administration Guide.

Enabling Usher authentication for Mobile
MicroStrategy Usher enables users to electronically validate identity using their Usher
badges on their smartphones. Users who have both the MicroStrategy Mobile and Usher
Security apps installed on the same device are able to submit their Usher identity to login
instead of entering a username and password. For steps to enable Usher authentication
to MicroStrategy Mobile, see “Enabling Usher authentication for Web and Mobile” in the
System Administration Guide.

Configuring and viewing logs and statistics
Logs are records of low-level activity, which can be aggregated and used for
troubleshooting a specific problem or for server and system analysis. You can determine
whether to log information such as errors, warnings, or messages generated by
MicroStrategy Mobile users, as well as statistical information such as the time taken by
the web server and Intelligence Server to complete an operation, how much data is
received and sent, the waiting time to receive data from the Intelligence Server, and so
on.

For steps, see the appropriate links below:

• Determining what and where information is logged, page 177

• Creating logs to debug API issues, page 179

• Viewing server logs, page 181

• Enabling and viewing statistics, page 182

Determining what and where information is logged
Tasks performed by MicroStrategy Mobile users may generate errors, warnings, or
messages in MicroStrategy Mobile Server. This information can be stored in log files. You
can define what information is logged by MicroStrategy Mobile and where it is logged.

To determine what and where information is logged

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select Configuration. The Diagnostics Configuration
page opens.

3 Select either Internal diagnostic setup or Custom diagnostic setup to
determine the type of log to create, as described below:

• Internal diagnostic setup: This setting is used to set the type of information
to be logged in the log file. The settings defined here are written in the
logger.properties file. This is the default option.

▫ Level: Select the level at which the information is written in the log file.
You can choose from the following levels:

— OFF: Nothing is written in the log file.

— Errors: Errors generated by Mobile are included in the log file. This is
the default option.

— Warnings: Errors and warnings generated by Mobile are included in
the log file.

— Messages: Errors, warnings, and messages generated by Mobile are
included in the log file.

▫ Log files directory: This field displays a default path where the log files
are saved. You can also specify a different path. The log file is generated in
the specified path in the MSTRmmddyyyy.log_num format. The default
directory is Program Files/MicroStrategy/Mobile Server
ASPx/WEB-INF/log/.

The naming of the log file is handled by the logger.properties file. For
example, the first log file created on 01/02/2008 appears as
MSTR01022008.log_1.

▫ Maximum output file size: The maximum size, in bytes, of the log file.
When the maximum file size is reached, a new log file is started. The default
size is 10,000,000 bytes.

▫ Number of file outputs: The maximum number of log files that
MicroStrategy Web creates. The default number of files is 100.

Logs can also be created to better identify and debug API issues. These logs are
configured in the Advanced Logger Settings area. For details and steps, see
Creating logs to debug API issues, page 179.

• Custom diagnostic setup: This option is typically used to load a
logger.properties file provided to you by MicroStrategy Technical Support. The
logger.properties file contains the internal diagnostics setup settings above. You
can load diagnostics settings contained in the file, get the output, and send it
back to Technical Support. When the Technical Support engineer is done, he or
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she can reset your log to its original settings. This allows for a very detailed level
of logging without you having to write the logger.properties file yourself.

▫ Specify the path to the logger.properties file in the Path to custom
diagnostics setup file field.

4 Click Save to apply the changes.

Creating logs to debug API issues
You can use logs to better identify and debug API issues. The logs can provide the
following information:

• Name of the class and method being accessed

• Custom messages used in the code to specify the reason why the message was logged

• All argument values sent to the method that logged the message

Using the options described below, you can determine the specific user and packages for
which errors are logged. This makes it easier to debug API issues since each log contains
unique information about a specific user, date, and package.

The logs generated by the XML-API logger are saved in different files from those
generated by the Internal Diagnostics logger. The XML-API logs are saved in the form of
AdvMSTRLog[package][date].log. In the log file name, [date] is replaced by the
current date and [package] is replaced by the name of the specific package name for
which the log exists. For details about the Internal Diagnostics logger, see Determining
what and where information is logged, page 177.

To create a log to debug API issues

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, under Diagnostics, select Configuration. The
Diagnostics Configuration page opens.

3 Select Internal diagnostic setup.

4 In the Advanced Logger Options area, select from the following options to disable or
enable the creation of XML-API logs, as well as configure how and what information
is logged.

• Disabled: When this option is selected, logs are created using only the default
settings you specify in the Internal Diagnostics options, as described in
Determining what and where information is logged, page 177. All errors,
warnings, or messages are logged to the log file you specified in the Log Files
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directory, but logs are not created for each user, date, and package combination.
This is the default option.

• Enable XML-API Logger: When this option is selected, all messages for a
particular user for all calls to the API are logged. These messages consist of any
classes that are located under the com.microstrategy.webapi package.

▫ User name: To specify that the XML-API logger only saves messages for a
specified user, enter the user's name in the text field. If you do not specify a
user, messages are logged for all users.

— When the Enable XML-API Logger option is selected, you can log
only API messages, not messages coming from a specific package or
multiple packages. To log information about specific or multiple
packages, you must select the Enable logging for multiple/other
package(s) option.

• Enable logging for multiple/other package(s): When this option is
selected, you can determine the specific packages for which logs are created.
This further refines the logging process because you can more distinctly define
which error messages are logged and for which users and packages.

▫ Package(s): To specify certain packages for which to create logs, type the
name of the package(s) in the text field. Use a comma to separate the names
of multiple packages. For example, you want to log API messages as well as
messages for an addons package. You list both of these packages by typing
the following in the text field: com.microstrategy.webapi,
com.microstrategy.web.app.addons

▫ User name: To specify that the XML-API logger saves messages only for a
specified user, type the user's name in the text field. If you do not specify a
user, messages are logged for all users.

▫ Pattern: You can limit the number of logged messages by specifying a
pattern. Only messages that match the pattern are logged. For example, you
want to log messages that are related only to methods that start with the
“getCustomLogin ” string. In this case, type ”getCustomLogin* ”.

You can create patterns using a limited set of regular expressions. For
more information about regular expressions, see
http://jakarta.apache.org/oro/api/org/apache/oro/text
/GlobCompiler.html.

▫ Level: You can specify the types of messages that are logged by selecting one
of the following options:

— Warnings: Errors and warnings are included in the log file.

— Errors: Errors are included in the log file.

— All: Errors, warnings, and messages are logged.

— OFF: Nothing is written in the log file. This is the default option.

5 Click Save to apply the changes.
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Viewing server logs
The information collected in server logs can be difficult to understand if you read it
directly from the log file itself. As an alternative to scanning a log that contains all
information collected for your system activity, you can view and filter logged information
using the View Logs page. This allows you to more easily locate and troubleshoot
application errors and the system.

The log display depends on what information is available in the log file. If the log is
empty, information from it is not displayed on the screen. For steps to set the level of
information recorded in the log file, see Determining what and where information is
logged, page 177.

To view the Mobile Server log file

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select View logs. The View logs page opens.

3 In the Display area, select the check boxes for the log information you want to
display on the View logs page:

• Errors: Logged errors are displayed on the screen. This is selected by default.

• Warnings: Logged warnings are displayed on the screen.

• Messages: Logged messages are displayed on the screen.

4 In the From area, specify the start date of logged information to display on the
screen.

5 In the To area, specify the end date of logged information to display on the screen.

If the From and To date fields contain the same date, logs are viewed for that
day only.

6 Click Refresh to display the selected log information on the View Logs page. The
logged information appears in the following columns.

• Time: The time and date when the event log was created

• User name: The name of the user who logged in

• User IP Address: The IP address of the user who logged in

• Level: Error, Warning, or Message, as above
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• Class and Method: Code references for the issue

• Message: The text of the logged message

7 To sort a column, click the Sort icon in the column's header.

Enabling and viewing statistics
You can enable statistics to interpret and analyze system and server performance and
disable them when you no longer need to monitor performance. For example, you can
obtain information about the time taken by the web server and Intelligence Server to
complete an operation, how much data is received and sent, the waiting time to receive
some data from the Intelligence Server, and so on.

You can determine what statistical information is logged to either the Mobile device or to
a text file on the Mobile Server machine.

Note the following:

• If multiple users work on the same server, displaying statistics for each
of them is not recommended, as it may impact system performance.

• If the statistics are being saved in the file, the file size grows quickly,
which is unnecessary. For this reason, this feature should not be used
unless the system is not working properly and you want to analyze the
data for system tuning or troubleshooting.

To enable statistics collection in MicroStrategy Mobile

1 Access the Mobile Server Administrator page:

• In Windows: Choose Start > Programs >MicroStrategy Tools >Mobile
Administrator. The Mobile Server Administrator web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, select Statistics. The Statistics page opens.

3 From theMode drop-down list, select where statistics are logged:

• OFF: Statistics are not displayed on the screen or saved in a file. This option is
selected by default.

• Screen: Statistics are saved to the log file on the Mobile device, at the lowest log
level.

• File: Statistics are saved in the specified log file. If selected, type the path to the
log file in the Statistics file field, including the absolute path to where the Mobile
Server is installed.
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• Screen and file: Statistics are saved in both the log file on the Mobile device
and in the specified log file. If selected, type the path to the log file in the
Statistics file field, including the absolute path to where the Mobile Server is
installed.

Deploying and configuring the MicroStrategy
Mobile application

Once you have installed and configured MicroStrategy Mobile Server, you need to install
and configure the MicroStrategy Mobile application on your company’s mobile devices.
These steps vary depending on whether you are using MicroStrategy Mobile for iPhone
or iPad, or MicroStrategy Mobile for Android.

• Deploying MicroStrategy Mobile for iPhone or iPad, page 183

• Configuring MicroStrategy Mobile for iPhone or iPad, page 186

• Deploying MicroStrategy Mobile for Android, page 194

• Configuring MicroStrategy Mobile for Android, page 194

• Configuring connectivity settings for iOS and Android devices, page 199

• Configuring the home screen for iPhone, iPad, and Android devices, page 202

• Pre-caching online content on the mobile device for offline use, page 211

• Configuring MicroStrategy Mobile for iPhone or iPad to receive push notifications,
page 213

• Applying configurations to mobile devices, page 214

• Managing multiple configurations for MicroStrategy Mobile, page 216

Deploying MicroStrategy Mobile for iPhone or iPad
For a list of supported iPhone and iPad devices and operating systems, see the
MicroStrategy Readmes.

To maintain control of your MicroStrategy Mobile implementation cycle, it is
recommended that you use the iOS Enterprise Deployment process to install the
MicroStrategy Mobile applications on your users’ devices.

The requirements and workflow for this process are described below.

Overview

The following is a high-level overview of the tasks you must perform to begin deploying
the MicroStrategy Mobile applications on your users’ devices:

• Download the MicroStrategy Mobile Xcode project.
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• Use the iOS Developer Portal to create the files you need to build the applications in
Xcode.

• Create a distributable archive of the application.

• Create a basic web page for your network, from which users can download the
application.

Prerequisites

• You must use an Apple Mac, running Xcode 4.2 or better.

• Your organization must be enrolled in the iOS Developer Enterprise Program. For
information about this program, visit
http://developer.apple.com/programs/ios/enterprise/.

• You must create an Application ID for the deployed application, using the iOS
Provisioning Portal. An Application ID is of the form
[Code].com.yourcompany.yourappname, where Code is an alphanumeric
code, called the Bundle Seed, and is generated when you create the Application ID.

If you are deploying MicroStrategy Mobile for both iPhone and iPad, you must
create an Application ID for each.

• You need a location on your network that users can access through their web
browsers, using either the HTTP or HTTPS protocol. The distributable archive must
be saved to this location.

Deploying the MicroStrategy Mobile applications

You must use Xcode to create modified versions of the MicroStrategy Mobile applications
to deploy them on your users’ devices.

The third-party products discussed below are manufactured by vendors
independent of MicroStrategy, and the information provided is subject to change.
For detailed instructions to perform the following tasks, see the iOS Developer
Library at http://developer.apple.com/library/ios/.

To build and deploy the MicroStrategy Mobile applications

To create a distribution certificate for MicroStrategy Mobile

1 In the Keychain Access utility on your Mac, use the Certification Assistant feature to
create a Certificate Signing Request (CSR) file.

2 In the iOS Provisioning Portal, in the Certificates section, request a Distribution
Certificate. When prompted, upload the CSR file you created in the previous step.

3 Once your certificate is ready, download it to your computer.
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4 Use the Keychain Access utility to install the downloaded certificate to your
computer.

This certificate authorizes your Mac as a trusted computer on the network,
and is used to sign the MicroStrategy Mobile applications for distribution.

To create a distribution Provisioning Profile for MicroStrategy Mobile

5 In the iOS Provisioning Portal, in the Provisioning section, create a Distribution
Provisioning Profile for the application.

6 Download the Provisioning Profile to your computer.

To download and install the MicroStrategy Mobile Xcode projects

7 On your Mac, download the disk image with the MicroStrategy Mobile Xcode
projects from https://software.microstrategy.com/Download/index.aspx. To do this,
select the desired version from the Version drop-down list, and then select iOS
from the OS drop-down list. The file name is
MicroStrategy Mobile SDK.dmg.

You must have a username and password to access the download site.

8 Double-click the downloaded file. A license agreement is displayed.

9 To accept the terms of the license agreement, click Agree. The disk image opens.

10 Copy the contents of the disk image to your computer, and eject the disk image.

To set up the Xcode projects

11 In the MicroStrategyMobile folder copied from the disk image, double-click
MicroStrategyMobile.xcodeproj. The MicroStrategy Mobile project opens in
Xcode.

12 Choose theMicroStrategyMobileIPhone orMicroStrategyMobileIPad
scheme, as applicable.

13 Open the property list file for the scheme you are building the application for. The
file names are Info_IPhone.plist or Info_IPad.plist for iPhone and iPad
respectively.

14 Change the Bundle Identifier property to your organization’s Bundle Identifier.

The Bundle Identifier is of the form
com.YourCompanyName.YourApplicationName, and is part of the application
ID you created in the iOS Provisioning Portal.

15 For the scheme you selected, in the Build Settings section, under Code Signing,
ensure that your distribution provisioning profile is selected.
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To build the application for distribution

16 From the Build menu, select Build and Archive. An archived version of the
application is built, with a .ipa extension.

17 Open Xcode’s Organizer window, select the archived application, and click Share
Application. The Share Archived Application dialog opens.

18 Click Distribute for Enterprise. The archive is built, and you are prompted to
enter the information for the application’s manifest file, which contains the
information that users’ devices need to download the application.

19 Enter the information for the manifest file. In the URL field, enter the web address
for the network location from which users can download the application. For
example, http://YourNetworkLocation/
MicroStrategyMobile.ipa.

Uploading and distributing the application

20 Upload the following files to your network location above:

• The application archive. For example, MicroStrategyMobile.ipa.

• The manifest file. For example, manifest.plist.

21 To distribute the application, provide users with a URL to the manifest file, using the
following syntax:

itms-services://?action=download-
manifest&url=http://YourServerLocation/ manifest.plist

You can provide this URL in an email, or by using a basic HTML page that users can
connect to.

Configuring MicroStrategy Mobile for iPhone or iPad
Before a user can view reports and documents in MicroStrategy Mobile for iPhone/iPad,
the application must be configured to communicate with Mobile Server and Intelligence
Server. Manually configuring each device can be time-consuming and difficult. Instead,
you can create a configuration.

A mobile device configuration is a list of settings for a MicroStrategy Mobile application
that are stored in a file on Mobile Server. A configuration for MicroStrategy Mobile for
iPhone/iPad contains information about the memory limit, network timeout, caching,
and error logging, as well as what projects can be accessed from the application and what
buttons are available on the home screen.

A single configuration can configure devices to connect to multiple Mobile Servers.
Users can manually connect to any available Mobile Server, if the configuration
allows them to configure the application from the mobile device. For instructions
on how to configure the application from the mobile device, see Configuring the
application from the device, page 215.
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You can create and save multiple configurations. Each configuration can have its own
login credentials, list of projects, and Home screen design. For example, you can create
one configuration for regional sales managers, providing access to only those projects
that report on sales data. You can then create another configuration for executives,
which gives them access to all projects currently in production and also provides a Home
screen with buttons for several high-level dashboards.

User logins and passwords included with a configuration should be used only for
demonstration purposes, as the configuration is not transmitted or stored securely.

Once you have created a configuration, you can generate a URL for that configuration.
You can then email that URL to a mobile device user. When the user opens the URL, the
MicroStrategy application on the mobile device is automatically configured with the
saved settings. For steps, see Configuring mobile devices using a generated URL, page
214.

To create an iPhone or iPad configuration

1 Access the Mobile Server Administrator page:

• In Windows: From the Start menu, point to Programs, thenMicroStrategy
Tools, and selectMobile Administrator. The Mobile Server Administrator
web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, selectMobile Configuration.

3 Click Define New Configuration.

4 From the Device drop-down list, select either iPhone or iPad to create a
configuration for the device. Click OK.

5 In the Configuration Name field, type the name of the configuration. This is the
name that is displayed in the configuration list.

Configure the iPhone or iPad settings

6 Select either the iPhone Settings or iPad Settings tab.

7 By default, the MicroStrategy Mobile application has a dark color theme. To change
the theme color, select Light from the Application Theme Color drop-down list.

8 To choose an accent color to highlight icons, buttons, and clickable text in
MicroStrategy Mobile, click the desired color in the Accent Color area. For
example, you can select an accent color that is used in your organization’s logo.

9 From theMemory Limit drop down list, select the amount of memory that is
available to the application. Values include 25 MB, 50 MB, 100 MB, 250 MB, 500
MB, 1 GB, 2 GB, 3 GB, or 4 GB. The application uses either this value or the
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available memory on the device, whichever is lower. Reports and documents render
faster when more memory is available to the application. The default value is 250
MB.

10 In the Network Timeout field, specify how long, in seconds, the application
should wait for the network to respond before reporting a timeout. The default value
is 60 seconds.

11 In the Acceptable Network Response Time field, specify an amount of time, in
seconds, that is acceptable for a network response. The default value is 2 seconds.

Along with the network timeout setting, this value determines the mobile server
connection quality displayed in the Network tab of the Settings screen in the iPhone
or iPad client. The Mobile Server quality is displayed as:

• A green image when network latency is less than the Acceptable Network
Response value.

• A red image when network latency is greater than the Network Timeout value.

• An orange image when the network latency is between the Network Timeout
value and the Acceptable Network Response Time value.

12 In theMaximum Columns in Grid field, specify the maximum number of
columns displayed at one time in a grid report. If the number of columns in the grid
exceeds this value, a user can scroll to see additional columns. The default value is 10
columns for iPhone and 50 columns for iPad.

13 From the Logging Level drop-down list, select the level of information to be stored
in the application's log file. You can choose from the following levels:

• Warnings: Errors and warnings generated by Mobile are included in the log
file. This is the default option.

• Errors: Errors generated by Mobile are included in the log file.

• Messages: Messages generated by Mobile are included in the log file.

• All: Warnings, errors, and messages generated by Mobile are included in the log
file.

• Off: Nothing is written in the log file.

To view the log file, in the MicroStrategy Mobile for iPhone application, from
the Settings screen, tap Advanced Settings, then, in the Logging group,
tap View Log.

14 In theMaximum log size field, specify the maximum number of entries to be
stored in the log file. The default value is 50 entries.

15 In the Check for new subscriptions every field, type how often, in seconds, the
application checks for new versions of subscribed reports and documents on
Intelligence Server. The default value is 600 seconds.

16 In the Validate device caches every field, type how often, in seconds, the
application validates the report and document caches on the device with Intelligence
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Server. This check only invalidates a cache on the device if the corresponding cache
on Intelligence Server is invalid or expired; it does not check whether any changes
have been made to the original report or document. The default value is 600
seconds.

17 Some reports and documents have the pre-caching feature enabled, but do not use
server side caching. To increase the execution performance for these objects, you can
force the application to use the local caches for a specified amount of time. To do
this, select the Cache real-time data for check box, and in the field, specify the
number of seconds that a local cache remains valid.

Note the following:

• For instructions on configuring reports, documents, or the contents of
a folder to be pre-cached, see Configuring the home screen for iPhone,
iPad, and Android devices, page 202.

• If caching for a specific report or document has been disabled, you can
still force it to use the pre-cache feature on a mobile device. To do this,
open the report or document in Developer, open the corresponding
Report Caching Options or Document Properties dialog box, and select
the Allow mobile devices to cache data temporarily to
optimize performance check box.

18 By default, the Mobile Server network response quality is measured and displayed as
a green, yellow, or red image on the mobile client. To disable this feature, clear the
Monitor Network Status check box.

19 By default, users can view and change the configuration settings in the Settings
screen in the application. To prevent users from changing the configuration settings
for the application, clear the Allow users to access advanced and
connectivity settings check box.

20 By default, if a cache exists for a subscribed report or document, that cache is loaded
when the user opens that report or document, and only for the page-by selection or
layout that is opened. This speeds up initial access to the application. To allow access
to reports and documents even when the connection to the network is intermittent,
select the Automatically pre-load subscriptions check box. If this check box is
selected, caches are loaded for all subscribed reports and documents when the
application is launched.

21 By default, MicroStrategy Mobile caches the contents of folders, and does not
refresh the folder unless the user shakes the device while in the folder screen. To
disable folder caching and to refresh folders every time that the user opens them,
clear the Cache Folders check box. This may cause Mobile to open folders more
slowly, as it must retrieve information about the folders from Intelligence Server
every time they are opened.

22 By default, reports and documents are cached on the device until either the memory
limit is reached or a newer version of the report or document is available. This allows
access to reports and documents even when the connection to the network is
intermittent. To clear the caches when the application is closed, select the Clear
caches when the application closes check box.
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23 By default, users can modify caching settings for the Mobile application. For
example, users can choose to clear or save caches when the application is closed. To
prevent users from modifying caching settings, clear the Allow users to modify
caching settings check box.

24 By default, users can modify logging settings for the Mobile application. For example,
users can select the level of detail for logged statistics. To prevent users from
modifying logging settings, clear the Allow users to modify logging settings
check box.

25 To enable push notification alerts, select the Enable Push Notification check
box. For details on configuring push notification alerts, see Configuring
MicroStrategy Mobile for iPhone or iPad to receive push notifications, page 213.

To enable push notifications, Mobile Server must be configured to use Secure
Socket Layer (SSL) encryption. For detailed instructions on configuring Mobile
Server to use SSL, see the Enabling Secure Communication chapter in the System
Administration Guide.

26 To allow MicroStrategy Mobile to download data in the background when the
application is running in the background, select the Enable Background
Download Mode check box.

The Enable Push Notification option must be selected before you enable
background downloading.

27 By default, mobile users can email, and print an image of the report or document
that they are viewing. To disable this feature, clear the Enable sharing, including
emailing, printing, and saving to photos check box.

28 By default, mobile users can annotate an image of the report or document that they
are viewing, and email a copy to their contacts. To disable this feature, clear the
Enable annotating check box.

29 If you require that your users log into your MicroStrategy projects using a passcode,
and your users have iOS devices with Apple Touch ID® enabled, they can use their
fingerprints to access the app, instead of using a passcode. To enable this feature,
enable the Allow authentication via system pass code for Touch ID check
box. To require users to log into MicroStrategy using a password, see Configure
users’ app passwords, page 192.

30 By default, PDF documents open in MicroStrategy Mobile's built-in PDF viewer. To
disable this viewer, select the Disable the built-in PDF viewer check box. If this
option is selected and the Allow users to open PDF documents in external
applications check box is selected, users are prompted to choose a third party PDF
viewer when they open a PDF document.

31 By default, Mobile users can use other applications to view PDF documents that are
generated by MicroStrategy Mobile. To disable this privilege, clear the Allow users
to open PDF documents in external applications check box.

32 By default, Keynote documents open in MicroStrategy Mobile’s built-in Keynote
viewer. To allow Mobile users to open keynote files in an external application, select
the Use external applications to open Keynote files check box. If this option

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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is selected, Mobile users are prompted to choose a third party Keynote viewer when
they open a Keynote document.

33 To ignore user privilege errors when the mobile device is reconciling, select the
Ignore user privilege errors during reconcile check box. Enable this setting
if you are creating a single Mobile configuration that includes multiple projects that
may not be accessible by all users who are using that configuration. This option
eliminates the error messages that users would normally receive for each inaccessible
project during reconciliation, and removes any associated subscriptions and caches
from the mobile device.

34 To display a log out option in the Action menu in MicroStrategy Mobile, select the
Display Log Out Option in Action Menu check box. When a Mobile user logs
out, her user name, password, and session information are removed from the device
and she is logged out of the project on the connected Intelligence Server. The Mobile
user must type her credentials to log back in to the application.

35 To clear all caches on the mobile device when a Mobile user logs out, select the
Clear Caches on Log Out check box. When the Display Log Out Option in Action
Menu option is selected, users can log out of MicroStrategy Mobile to delete caches
that have been created on the device.

36 By default, the MicroStrategy Mobile application displays a Learn More link. When
this link is tapped by a Mobile user, the mobile version of the MicroStrategy website
opens in the default web browser. You can modify the Learn More link in the
following ways.

• To change the website that opens when the Learn More link is tapped, type the
desired URL in the Custom URL field.

• To remove the Learn More link, clear the Show “Learn More” Link check
box.

37 By default, the passwords used to log in to projects and Intelligence Servers can be
saved in the MicroStrategy Mobile application. To configure the application to
remove saved passwords after a certain period of time:

a In the Clear Saved Password settings, select After.

b From the drop-down list, select whether to specify the password removal time in
Days, Hours, orMinutes.

c In the field, type the number of days, hours, or minutes before the saved
passwords are removed from the application. The timer counts from when the
user types a password, or, if the password is included as part of a configuration,
from when the configuration is applied. Once a password is removed, the user
must type the password the next time the login dialog appears.

38 By default, the configuration used on the device is not updated automatically. To
enable the mobile device to check the Mobile Server for updates to the configuration
at a specified time interval:

a In the Check and update configuration settings, select Every.

b From the drop-down list, select whether to specify the time interval in Days or
Hours.
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c In the field, type the number of days or hours that must pass between each
check for updates. The MicroStrategy Mobile application checks for an update to
the Mobile configuration at this specified interval. If an update is found, the user
is prompted to apply the new configuration to the mobile device. The user can
then choose to apply the new configuration or wait to apply the configuration at
a later time. If the user selects the latter option, the prompt reappears five
minutes later.

39 To set up client authentication for Mobile Server, select the Use Certificate
Server check box. With this option selected, you can set up a client certificate
server responsible for creating certificates for mobile clients. These certificates are
required from mobile clients attempting to access the Mobile Server.

To specify the certificate server, type the certificate server’s URL in the Use
Certificate Server text field. This field must begin with https:// and requires
the use of the fully qualified name of the certificate server in the URL, as in the
following examples.

ASP:

https://fully_qualified_domain_name:port/
CertificateServer/asp/certificate.aspx

JSP:

https://fully_qualified_domain_name:port/
CertificateServer

or

https://fully_qualified_domain_name:port/
CertificateServer/servlet/certificate

where:

• fully_qualified_domain_name:port is the location and port of your
certificate server. For example, machine_name.domain.com:8443.

For detailed steps on configuring a certificate server, see Client authentication with a
certificate server, page 164.

40 If a mobile device has an invalid certificate, it can still run reports and documents
that are cached on the device. To clear the device cache when a certificate becomes
invalid, select the Clear caches when certificate becomes invalid check box.

Configure users’ app passwords

41 To specify requirements for the passwords that Mobile users enter to gain access to
the Mobile application, use the following settings under App Password Options:

a To require Mobile users to type a password to open the application, select the
Require password to open the application check box.
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b To require Mobile users to type a password to open the application after the
mobile device is unlocked, select the Require password after locking the
device check box.

c To require at least one numeric character in the password, select the Requires
at least one numeric character check box.

d To require at least one special character in the password, select the Requires
at least one special character ($, @, %...) check box.

e To require at least one capital letter in the password, select the Requires at
least one capital letter check box.

f To specify a minimum number of characters for the password, type the desired
number, in characters, in theMinimum passcode length text box. The
default value is 4 characters.

g To specify a maximum number of failed login attempts before a user is locked
out of the Mobile application, type the desired maximum number in the
Maximum number of failed logon attempts text box. If the maximum is
met, all data is wiped, including caches and the mobile app configuration. The
default value is 10 attempts.

h To specify how long a user has to wait to try again after he enters an incorrect
passcode, type the desired amount of time, in seconds, in the Lockout
duration text box. The default value is 0 seconds.

i To specify the amount of inactive time that must elapse before a password
request appears on the mobile device, type the desired number of seconds in the
Require password on resuming application after text box. The user is
required to re-enter valid credentials when the MicroStrategy Mobile application
is resumed after being inactive for the specified period of time.

The MicroStrategy Mobile application is considered inactive if it is running in
the background, if other applications are running in the foreground, or if the
mobile device is locked.

j If your users have configured their iOS devices to unlock using a numeric or
alphanumeric password, you can allow them to use the same password to access
MicroStrategy Mobile. On newer iOS devices such as the iPhone 6, users can
access the app by scanning a fingerprint and using Apple Touch ID. To enable
this feature, enable the Authenticate using iOS device passcode check
box.

Configure the connectivity settings

42 Click the Connectivity Settings tab to configure the connectivity settings for your
iPhone or iPad. For instructions on configuring the connectivity settings, see
Configuring connectivity settings for iOS and Android devices, page 199.
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Configure the home screen settings

43 Click theHome Screen tab to configure the appearance of the home screen in the
Mobile application. For detailed instructions on configuring the home screen, see
Configuring the home screen for iPhone, iPad, and Android devices, page 202.

Save and distribute the Mobile configuration

44 When you are finished creating the configuration, click Save.

45 Generate a URL for the configuration, and distribute it to your Mobile users. For
detailed instructions on generating and distributing a URL, see Configuring mobile
devices using a generated URL, page 214.

Deploying MicroStrategy Mobile for Android
For a list of supported Android devices and operating systems, see the MicroStrategy
Readmes.

To deploy MicroStrategy Mobile to users’ Android devices, you can send the application
as an email attachment to your users. The application is installed when the users
download the attachment.

Configuring MicroStrategy Mobile for Android
Before a user can view reports and documents in MicroStrategy Mobile for iPhone/iPad,
the application must be configured to communicate with Mobile Server and Intelligence
Server. Manually configuring each device can be time-consuming and difficult. Instead,
you can create a configuration.

A mobile device configuration is a list of settings for a MicroStrategy Mobile application
that are stored in a file on Mobile Server. A configuration for MicroStrategy Mobile for
Android contains information about the memory limit, network timeout, caching, and
error logging, as well as what projects can be accessed from the application and what
buttons are available on the home screen. For details on configuring push notification
alerts, see Configuring MicroStrategy Mobile for Android to receive push notifications,
page 217.

A single configuration can configure devices to connect to multiple Mobile Servers.
Users can manually connect to any available Mobile Server, if the configuration
allows them to configure the application from the mobile device. For instructions
on how to configure the application from the mobile device, see Configuring the
application from the device, page 215.

You can create and save multiple configurations. Each configuration can have its own
login credentials, list of projects, and Home screen design. For example, you can create
one configuration for regional sales managers, providing access to only those projects
that report on sales data. You can then create another configuration for executives,
which gives them access to all projects currently in production and also provides a Home
screen with buttons for several high-level dashboards.
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User logins and passwords included with a configuration should be used only for
demonstration purposes, as the configuration is not transmitted or stored securely.

For information on the requirements to support the Map widget on Android devices,
refer to theMicroStrategy Readme.

Once you have created a configuration, you can generate a URL for that configuration,
and then post that URL to an HTML page. Mobile users can use their mobile devices to
browse to the HTML site and click on the URL. When a user opens the URL on her
mobile device, the application is automatically configured using the settings in the
configuration. For steps, see Configuring mobile devices using a generated URL, page
214.

To create an Android Phone or Android Tablet configuration

1 Access the Mobile Server Administrator page:

• In Windows: From the Start menu, point to Programs, thenMicroStrategy
Tools, and selectMobile Administrator. The Mobile Server Administrator
web page opens.

• In UNIX/Linux: After you deploy MicroStrategy Mobile Server Universal and log
on to the mstrMobileAdmin servlet using proper credentials, the Mobile
Server Administrator web page opens. The default location of the Administrator
servlet varies depending on the platform that you are using.

2 From the pane on the left, selectMobile Configuration.

3 Click Define New Configuration.

4 From the Device drop-down list, select either Android Phone or Android
Tablet to create a configuration for the device. Click OK.

5 In the Configuration Name field, type the name of the configuration. This is the
name that is displayed in the configuration list.

Configure the Android Phone or Android Tablet settings

6 Select either the Phone Settings or Tablet Settings tab.

7 In the Network Timeout field, specify how long, in seconds, the application
should wait for the network to respond before reporting a timeout. The default value
is 60 seconds.

8 In theMaximum Columns in Grid field, specify the maximum number of
columns displayed at one time in a grid report. If the number of columns in the grid
exceeds this value, the user can scroll to see additional columns. The default value is
10 columns for Android phones and 50 columns for Android tablets.

9 In the Refresh data and submit pending transactions every field, type how
often, in seconds, the application should validate the report and document caches on
the device with Intelligence Server and upload any pending transactions. This check
only invalidates a cache on the device if the corresponding cache on Intelligence
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Server is invalid or expired; it does not check whether any changes have been made
to the original report or document. The default value is every 600 seconds.

10 Some reports and documents have the pre-caching feature enabled, but do not use
server side caching. To increase the execution performance for these objects, you can
force the application to use the local caches for a specified amount of time. To do
this, select the Cache real-time data for check box, and in the field, specify the
number of seconds that a local cache remains valid. For instructions on configuring
reports, documents, or the contents of a folder to be pre-cached, see Configuring the
home screen for iPhone and Android Phone, page 205 or Configuring the home
screen for iPad or Android Tablet, page 209.

If caching for a specific report or document has been disabled, you can still
force it to use the pre-cache feature on a mobile device. To do this, open the
report or document in Developer, open the corresponding Report Caching
Options or Document Properties dialog box, and click the Allow mobile
devices to cache data temporarily to optimize performance check
box.

11 To check for and download subscription updates in the background, select the
Enable background syncing check box. When this option is selected, the mobile
device checks for updates and downloads subscriptions at the specified interval, even
if the MicroStrategy Mobile application is not running on the device. To specify the
subscription update interval, do one of the following.

• To update subscriptions on the device every 1, 2, 4, 10, or 24 hours, select the
interval from the Update subscriptions every drop-down list.

• To update subscriptions on the device at the same time each day, select 24 hours
from the Update subscriptions every drop-down list, and then select the
desired time from the Time of the day for update drop-down list.

12 By default, the Mobile Server network response quality is measured and displayed as
a green, yellow, or red image on the mobile client. To disable this feature, clear the
Monitor Network Status check box.

13 By default, users can view and change the configuration settings in the Settings
screen in the application. To prevent users from changing the configuration settings
for the application, clear the Allow users to access settings check box.

14 By default, if a cache exists for a subscribed report or document, that cache is loaded
when the user opens that report or document, and only for the page-by selection or
layout that is opened. This speeds up initial access to the application. To allow access
to reports and documents even when the connection to the network is intermittent,
select the Automatically pre-load subscriptions check box. If this check box is
selected, caches are loaded for all subscribed reports and documents when the
application is launched.

15 By default, MicroStrategy Mobile caches the contents of folders, and does not
refresh the folder unless the user shakes the device while in the folder screen. To
disable folder caching and to refresh folders every time that the user opens them,
clear the Cache folders check box. Clearing this option may cause Mobile to open
folders more slowly, as it must retrieve information about the folders from
Intelligence Server every time they are opened.
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16 By default, reports and documents are cached on the device until either the memory
limit is reached or a newer version of the report or document is available. This allows
access to reports and documents even when the connection to the network is
intermittent. To clear the caches when the application is closed, select the Clear
caches when the application closes check box.

17 By default, users can modify caching settings for the Mobile application. For
example, users can choose to clear or save caches when the application is closed. To
prevent users from modifying caching settings, clear the Allow users to modify
caching settings check box.

18 To prevent users from sharing images of documents from the MicroStrategy Mobile
application, clear the Allow users to share document screenshots check box.
When this option is disabled, Mobile users cannot access the Share and Annotate
features.

19 By default, the MicroStrategy Mobile application displays a Learn More link. When
this link is tapped by a Mobile user, the mobile version of the MicroStrategy website
opens in the default web browser. You can modify the Learn More link in the
following ways.

• To change the website that opens when the Learn More link is tapped, type the
desired URL in the Custom URL field.

• To remove the Learn More link, clear the Show “Learn More” link check
box.

20 By default, the configuration used on the device is not updated automatically. To
enable the mobile device to check the Mobile Server for updates to the configuration
at a specified time interval:

a In the Check and update configuration settings, select Every.

b From the drop-down list, select whether to specify the time interval in Days or
Hours.

c In the field, type the number of days or hours that must pass between each
check for updates. The MicroStrategy Mobile application checks for an update to
the Mobile configuration at this specified interval. If an update is found, the user
is prompted to apply the new configuration to the mobile device. The user can
then choose to apply the new configuration or wait for a later time. If the user
selects the latter option, the prompt reappears five minutes later.

21 To set up client authentication for Mobile Server, select the Use Certificate
Server check box. With this option selected, you can set up a client certificate
server responsible for creating certificates for mobile clients. These certificates are
required from mobile clients attempting to access the Mobile Server. To specify the
certificate server, type the certificate server’s URL in the Use Certificate Server
text field. This field must begin with https:// and requires the use of the fully
qualified name of the certificate server in the URL, as in the following examples.

ASP:

https://fully_qualified_domain_name:port/
CertificateServer/asp/certificate.aspx

JSP:
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https://fully_qualified_domain_name:port/
CertificateServer

or

https://fully_qualified_domain_name:port/
CertificateServer/servlet/certificate

where:

• fully_qualified_domain_name:port is the location and port of your
certificate server. For example, machine_name.domain.com:8443.

For detailed instructions on configuring a certificate server, see Client authentication
with a certificate server, page 164.

Configuring passcode and encryption options

22 To require users to enter a password to access the application, and to enable the
encryption of caches on their mobile devices, select the Requires passcode
(required for Data Encryption) check box. When this option is selected, a
Mobile user must create a password the first time that she opens the Mobile
application. The user is then prompted for the password each time that she attempts
to open the application.

Mobile device caches are encrypted only if the Requires Passcode check box is
selected.

23 To require Mobile users to type a password to open the application after the mobile
device is unlocked, select the Require password after locking the device
check box.

24 To specify requirements for the passwords that Mobile users enter to gain access to
the Mobile application, use the following settings under Encryption options:

a To require at least one numeric character in the password, select the Requires
at least one numeric character check box.

b To require at least one special character in the password, select the Requires
at least one special character ($, @, %...) check box.

c To require at least one capital letter in the password, select the Requires at
least one capital letter check box.

d To specify a minimum number of characters for the password, type the number,
in characters, in theMinimum passcode length text box. The default value is
4 characters.

e To specify a maximum number of failed login attempts before a user is locked
out of the Mobile application, type the maximum number in theMaximum
number of failed logon attempts text box. If the maximum is met, all data
is wiped, including caches and the mobile app configuration. The default value is
10 attempts.
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f To specify how long a user has to wait to try again after he enters an incorrect
passcode, type the amount of time, in seconds, in the Lockout duration text
box. The default value is 0 seconds.

g To specify the amount of inactive time that must elapse before a password
request appears on the mobile device, type the number of seconds in the
Require password on resuming application after text box. The user is
required to re-enter valid credentials when the MicroStrategy Mobile application
is resumed after being inactive for the specified period of time.

The MicroStrategy Mobile application is considered inactive if it is running in
the background, if other applications are running in the foreground, or if the
mobile device is locked.

25 To continue the mobile configuration, click the Connectivity Settings tab. For
detailed instructions on configuring connectivity settings, see Configuring
connectivity settings for iOS and Android devices, page 199.

Configuring connectivity settings for iOS and Android
devices
To configure mobile devices to communicate with Mobile Server and provide access to
projects, you must provide connection and authentication information. Configure the
connection and authentication information for your Mobile Server(s) and project(s) in
the Connectivity Settings tab of the Mobile Configuration.

Configure the connectivity settings

1 From the Mobile Configuration, select the Connectivity Settings tab.

2 By default, user logins and passwords can be cached on the mobile device for a
specified period of time. To stop credentials from caching on mobile devices, select
the Never Persist Credentials check box. When this option is selected, a user is
required to log in when she completely closes and reopens MicroStrategy Mobile. To
completely close MicroStrategy Mobile, the user must also close the background task
for the application on her device. This option is available for iPhone, iPad, and
Android devices.

3 Under Default Mobile Server Authentication, specify the default Mobile Server
authentication settings.

a From the Authentication Mode drop-down list, select the default
authentication mode to use to log in to the Mobile Server machine.

▫ For iOS devices, to use a trusted authentication provider such as Tivoli or
SiteMinder, you must choose Basic and enter your credentials for the
trusted authentication provider.

▫ The default mode is Anonymous.

▫ For Android, to use trusted authentication as the default authentication
mode, you must use basic authentication.
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▫ If you are using HTML forms for trusted authentication with the iPhone or
iPad, you can choose Anonymous, Basic, or Windows as the default Mobile
Server authentication mode.

b For basic or Windows authentication, in the Login field, type the user name. To
use basic authentication with a trusted authentication provider, type your trusted
authentication provider login.

c For basic or Windows authentication, in the Password field, type the password
for the login. To use basic authentication with a trusted authentication provider,
type your trusted authentication provider password.

d For basic or Windows authentication, you can override login credentials that
users may have specified on their mobile devices. To do this, select the
Overwrite user-specified credentials when applying configuration
check box.

e For integrated authentication, ensure that you have configured integrated
authentication for your MicroStrategy environment. For steps to configure
integrated authentication, see the System Administration Guide.

4 Click Configure New Mobile Server.

5 In theMobile Server Name field, type the fully qualified host name of this
machine. This is the Mobile Server that the application will connect to.

• For iOS devices, if you are using trusted authentication, in this field, type the
URL that is monitored by your trusted authentication provider. For example, if
you are using Tivoli for trusted authentication, type http://tivoli_
machine:port/junctionName/. For additional information on trusted
authentication, see the System Administration Guide.

• If you are using trusted authentication, in this field, type the name of the trusted
authentication provider machine.

6 If mobile clients must use a different name to access the Mobile Server, select the
Mobile clients access this server using the following external name
check box, and type the name in the field. For example, type the externally accessible
name of a load balancer in machine-name.domain.com format.

7 In theMobile Server port field, type the port number that is used by Mobile
Server on this machine. The default port is 80.

8 In theMobile Server path field, type the path to the MicroStrategy Mobile Server
files on this machine. The default path is MicroStrategyMobile.

9 From theMobile Server type drop-down list, select ASP.NET for MicroStrategy
Mobile, or J2EE for MicroStrategy Mobile Universal. ASP.NET is selected by
default.

10 From the Request type drop-down list, specify whether the mobile devices use
HTTP (no encryption) orHTTPS (HTTP encryption) to access the Mobile Server.
For more information about HTTP and HTTPS and instructions on configuring
Secure Sockets Layer (SSL), see SSL encryption, page 164. For information on
encrypting traffic to Mobile Server, see Encrypting session information, page 174.
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You must decide whether to configure your Mobile Server to use SSL prior to
creating mobile configurations. If you attempt to implement SSL on your
Mobile Server after creating mobile configurations, you will not be able to
update any configuration that has a Request Type of HTTP.

11 The default Mobile Server authentication settings specified above are used to log in to
the Mobile Server. To use different login credentials, clear the Use default
authentication check box and specify the Mobile Server authentication settings:

a From the Authentication mode drop-down list, select the default
authentication mode to use to log in to the Mobile Server machine. For iOS
devices, to use a trusted authentication provider such as Tivoli or SiteMinder,
you must choose Basic and enter your credentials for the trusted authentication
provider.

▫ If you are using HTML forms for trusted authentication with the iPhone or
iPad, you can choose Anonymous, Basic, or Windows as the Mobile Server
authentication mode.

▫ Anonymous authentication is selected by default.

▫ For Android, to use trusted authentication, you must use basic
authentication.

b For basic or Windows authentication, in the Login field, type the user name. To
use basic authentication with a trusted authentication provider, type your trusted
authentication provider login.

c For basic or Windows authentication, in the Password field, type the password
for the login. To use basic authentication with a trusted authentication provider,
type your trusted authentication provider password.

d For basic or Windows authentication, you can override login credentials that a
user may have specified on their mobile device. To do this, select the Overwrite
user-specified credentials when applying configuration check box.

12 Under Default Project Authentication, specify the default project authentication
settings.

a From the Authentication mode drop-down list, select the type of
authentication used by the Intelligence Server. Standard authentication is
selected by default.

If you select Trusted Authentication or Windows Authentication, the
Login and Password fields are disabled. For iOS devices, to use trusted
authentication you must supply your trusted authentication provider
credentials in the Mobile Server Authentication section above.

b In the Login field, type the MicroStrategy user name to be used by the
application to log in to the Intelligence Server.

c In the Password field, type the password for that user name.

d For standard, LDAP, and database authentication, you can override login
credentials that a user may have specified on their mobile device. To do this,
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select the Overwrite user-specified credentials when applying
configuration check box.

Configure a project

13 Configure a project that contains reports and documents intended to be viewed on
the mobile device:

a Click Configure New Project.

b Select the project from the Project Name drop-down list.

c The default project authentication settings specified above are used to log in to
the project. To use different login credentials, clear the Use Default
Authentication check box and specify the project authentication settings.

d To specify a root folder, other than the project’s default, select the Use root
folder check box. Click the down arrow to select the root folder.

e Designate whether the login is case-sensitive by selecting or clearing the User
login is case-sensitive check box.

14 To configure another project, click Configure New Project. Enter the
information for this project.

15 To configure another Mobile Server, click Configure New Mobile Server. Enter
the information for this Mobile Server.

Add a trusted certificate for SSL encryption for Android devices

16 If you are using SSL encryption for communication between Android devices and
Mobile Server, you must specify the location of your trusted certificate. A certificate
is required for secure client authentication with the Mobile Server. To add a new
certificate, click Add New Certificate and enter the URL for the certificate in the
Trusted Certificates text box.

The URL for the trusted certificates must be accessible from the Android
devices.

Configuring the home screen for iPhone, iPad, and
Android devices
You can specify whether the user is presented with the default MicroStrategy Mobile
home screen, a folder or report that you specify, or a custom home screen when they
open the MicroStrategy Mobile application. To do this, configure the settings in the
Home Screen tab of the Mobile Configuration.

Configure the home screen

1 From the Mobile Configuration, select theHome Screen tab.
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2 To display the default MicroStrategy Mobile home screen when the application is
started, select Display the default home screen. The default home screen
contains buttons for Shared Library, Reports, Settings, and Help.

3 To display the contents of a folder when the application is started:

a Select Display the contents of a folder.

b Click the down arrow next to the Object field. A dialog box opens.

c From the Project drop-down list, select the project that contains the folder you
want to display. This must be a project that the configuration has been granted
access to on the Connectivity Settings tab.

d In the User name and Password fields, type the user name and password to
log in to the project.

e Browse to the folder and click Current folder. The dialog box closes and the
browse folder is specified in the field. This is the root folder where the Mobile
user begins browsing for reports and documents.

f By default, Mobile Server checks for a cached subscription when a Mobile user
selects a report or document from the browse folder. To execute the report or
document without checking for a cached subscription, clear the Check
subscription check box. Disabling this option ensures that reports and
documents are updated, but this execution requires more time than displaying
cached subscriptions.

g You can configure the application to cache and preload the contents of a folder
in the background when the application reconciles. This feature creates a faster
response time for the contents of the desired folder, and allows you to cache
objects on the mobile device without requiring users to manually execute them.
To enable cache preloading, select the Pre-cache contents at startup check
box.

To increase the execution performance of pre-cached objects that do not have
server side caching enabled, specify an appropriate amount of time for local
caches to remain valid. To do this, enter the amount of time in the Cache
real-time data for field in the iPhone Settings, iPad Settings, Phone
Settings, or Tablet Settings tab. For detailed instructions on configuring this
option, see Configuring MicroStrategy Mobile for iPhone or iPad, page 186
or Configuring MicroStrategy Mobile for Android, page 194.

4 To create a customized home screen, select Display a custom home screen.
Specify the options for each button. For detailed instructions on how to create a
custom home screen, see Creating a custom home screen, page 203.

5 Click Save. The configuration is saved.

Creating a custom home screen

When you create a configuration for MicroStrategy Mobile, you can choose to display a
report or document on the home screen, customize the application's home screen, or use
the default home screen.
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• Displaying a single report or document as the home screen, page 204

• Configuring the home screen for iPhone and Android Phone, page 205

• Configuring the home screen for iPad or Android Tablet, page 209

Displaying a single report or document as the home screen

You can customize the home screen to displays a single report or document when the
application is started. To improve the start up performance of this report or document,
configure it to pre-cache.

To display a single report or document when the application starts

1 Select Display a custom home screen.

2 Select Display a report or document.

3 Click the down arrow. A project login dialog box opens.

4 From the Project drop-down list, select the project that contains the folder you
want to display. This must be a project that the configuration has been granted
access to on the Connectivity Settings tab.

5 In the User name and Password fields, type the user name and password to log
in to the project.

6 Browse to the report or document and select it. The dialog box closes and the report
or document is specified in the field.

Pre-caching reports, documents, and supporting objects

7 You can configure the application to cache and preload a report or document and its
supporting objects folder in the background when the application reconciles. This
feature creates a faster response time for the report or document you choose to
display at startup.

To increase the execution performance of pre-cached objects that do not have
server side caching enabled, specify an appropriate amount of time for local
caches to remain valid. To do this, enter the amount of time in the Cache
real-time data for field in the iPhone, iPad, Phone, or Tablet Settings tab.
For detailed instructions on configuring this option, see Configuring
MicroStrategy Mobile for iPhone or iPad, page 186 or Configuring
MicroStrategy Mobile for Android, page 194.

8 To enable cache preloading for a report or document, click +.

9 From the Action drop-down list, select Run report or document.

10 From the Object drop-down list, select the desired report or document.
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11 From the Include a folder of supporting objects drop-down list, select a folder
that includes supporting objects for your report or document. The contents of this
folder are pre-cached at startup.

Pre-caching a folder of supporting objects

12 To enable cache preloading for a folder, click +.

13 From the Action drop-down list, select Browse folder.

14 From the Root drop-down list, select the desired folder. The contents of this folder
are pre-cached at startup.

15 To execute the report or document without checking for a cached subscription, clear
the Check subscription check box.

You can also pre-cache online content. For steps, see Pre-caching online
content on the mobile device for offline use, page 211.

Displaying a progress bar for subscriptions and pre-caching

16 On the iPhone or iPad, if the home screen is a report or document, you can display a
progress bar along the bottom of the screen to measure the progress for subscription
synchronization and pre-caching. To do this, select Display a progress bar for
subscriptions synchronization and pre-caching. By default, the progress bar
is displayed in gray. To change the color of the progress bar, click the Color drop-
down list and select the desired color.

17 Click Save to save and close the configuration.

Configuring the home screen for iPhone and Android Phone

The default home screen for MicroStrategy Mobile on iPhone and Android Phone
includes the following buttons:

• Shared Library: Opens the Projects screen, which displays a list of all projects
that the device has been configured to access.

• Settings: Opens the Settings screen. If the Allow users to access Settings
check box (in the iPhone Settings tab) is cleared, the Settings screen displays
version information and the status of the application. If this check box is selected,
the Settings screen also displays configuration settings such as the memory limit.

• Help: Opens the Help for the application.

You can configure the home screen to display the contents of a folder, or a single report
or document.

You can also customize the home screen to display a set of custom buttons. Each button
can perform one of the following actions:

• Run a report or document

• Browse a specific folder
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• List the projects available in the application

• List all reports or documents the user has subscribed to

• Open the Settings screen

• Open the Help for the application

Depending on how many buttons you define, the buttons are arranged as follows:

• If the home screen has one to four buttons, the buttons are arranged in one column
of four rows.

• If the home screen has five or six buttons, the buttons are arranged in two columns
of three rows.

• If the home screen has seven to nine buttons, the buttons are arranged in three
columns of three rows.

• If the home screen has more than nine buttons, the buttons are arranged in multiple
pages. Each page contains three columns of three rows of buttons.

To create a custom home screen for iPhone or Android Phone

1 On theMobile Configuration page (accessible from theMobile Administrator
page), define a new configuration, or modify an existing configuration. For
instructions on how to define a new configuration, see Configuring MicroStrategy
Mobile for iPhone or iPad, page 186 or Configuring MicroStrategy Mobile for
Android, page 194.

2 Select theHome Screen tab.

3 Select Display a custom home screen.

4 Select Display a custom list of folders, documents, or reports. A preview
of the custom home screen is displayed on the left, and the customization options
are displayed on the right.

Define the buttons

5 Select a button in the preview.

6 From the Buttons drop-down list, select Action.

7 From the Action drop-down list, specify the action that you want the button to
take:

• Run report or document: Executes a specific report or document. To specify
the report or document, click the arrow next to Object, select the project
containing the report or document, log in, and browse to the report or
document. To create faster response times on iPhone by pre-caching the
document or report in the background when the application starts, select the
Pre-cache contents at startup check box. To pre-cache the supporting
objects for the report or document on iPhone or Android Phone, select the
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desired folder from the Include a folder of supporting objects drop-down
list.

To increase the execution performance of pre-cached objects that do not
have server side caching enabled, specify an appropriate amount of time
for local caches to remain valid. To do this, enter the amount of time in
the Cache real-time data for field in the iPhone Settings or Phone
Settings tab. For detailed instructions on configuring this option, see
Configuring MicroStrategy Mobile for iPhone or iPad, page 186 or
Configuring MicroStrategy Mobile for Android, page 194.

• Browse folder: Opens a specific folder. To specify the folder, click the arrow
next to Root, select the project containing the folder, log in and browse to the
folder.

You can allow MicroStrategy Mobile for iPhone users to browse folders
made available over the web through the WebDAV protocol. To do this,
you must create an External Mobile Folder and specify it as a Browse
Folder. For detailed steps to create an External Mobile Folder, see the
Advanced Reporting Guide.

By default, Mobile Server checks for a cached subscription when a Mobile user
selects a report or document from the browse folder. To execute the report or
document without checking for a cached subscription, clear the Check
subscription check box. Disabling this option ensures that reports and
documents are updated, but this execution requires more time than displaying
cached subscriptions.

To create faster response times on iPhone or Android Phone by pre-caching the
folder in the background when the application starts, select the Pre-cache
contents at startup check box.

To increase the execution performance of pre-cached objects that do not
have server side caching enabled, specify an appropriate amount of time
for local caches to remain valid. To do this, enter the amount of time in
the Cache real-time data for field in the iPhone Settings or Phone
Settings tab. For detailed instructions on configuring this option, see
Configuring MicroStrategy Mobile for iPhone or iPad, page 186 or
Configuring MicroStrategy Mobile for Android, page 194.

• Go to Reports: Opens the Reports screen on the iPhone, which displays the
reports and documents the user has subscribed to.

• Go to Subscriptions: Opens the Subscriptions screen on Android phones,
which displays the reports and document the user has subscribed to.

• Go to Settings: Opens the Settings screen. If the Allow users to access
Settings check box (in the iPhone Settings or Phone Settings tab of the
Mobile Configuration page) is cleared, the Settings screen displays version
information and the status of the application. If this check box is selected, the
Settings screen also displays configuration settings such as the memory limit.
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• Go to Shared Library: Opens the Shared Library screen, which displays a list
of all projects that the device has been configured to access.

• Go to Help: Opens the Help for the application.

8 From the Buttons drop-down list, select Caption.

9 In the Caption field, type the text to be displayed on the button.

10 In the Description field, type any notes about the button. This field is only for
reference within the configuration, and is not visible to the user.

11 To change the image used for the button's icon:

a From the Buttons drop-down list, select Icon.

b Select Use my own.

c In the Image URL field, specify the location of the image to use as the icon for
the button.

12 To add a new button, click Add a button. The button is displayed in the preview.

13 To delete a button, select the button and click Remove a button.

Configure the button display

14 From the Format drop-down list, select Button Style.

15 From the Border Color color picker, select the color used in the outline of the
button.

16 From the Fill Color color picker, select the color used in the background of the
button.

17 From the Font Color color picker, select the color of the font used in the button
captions.

18 From the Style drop-down list, select the style to apply to the buttons:

• Glass: Same as Flat, but with a gloss applied on top of the background and icon.

• Flat: The Border Color and Fill Color properties (see below) define a
background for the button. The active area of the button includes the icon and
the background.

• None: No background is used. The only active area of the button is the icon
itself. The Border Color and Fill Color properties (see below) are ignored
when this style is selected.

Specify the background

19 From the Format drop-down list, select Background.

20 To set the background to a specific color, select Fill Color and, from the color
picker, select that color.
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21 To use a custom image as the background, select Image, and specify the location of
the image in the Image URL field.

The image must be no larger than 320 pixels wide and 416 pixels high.

Configure the title bar

22 From the Format drop-down list, select Title Bar.

23 To specify text to be displayed in the title bar, select Caption and, in the field, type
the text to be displayed. MicroStrategy Mobile is displayed by default.

24 To display an image as the title bar on the iPhone, select Image URL and, in the
text field, specify the location of the image.

The image must be no larger than 232 pixels wide and 44 pixels high.

25 When you are ready to save the custom Home screen with the configuration, click
Save. The configuration and the custom home screen are saved.

Configuring the home screen for iPad or Android Tablet

The default home screen for MicroStrategy Mobile on iPad and Android Tablet displays
all projects that the device has been configured to access. In the menu bar it displays the
following options:

• Home or Shared Library: Displays the list of projects.

• Enable Reports Tab or Enable Subscriptions Tab: Displays the reports and
documents the user has subscribed to.

On the iPad, the application also has an in the upper right. Tapping on iPad or

hitting the menu button on an Android tablet brings up a menu with the following
options:

• Settings: Displays version information and the status of the application. If the
Allow users to access Settings check box (in the iPad Settings or Tablet
Settings tab of the Mobile Configuration page) is selected, the Settings screen also
displays configuration settings such as the memory limit.

• Help: Displays the Help for the application.

You can configure the home screen to display the contents of a folder, or a single report
or document. You can also customize the home screen to display a set of custom buttons.
These buttons are displayed in a list. Each button can perform one of the following
actions:

• Run a report or document

• List the reports or documents in a folder

• List the projects available in the application
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To create a custom home screen for iPad or Android Tablet

1 In theMobile Administrator home page, in theMobile Configuration page,
define a new configuration, or modify an existing configuration. For instructions on
how to define a new configuration, see Configuring MicroStrategy Mobile for
iPhone or iPad, page 186 or Configuring MicroStrategy Mobile for Android, page
194.

2 Select theHome Screen tab.

3 Select Display a custom home screen.

4 Select Display a custom list of folders, documents, or reports. A preview
of the custom home screen is displayed on the left, and the customization options
are displayed on the right.

Define the buttons

5 Select a button in the preview.

6 From the Action drop-down list, specify the action that you want the button to
take:

• Run report or document: Execute a specific report or document. To specify
the report or document, click the arrow next to the Object field, select the
project containing the report or document, and browse to the report or
document. To create faster response times on iPad or Android Tablet by pre-
caching the document or report in the background when the application starts,
select the Pre-cache contents at startup check box. To pre-cache the
supporting objects for the report or document, select the desired folder from the
Include a folder of supporting objects drop-down list.

To ensure that pre-cached objects are used by the application, select the
Cache real-time data for check box in the iPad Settings or Tablet
Settings tab. For detailed instructions on configuring this option, see
Configuring MicroStrategy Mobile for iPhone or iPad, page 186 or
Configuring MicroStrategy Mobile for Android, page 194.

• Browse folder: Open a specific folder. To specify the folder, click the arrow
next to the Root field, select the project containing the folder, and browse to
the folder.

You can allow MicroStrategy Mobile for iPad users to browse folders made
available over the web through the WebDAV protocol. To do this, you
must create an External Mobile Folder and specify it as a Browse Folder.
For detailed steps to create an External Mobile Folder, see the Advanced
Reporting Guide.

By default, Mobile Server checks for a cached subscription when a Mobile user
selects a report or document from the browse folder. To execute the report or
document without checking for a cached subscription, clear the Check
subscription check box. Disabling this option ensures that reports and
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documents are updated, but this execution requires more time than displaying
cached subscriptions.

To create faster response times by pre-caching the folder in the background
when the application starts, select the Pre-cache contents at startup check
box.

To ensure that pre-cached objects are used by the application, select the
Cache real-time data for check box in the iPad or Tablet Settings tab.
For detailed instructions on configuring this option, see Configuring
MicroStrategy Mobile for iPhone or iPad, page 186 or Configuring
MicroStrategy Mobile for Android, page 194.

• Go to Shared Library: Open the Shared Library screen, which displays a list
of all projects that the device has been configured to access.

7 To add a new button, click Add a button. The button is displayed in the preview.

8 To delete a button, select the button and click Remove a button.

9 To move a button up or down in the display, select the button and clickMove down
orMove up.

Specify the contents of the home screen selector

10 Select the check box next to each item that you want to appear in the Home screen:

• Enable reports tab: On the iPad, adds a Reports tab to the home screen,
which displays the reports and documents the user has subscribed to.

• Enable subscriptions tab: On Android tablets, adds a Subscriptions tab to
the home screen, which displays the reports and documents the user has
subscribed to.

• Settings: Adds Settings to the menu on the iPad or the menu button on

an Android tablet. Tapping Settings displays version information and the status
of the application. If the Allow users to access Settings check box (in the
iPad Settings or Tablet Settings tab of the Mobile Configuration page) is
selected, the Settings screen also displays configuration settings such as the
memory limit.

• Help: Adds Help to the menu on the iPad or the menu button on an

Android tablet. TappingHelp displays the Help for the application.

11 When you are ready to save the custom home screen with the configuration, click
Save. The configuration and the custom home screen are saved.

Pre-caching online content on the mobile device for
offline use
You can pre-cache online content, such as videos or files, on a mobile device, which
allows a user to view the content when the device is offline.
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For example, when a user views a streaming video on a mobile device using the Video
Player widget, the streaming video is buffered and played as it downloads. By default, the
downloaded video file is discarded when the MicroStrategy Mobile application is closed.

You can ensure that the video is downloaded and stored on the mobile device for offline
use. To do so, you must provide a WebDAV folder that contains the video, and define the
appropriate settings to have the contents of the folder pre-cached, as described in the
steps below.

If the video is downloaded instead of streamed, pre-caching downloads the video before
the user requests it. This allows a faster response time.

Prerequisites

• Create an External Mobile Folder to browse the contents of the WebDAV folder that
contains your video or other content. For detailed steps, see the Advanced Reporting
Guide.

• Create the document that contains the content to be pre-cached. For example, if you
are pre-caching a video, you can create a document with a Video Player widget that
displays either of the following on an iPhone or iPad:

▫ A streaming video which provides the location of the video file using the
Alternate Download URL setting.

▫ A downloaded video which provides the location of the video file using the Video
URL setting.

For detailed information and steps to create a Video Player widget, see Downloading
and playing videos: Video Player widget, page 128.

To store content on the mobile device for offline use

1 In Mobile Administrator, clickMobile Configuration from the left. Define a new
configuration, or select the existing configuration that you want to modify. For steps
to define a new configuration, see Configuring MicroStrategy Mobile for iPhone or
iPad, page 186 or Configuring MicroStrategy Mobile for Android, page 194.

2 On theHome Screen tab, select Display a custom home screen.

3 Select the appropriate settings to define the External Mobile Folder as a folder of
supporting objects for the document and pre-cache its contents. For detailed steps,
see the appropriate link below:

• If you have defined the mobile configuration to display a single report or
document when the application starts, see To display a single report or
document when the application starts, page 204.

• If you have defined the mobile configuration to display a custom list of folders,
documents, or reports when the application starts on the iPhone, see To create
a custom home screen for iPhone or Android Phone, page 206.

• If you have defined the mobile configuration to display a custom list of folders,
documents, or reports when the application starts on the iPad, see To create a
custom home screen for iPad or Android Tablet, page 210.



Mobile Design and Administration Guide

© 2017, MicroStrategy Inc. 213

Configuring MicroStrategy Mobile for iPhone or iPad to
receive push notifications
You can use alert-based subscriptions to ensure that users automatically receive
notifications on an iPhone or iPad with MicroStrategy Mobile when a metric on a report
meets specific threshold conditions. You can create an alert-based subscription using the
Alerts Editor in Web. For information on creating alert-based subscriptions, see the
MicroStrategy Web Help.

These alerts are “pushed” to MicroStrategy Mobile for iPhone or iPad by Intelligence
Server. For information on how these push notifications are displayed on the device, see
theMicroStrategy Mobile Analysis Guide.

The following high-level procedure provides steps to enable push notifications for
MicroStrategy Mobile on an iPhone or iPad.

Prerequisites

• MicroStrategy delivers alert notifications through the Apple Push Notification
Service (APNS). Therefore, you must have an Apple iOS developer license to send
mobile push notifications. For information about the various iOS developer licenses
available, see http://developer.apple.com/programs/.

• Your Intelligence Server machine must have a direct internet connection to the
Apple Push Notification Service (APNS).

• You must have MicroStrategy Distribution Services to use push notifications with
MicroStrategy. For information about purchasing a Distribution Services license,
contact your MicroStrategy account executive.

• Push notifications must be enabled on an iPhone or iPad for the device to receive
MicroStrategy push notifications. In addition, the first time MicroStrategy Mobile for
iPhone or iPad is opened on a device, the user is prompted to allow the application to
receive push notifications.

• To enable push notifications, Mobile Server must be configured to use Secure Socket
Layer (SSL) encryption. For detailed instructions on configuring Mobile Server to use
SSL, see the Enabling Secure Communication chapter in the System Administration
Guide.

High-level steps to enable MicroStrategy push notifications for iPhone
or iPad

1 Install the APNS certificate on the Intelligence Server machine that provides the
push notifications. For instructions, see the documentation provided with your iOS
developer license.

2 In Developer, create a Distribution Services device for iPhone or iPad. For detailed
instructions, see the Scheduling Jobs and Administrative Tasks chapter in the
System Administration Guide, or see the Developer Help (formerly the
MicroStrategy Desktop Help).

http://developer.apple.com/programs/
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3 Create a configuration for the application (see Configuring MicroStrategy Mobile
for iPhone or iPad, page 186). In the iPhone Settings or iPad Settings tab of
the configuration, make sure that you select the Enable Push Notification check
box.

4 The first time the user opens MicroStrategy Mobile for iPhone or iPad on a device,
the user is prompted to allow push notifications for MicroStrategy Mobile. The user
must select Allow push notifications.

Applying configurations to mobile devices
Once you have created a configuration for a mobile device, you need to apply that
configuration to the device. You can:

• Generate a URL for the configuration, then email the link to users or create an
HTML page containing the link. When users tap the URL on their mobile device, the
configuration is automatically applied to the device. For steps, see Configuring
mobile devices using a generated URL, page 214.

• Configure MicroStrategy Mobile for iPhone, iPad, and Android through the Settings
screen in the application. For steps, see Configuring the application from the device,
page 215.

Configuring mobile devices using a generated URL

You can quickly and easily apply a configuration to a mobile device using a URL, as
follows:

• Email the URL to your mobile device users. When these users tap the URL in the
email client on their mobile device, the configuration is automatically applied to the
device. This option is available for iOS users.

• Create an HTML page that includes the URLs as links. When users tap the URL in
the HTML page using the browser on their mobile device, the configuration is
automatically applied to the device. To email the link to Android users, you must
create a short link. This option is available for Android users.

Steps to generate a mobile configuration URL are provided below.

User logins and passwords included with a configuration should be used only for
demonstration purposes, as the configuration is not transmitted or stored securely.

To generate a URL for a configuration

1 In the MicroStrategy Mobile Server page, from the pane on the left, selectMobile
Configuration.

2 For the configuration you want to generate a link for, click Generate URL. A
Generate Configuration URL dialog box opens.

3 In the Server Name field, type the fully qualified host name of the machine
hosting the Mobile Server that the configuration is stored on.
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If you are using trusted authentication, in this field, type the name of the
trusted authentication provider machine.

4 By default, the port number used by Mobile Server is included in the URL. If you do
not want to include the port number in the URL, clear the Include port check
box.

5 If you are including the port number in the URL, select the Include port check
box, and in the text box next to it, type the port number used by Mobile Server. The
default is 80.

6 By default, the request type is set to HTTP. If you are using a secure connection,
selectHTTPS from the Request Type drop-down list.

7 From the Authentication Mode drop-down list, select an authentication mode.
When the user taps the URL, she will have to provide a username and password to
log in to Mobile Server using this authentication mode.

8 For Android devices, you must shorten the configuration URL before you insert it as
a clickable link in an email. To do this, click Use Short URL.

9 To generate the URL, click Generate URL. The URL is generated and displayed in
the dialog box. You can then copy and paste the URL into an email for iPhone and
iPad users. For Android users, you can insert the link into an HTML page and
instruct users to click on the appropriate link using the browser on their Android
devices, or you can email a short URL.

10 To save the URL settings, click Save. The Generate Configuration URL dialog box
closes, and the authentication mode and host are saved for the next time you
generate a URL for this configuration.

Configuring the application from the device

You can also configure MicroStrategy Mobile for iPhone, iPad, and Android through the
Settings screen in the application. You need to add the connection information for the
MicroStrategy Mobile server, and then configure the projects that you want to receive
reports from, as described in the procedures below.

If you have applied a configuration to the device and that configuration does not
allow users to view or change the device settings, you will not be able to configure
the application from your device. Contact your system administrator if you need to
change your configuration settings.

To configure MicroStrategy Mobile on an iPhone, iPad, or Android
device

1 Open the Settings screen:

• On an iPhone, tap the Settings button.
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• On an iPad, tap and then tap Settings.

• On Android, tap the menu button , then tap Settings.

Depending on your configuration, you may not be able to access the Settings
screen, or you may only be able to view the About MicroStrategy Mobile
information.

2 To configure an existing server, tap the server name or IP address. To add a new
server, tap Add Mobile Server. Specify the settings for the server as described in
Configure the connectivity settings, page 199.

3 To configure the application settings, tap Advanced Settings. Specify the settings
for the application as described in Configure the iPhone or iPad settings, page 187 or
Configuring MicroStrategy Mobile for Android, page 194.

Downloading a client certificate from the certificate server

4 Click Get Certificate.

5 In the Authentication screen, log in using your MicroStrategy login and password.
The certificate will download and display in the Advanced Settings screen.

6 To exit the settings screen and return to the Home screen, tapHome.

Managing multiple configurations for MicroStrategy
Mobile
To see all configurations that have been saved on this Mobile Server, select the Mobile
Configuration category in the Mobile Server Administrator page.

To rename a configuration, click the name of the configuration. Type the new name for
the configuration and press ENTER.

From the Actions column, you can manage your configurations:

• To modify an existing configuration, clickModify. The configuration opens, and you
can make any changes. For instructions, see the appropriate link below:

▫ Configuring MicroStrategy Mobile for iPhone or iPad, page 186

▫ Configuring MicroStrategy Mobile for Android, page 194

• To copy a configuration, click Duplicate. A copy of that configuration is created
with the name "Copy of <configuration>" and added to the end of the list. You can
then modify this copy by clickingModify.

• To generate a URL for a configuration, click Generate URL. A Generate URL
dialog box opens.

• To delete a configuration, click Delete.

• To create a new configuration, click Define New Configuration.
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Configuring MicroStrategy Mobile for Android to
receive push notifications
You can use alert-based subscriptions to ensure that users automatically receive
notifications on an Android device with MicroStrategy Mobile when a metric on a report
meets specific threshold conditions. You can create an alert-based subscription using the
Alerts Editor in Web. For information on creating alert-based subscriptions, see the
MicroStrategy Web Help.

These alerts are “pushed” to MicroStrategy Mobile for Android by Intelligence Server.
For information about how these push notifications are displayed on the device, see the
MicroStrategy Mobile Analysis Guide.

Prerequisites

• MicroStrategy delivers alert notifications through the Google Cloud Message (GCM),
which is a free service that enables developers to send messages between servers and
client applications. For some customizations, you may need an API key obtained
from Google Play Console.

• Your Intelligence Server must be able to connect to Google Cloud Message service
either with direct connect or through a proxy, which can be configured through
Developer.

• You must have MicroStrategy Distribution Services to use push notifications with
MicroStrategy. For information about purchasing a Distribution Services license,
contact your MicroStrategy account executive.

• Push notifications must be enabled on an Android device to receive MicroStrategy
push notifications. In addition, the first time MicroStrategy Mobile for Android is
opened on a device, the user is prompted to allow the application to receive push
notifications.

• To enable security, it is recommended that Mobile Server be configured to use Secure
Socket Layer (SSL) encryption. For detailed instructions on configuring Mobile
Server to use SSL, see the Enabling Secure Communication chapter in the System
Administration Guide.

• Your Android device must have Google Play service.

High-level steps to set up Android Alert Push Notification Environment

1 Open MicroStrategy Developer settings for Intelligence Server:

a From the Administrator menu select Delivery Message.

b Select Devices.

c Create a device withMobile Client Android as shown in the image below.

https://www2.microstrategy.com/producthelp/10.7/manuals/en/MobileAnalysis.pdf
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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▫ In the Package Name field enter your Android application identity. (For out of
the box build users, use the default name. For customized application user
provide the package name.)

▫ Under the Google Cloud Messaging Services section, for IP Address and Port
Number fields use the default values that display automatically.

▫ In the Authorization Key field enter the Application Programming
Interface Key obtained from Google Developer Console. (For out of the
box build user, use the default value. For customized application users provide
the package name.)

▫ The Collapse Key field displays empty by default. (This parameter identifies a
group of messages that can be collapsed in a way that only the last message gets
sent when delivery is resumed. This is intended to avoid sending duplicates of
the same message when the device comes back online or becomes active.)

▫ The Delay While Idle field defaults to "False." (When this parameter is set to
"True", it indicates that the message should not be sent until the device becomes
active.)

▫ In the Notification Active For (in hours) field indicate how long the message
should be kept Google Cloud Message Storage if the device is offline. (The
maximum time to live supported is 4 weeks. Since this amount is measured in
seconds the default value appears as 1 hour.)
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▫ The Google Cloud Message Proxy field is optional. If Intelligence Server
cannot communicate with Google Cloud Messaging then select the check box
and enter the IP Address of the proxy server.

2 Create Alert Subscription for Android device in Web Server:

a From Report menu select Alert.

b SelectMobile Notification. The Alert Editor dialogue box opens.

c Select Android as the Device Type and enter the newly created device
name as Target Application.

3 OpenMobile Configuration settings for Mobile Server and select the Enable
push notification check box.
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4 Apply the mobile configuration on Android device. Once the alert is triggered, user
receives alert subscription through the Android device.

How to receive notification through Customized Application

1 Open Android Studio and create a new SDK project.

2 Select a configuration file to add to the new SDK project. The configuration file
provides service-specific information for the application.

▫ To obtain the configuration file, select an existing project for the application or
create new.

▫ A package name for the application must also be provided. (For more
information please refer to the Google Developer Help.)

3 Download google-services.json and copy into the application.

4 Compile and distribute application.

High-level steps to enable MicroStrategy push notifications for Android

1 In MicroStrategy Developer, create a Distribution Services device for Android. For
detailed instructions, see the Scheduling Jobs and Administrative Tasks chapter in
the System Administration Guide, or see the Developer Help.

2 Create a configuration for the application. In Android Settings tab of the
configuration, make sure that you select the Enable Push Notification check box.

https://developers.google.com/cloud-messaging/android/client#get-config
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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3 The first time you open MicroStrategy Mobile for Android on a device, the user is
prompted to allow push notifications for MicroStrategy Mobile. The user must select
Allow push notifications.

The Mobile subscription workflow
There are three steps in the MicroStrategy Mobile subscription workflow. These steps,
detailed below, explain how Mobile retrieves a report from Intelligence Server:

• First, a subscription to the report is created. Any prompts are answered, and the
scheduled event or time is set. Subscriptions can be created by an administrator or
Mobile user in MicroStrategy Developer or Command Manager.

For more information about how an administrator schedules a report to be delivered,
see Scheduling the report or document, page 221.

For more information about how a user subscribes to a report or document from
their device, see theMicroStrategy Mobile Analysis Guide.

• Second, the report is executed when the scheduled event or time is triggered. Upon
execution of the report, the new report cache is sent to the MicroStrategy history
list. For more information, see Executing the report on Intelligence Server, page
221.

• Finally, the user retrieves the report from Mobile Server, and it is available on the
user’s mobile device. For more information, see Retrieving the report in
MicroStrategy Mobile, page 222.

For background information on data security in MicroStrategy Mobile, see Data security
in Mobile, page 222.

Scheduling the report or document
The Mobile user or an administrator selects the reports or dashboard-style documents to
be viewed in MicroStrategy Mobile. They then schedule these reports for delivery to
Mobile, and answers any prompts in the reports. For instructions on scheduling report
subscriptions for Mobile, seeManaging Mobile report subscriptions, page 222.

In addition, the Mobile user schedules an update time window for the mobile device to
automatically retrieve the reports. For instructions, see the section on choosing when to
update the Report List in the MicroStrategy Mobile Analysis Guide.

Executing the report on Intelligence Server
When the schedule associated with a report is triggered, that report is executed by
Intelligence Server. The report is then sent to the History List, to reduce the load on
Intelligence Server. For a detailed explanation of the History List, see the Caching
chapter in the System Administration Guide.

Reports available in Mobile are only updated when the associated schedule is triggered.
In particular, editing the report through MicroStrategy Web or Developer does not
update the report’s History List message. If you are concerned that Mobile users may not

https://www2.microstrategy.com/producthelp/10.7/manuals/en/MobileAnalysis.pdf
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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have the most recent version of a report, you should either update the History List
message, or inform the users that they need to reset that report.

If the user has made changes to the report on the Mobile device and saved those
changes, any changes made to the report in MicroStrategy Web or Developer are
not applied to the report on the Mobile device until the user resets the report.

Retrieving the report in MicroStrategy Mobile
Once a report has been sent to the History List, it is available on Mobile Server. Mobile
then retrieves the report from the server, either during its scheduled update time or
during a manual update. To schedule when reports are retrieved from Mobile Server, and
to retrieve reports immediately, see the MicroStrategy Mobile Analysis Guide.

Mobile retrieves reports from Mobile Server by report ID (a unique 32-character
identifier) and report type. Graph reports are stored on the mobile device as JPG image
files. Other types of reports are compressed to roughly one-tenth their original size, using
LZW compression. This keeps the memory footprint of each individual report as small as
possible, and also reduces the amount of bandwidth that the reports use during
reconciliation.

In MicroStrategy Mobile for iPhone, iPad, or Android, the administrator can control
how much memory is available for use by reports in theMemory Limit setting in the
device configuration. For instructions on changing this setting, see Configuring
MicroStrategy Mobile for iPhone or iPad, page 186 or Configuring MicroStrategy
Mobile for Android, page 194.

Data security in Mobile
The data in the reports and documents that you view on your mobile device is secured by
MicroStrategy. This means that the data you can view and work with is controlled by the
same security mechanisms that control access to the data in other MicroStrategy
products and components. Security settings can limit your data access to specific
projects, certain reports within a project, the ability to use specific objects on reports,
and how you can explore some data. If you have any questions about any data you expect
to be able to access but cannot, see your MicroStrategy administrator.

MicroStrategy also secures the data in your reports and documents by ensuring that
other applications on your mobile device cannot access it.

Managing Mobile report subscriptions
To receive reports and dashboard-style documents on a mobile device, the device’s user
must be subscribed to those reports. Each Mobile subscription is associated with a
MicroStrategy schedule that controls how often the report or document is updated. For
detailed information about schedules and subscriptions, including instructions on how to
create schedules, see the Scheduling Jobs and Administrative Tasks chapter in the
System Administration Guide.

https://www2.microstrategy.com/producthelp/10.7/manuals/en/MobileAnalysis.pdf
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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Before you subscribe

Note the following when you configure MicroStrategy Mobile subscriptions, either for
yourself or for other users:

• To view reports in the MicroStrategy Mobile application, users must have the Use
MicroStrategy Mobile privilege for all projects containing reports they want to view.

• To view dashboard-style documents in MicroStrategy Mobile, users must have the
Mobile View Documents privilege for all projects containing documents they want to
view.

• When subscribing a user to a report, be certain that the user has the proper
permissions to view the report and the objects it contains.

For additional information about report and report object permissions in the
MicroStrategy security model, see the Setting Up User Security chapter in the
System Administration Guide.

• MicroStrategy has a number of recommended best practices for designing reports to
be viewed in MicroStrategy Mobile. Reports designed according to these best
practices load quickly and are easy to read on mobile devices. For a list of these best
practices, see Chapter 2, Designing Reports and Documents for Mobile Devices.

See the appropriate link below:

• Managing subscriptions, page 223

• Managing multiple subscriptions at once with Developer, page 224

• Managing subscriptions using Command Manager, page 229

• Managing your subscriptions through MicroStrategy Web, page 229

• Managing subscriptions in MicroStrategy Developer, page 231

• Managing subscriptions with Newsstand for the iPhone and iPad, page 232

Managing subscriptions
Both administrators and MicroStrategy Mobile users can manage subscriptions in
Mobile. There are several different ways to manage MicroStrategy Mobile report and
document subscriptions:

• Subscribing multiple users

You can subscribe multiple users to reports or documents in MicroStrategy
Developer. The Subscription Manager allows you to manage all the subscriptions for
a project from one interface. For specific information about how to manage Mobile
subscriptions using Developer, seeManaging multiple subscriptions at once with
Developer, page 224.

• Using MicroStrategy Command Manager

You can use MicroStrategy Command Manager to manage any number of
subscriptions. Command Manager is a script-based tool for administering

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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MicroStrategy systems. For specific information about how to manage Mobile
subscriptions using Command Manager, seeManaging subscriptions using
Command Manager, page 229. For general information about Command Manager,
including detailed instructions, see the Automating Administrative Tasks with
Command Manager chapter in the System Administration Guide, or see the Help
for Command Manager.

• Individual users managing personal subscriptions

▫ In MicroStrategy Web

Individual users can manage their subscriptions in MicroStrategy Web. For
specific information about managing individual MicroStrategy Mobile
subscriptions, including how to subscribe to reports, seeManaging your
subscriptions through MicroStrategy Web, page 229. For general information
about managing subscriptions using MicroStrategy Web, see the MicroStrategy
Web Help.

▫ In MicroStrategy Developer

Individual users can manage their subscriptions through MicroStrategy
Developer. Specifically, the Subscription Wizard offers users a way to subscribe
to multiple reports simultaneously, without having to open each individual
report. Users can also subscribe to individual reports by using the report’s
Properties page. For specific information about managing individual
MicroStrategy Mobile subscriptions in Developer, including how to subscribe to
reports, seeManaging subscriptions in MicroStrategy Developer, page 231. For
general information about managing subscriptions using MicroStrategy
Developer, see the MicroStrategy Web Help .

▫ In MicroStrategy Mobile

Individual users can manage their subscriptions on their mobile devices. They
can subscribe to any report or document that they have access to, answer
prompts, and define the schedule or event that will determine when the report
or document is sent to the device. Users can also edit their existing subscriptions
on their device. For specific information about editing and subscribing to reports
and documents on a mobile device, see the MicroStrategy Mobile Analysis Guide.

Managing multiple subscriptions at once with
Developer
The Subscription Manager allows you to manage all the subscriptions for a project from
one interface. It is a convenient, central location that displays every subscription, and
allows you to filter on various criteria.

To access the Subscription Manager, log in to Developer and expand Administration,
then Configuration Managers, and then select Subscriptions. For detailed
information about the Subscription Manager, see theMicroStrategy Developer Help.

In Developer, the administrator can subscribe multiple MicroStrategy Mobile users to a
single report at once, or subscribe a single user to multiple reports by using the
Subscription Creation Wizard.

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/WebUser/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/manuals/en/MobileAnalysis.pdf
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For more information about using the Subscription Creation Wizard, refer to the
MicroStrategy Developer Help.

To subscribe one or more users to one or more reports

1 From the Administrationmenu, point to Scheduling and then select
Subscription Creation Wizard. The Subscription Wizard opens.

2 Review the information on the Introduction dialog box and click Next. The Specify
Characteristics dialog box opens, as shown below:

3 From the Choose a project from which reports/documents will be
delivered to the recipients drop-down list, select the project that contains the
reports that you want to create a subscription to.

4 From the Choose a delivery type drop-down list, selectMobile to send the
report directly to the Mobile device, select Cache Update to update server side
caches for reports and documents that use the pre-caching feature, or select
History List to deliver the report to a Mobile device using the History List.

Use cache update subscriptions to update server side caches for your pre-
cached reports and documents. For instructions on configuring the pre-cache
option for reports and documents, see Configuring the home screen for
iPhone and Android Phone, page 205 or Configuring the home screen for
iPad or Android Tablet, page 209.

5 Click Next. The Choose Reports/Documents dialog box opens, as shown below:
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6 Browse to the reports/documents to be delivered and click the right arrow to add
them to the Selected objects. Click Next.

7 Answer any prompts for the selected reports/documents.

You cannot schedule reports with prompts unless the report has default
answers.

8 Click Next. The Choose Recipients dialog box opens, as shown below:
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9 From the Schedule drop-down list, select the schedule to execute the
reports/documents.

10 Click To... to open the Select Recipients dialog box, as shown below:

11 Browse to the recipients of the subscription and click the right arrow > to add them
to the Selected recipients. Click OK to return to the Subscription Wizard -
Choose Recipients dialog box.

12 If you are creating a history list subscription for a document, choose the form of
export to generate from the Pre-generate export drop-down list. The options for
this setting are an HTML page, a PDF document, or an Excel spreadsheet.

13 If you are creating a Mobile delivery, from theMobile device type drop-down list,
choose Phone or Tablet.

14 If you are creating a cache update subscription for pre-cached reports and
documents, select either Phone or Tablet from the Delivery Format drop-down
list.

15 To send the report to the selected recipients immediately after creating the
subscription, select the Run subscription immediately check box.

16 Click Next. The Specify Subscription Properties dialog box opens, as shown below:
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17 Specify your subscription properties as follows:

Depending on the reports or documents selected, one or more options may be
grayed out and unavailable. For details on these options and when they are
available, see the System Administration Guide.

• To configure a date when the subscription will stop sending reports, select the
Expire subscription on check box and select a date.

• If you are creating a History List delivery, you can have an automated delivery
notification email sent when the report is delivered. To do this, select the Send
notification to default email address of each recipient check box.

• If you are creating a History List delivery, to ensure that previous versions of the
report in the recipients’ delivery location are replaced with the most recent
version, select the The new scheduled report will overwrite older
versions of itself check box. If this check box is not selected, the older
versions remain.

• To ignore any existing report or document caches and ensure that the report or
document always has the latest data, select the Re-run against the
warehouse check box.

• To update History List caches and not Matching caches, select the Do not
create or update matching caches check box. For an explanation of
Matching and History caches, see the Caching chapter of the System
Administration Guide.

18 Click Next. The Summary dialog box opens.

19 Review the settings and click Finish. The subscription is created and available for
viewing in the Subscription Manager.
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Managing subscriptions using Command Manager
MicroStrategy Command Manager is a script-based tool for automating Intelligence
Server administration. You can compose Command Manager scripts to manage user
subscriptions. In some situations this may be more efficient than navigating the
Developer GUI, since you can quickly change the names of reports, users, or projects
with Command Manager scripts.

To configure subscriptions with Command Manager, you must have the Use Command
Manager privilege.

To start Command Manager, from the Start menu point to Programs, then
MicroStrategy Products, and select Command Manager.

The Command Manager statement syntax for creating a mobile subscription is:

CREATE MOBILESUBSCRIPTION subscription_name [FOR OWNER
login_name] SCHEDULE schedule_name USER user_name
CONTENT report_or_document_name IN FOLDER location_name
IN PROJECT project_name [OVERWRITEOLDERVERSION
(TRUE|FALSE)] [EXPIRATIONDATE mm/dd/yyyy] [RUNFRESH
(TRUE|FALSE)] [CREATEUPDATECACHE (TRUE|FALSE)]
[MODIFICATIONBYRECIPIENTS (TRUE|FALSE)];

For more information about Command Manager, including detailed instructions, see the
Automating Administrative Tasks with Command Manager chapter in the System
Administration Guide, or see the Help for Command Manager.

Managing your subscriptions through MicroStrategy
Web
There are a variety of ways to manage your MicroStrategy Mobile subscriptions using
MicroStrategy Web.

MicroStrategy Web’s subscription interface enables you to subscribe to a new report or
document, or to unsubscribe from a report or document that you no longer need to view.
You can also change the update schedule for a subscription. Finally, you can change the
prompt answers for a report or document that is delivered to your mobile device. See the
following sections for procedures:

• To subscribe to a report or document in MicroStrategy Web, page 230

• To unsubscribe from a report, page 230

• To change the update schedule for a subscription in MicroStrategy Web, page 230

• To change the personalized prompt answers for a report or document, page 231

To manage your Mobile subscriptions through MicroStrategy Web, you must have the
Web Scheduled Reports privilege as well as the Use MicroStrategy Mobile privilege. In
addition, to subscribe to a document you must have the Mobile View Document privilege.
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To subscribe to a report or document in MicroStrategy Web

1 Open the report or document in MicroStrategy Web.

2 Answer any prompts that the report or document contains and click Run Report.

Your answers to the prompts are saved and used to personalize your subscription to
that report or document. To change these answers later, open the report or
document again and, from the Data menu, select Re-prompt.

3 From theHome menu, point to Subscribe to, and then selectMobile. The
Subscribe to Mobile dialog box opens.

4 Type a name for the subscription in the Name text field.

5 Select a schedule or event from the Schedule drop-down list.

6 Click To to choose the subscription recipients.

7 Choose the subscription device from the Device type drop-down list.

8 To run the subscription immediately following its creation, select the Run
subscription immediately check box.

9 To choose an end date for the subscription, expand Advanced Options, select the
Do not deliver after check box, and click the Calendar drop-down menu to
choose a date.

10 Click OK. The Subscribe to Mobile dialog box closes.

11 To verify that you are subscribed to the report or document, at the top of the page,
clickMy Subscriptions. Note that the report appears in your list of subscriptions,
in the Mobile Subscriptions section.

To unsubscribe from a report

1 Open MicroStrategy Web and log into a project.

2 At the top of the page, clickMy Subscriptions. The Subscriptions screen opens,
with a list of all your subscriptions for that project.

3 In the Unsubscribe column, select the check box for any reports that you no
longer want to receive on your mobile device.

4 Click Unsubscribe. Any selected reports are removed from your subscription list.

To change the update schedule for a subscription in MicroStrategy
Web

1 Open MicroStrategy Web and log into a project.
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2 At the top of the page, clickMy Subscriptions. The Subscriptions page opens,
with a list of all your subscriptions for that project.

3 In the Action column, click Edit for the subscription you want to edit. The Edit
Subscription page for that subscription opens.

4 From the drop-down list, select the new schedule.

5 Click OK. The Edit Subscription dialog box closes.

To change the personalized prompt answers for a report or document

1 Open the report or document in MicroStrategy Web.

2 From the Data menu, select Re-prompt.

3 Answer the prompts in the report or document.

4 When you are satisfied with your prompt answers, click Run Report. The report
executes with your prompt answers, and your answers are saved and used to
personalize your subscription to the report.

Managing subscriptions in MicroStrategy Developer
You can manage your subscriptions to individual reports. Steps for these procedures are
below.

To manage subscriptions in bulk, and for steps to use the command line tool Command
Manager, see the System Administration Guide.

To manage your Mobile subscriptions through MicroStrategy Developer, you must have
the Use Developer privilege as well as the Use MicroStrategy Mobile privilege. In
addition, to subscribe to a document you must have the Mobile View Document privilege.

To unsubscribe from a report or document delivery, you must either have created the
subscription originally (you are the owner of the subscription), or else the creator must
have selected Allow Unsubscribe when she created the subscription. If neither of
these is true, then only an administrator or the subscription’s owner can unsubscribe
users from the report/document delivery.

To subscribe to a single report or document

1 In Developer, right-click the report/document, select Schedule delivery to, and
selectMobile.

2 Type the name of the subscription in the Name text field.

3 Select the schedule that you want the report/document to be delivered based on, by
selecting it from the drop-down list.

4 Click To to choose the subscription recipients.

5 Select the desired mobile device from theMobile device type drop-down list.
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6 To run the subscription immediately following its creation, select the Run
subscription immediately check box.

7 Click OK. The dialog box closes.

To unsubscribe from a single report or document

1 In Developer, from the Tools menu, selectMy Subscriptions.

2 Right-click the subscription and select Unsubscribe.

If the Unsubscribe option is not available, the subscription can only be deleted
by the subscription’s owner or by an administrator.

3 Confirm that you want to delete the subscription by clicking Yes. The subscription is
deleted.

Managing subscriptions with Newsstand for the iPhone
and iPad
For iPhone and iPad, using the MicroStrategy SDK, you can configure your
MicroStrategy Mobile application to use the Newsstand feature in iOS. By delivering
subscriptions through Newsstand, you can schedule deliveries at off-peak hours. These
subscriptions are downloaded to iPhones and iPads even if the MicroStrategy Mobile
application is not running on the mobile device.

To use the Newsstand feature in iOS, you must configure MicroStrategy Mobile to receive
push notifications, as described in Configuring MicroStrategy Mobile for iPhone or iPad
to receive push notifications, page 213.

For procedures on compiling the MicroStrategy Mobile application as a Newsstand
application, see theMicroStrategy Developer Library.

You can perform the following administrative tasks to manage Newsstand subscriptions:

• Mobile clients create connections with Intelligence Server to download Newsstand
subscriptions. To allow these connections to stay open during downloads,
Intelligence Server allows a specific amount of idle time during the connections. To
modify the idle time limit, adjust theMobile Newsstand session idle time
setting in the Governing Rules dialog box (in the Intelligence Server Configuration
Editor). For detailed instructions on modifying Intelligence Server governing rules,
see the System Administration Guide.

• When a Newsstand subscription is ready to be downloaded, a push notification is
sent to the Newsstand application on the recipient’s mobile device. You can schedule
an administration task to send Newsstand push notifications at a specific time of day.
For detailed procedures on scheduling administration tasks, see the System
Administration Guide.

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
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Customizing error messages for mobile devices
Mobile administrators can customize error messages originating from Intelligence
Server. Use this custom error message feature to:

• Provide alternate, less technical, and app-specific text

• Include administrator contact information

• Translate error message text

This feature is for customizing error messages originating from Intelligence Server. The
Mobile server performs the following general workflow when an error is received from
Intelligence Server:

1 The Mobile server verifies whether the error code is configured in the
mobileErrors.xml file on the Mobile server. If the error code is configured in the
mobileErrors.xml file, the Mobile server passes the customized message to the
mobile app. To configure an error code in the mobileErrors.xml file, see To
customize error messages for mobile devices (from Intelligence Server)

For a list of the out-of-the-box error message defined in the mobileErrors.xml
file, see Default mobileErrors.xml.

2 If the error code is not configured in the mobileErrors.xml file, the Mobile server
verifies whether the Override unhandled Intelligence Server error
messages setting is enabled. If the setting is enabled, the Mobile server passes the
defined error message to the mobile app. To set the override setting, see To override
non-customized error messages (from Intelligence Server).

3 If the Override unhandled Intelligence Server error messages setting is
not enabled, the Mobile server passes the standard error message from the
Intelligence Server to the mobile app.

When an error is logged, the original error message from Intelligence Server is
always written to the log file, regardless of the error message sent to the mobile
app.

To customize error messages for mobile devices (from Intelligence
Server)

1 On the Mobile server, open themobileErrors.xml file with an XML or text editor.

The file is located in <MobileServerRoot>\WEB-INF\xml\config. For example, if
installed on the C: drive, the file is located in C:\Program Files
(x86)\MicroStrategy\Mobile Server ASPx\WEB-INF\xml\config.

2 Edit the file to customize error messages.

The following is an typical error message from the XML file:
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<error code="-2147216380" displayError="true" showContactInfo="true"
target="login" useOriginalMessage="false">
     <message XMLmerge_id="1" desc="The page could not be displayed."
desc-id="mstrWeb.14784"/>

<message XMLmerge_id="2" desc=" " desc-id=""/>
     <message XMLmerge_id="3" desc="Please contact your Administrator."
desc-id="mstrWeb.456"/>
</error>

Note the following syntax rules:

• Only the following attributes are supported in the <error/> tag:

▫ code - specifies the ID of the error code from Intelligence Server.

▫ useOriginalMessage - specifies whether to use the error message from
Intelligence Server. If true, the text from Intelligence Server is passed to the
Mobile app. If false, the custom text is passed to the Mobile app.

Other attributes are available for MicroStrategy Web only and are ignored here.

• If there are multiple <message/> tags defined for an error code, the messages
are concatenated and passed to the mobile app.

— When translating error messages, it is good practice to divide the text into
strings that can be reused by multiple error messages.

• Internationalization is supported through the desc-id attributes, which point
to the translated strings in the MessagesBundle_*.properties files in
<MobileServerRoot>\WEB-INF\classes\resources. For more information see
the following topic in the MicroStrategy Developer Zone: Using Localization
Descriptor Files.

3 Save and close the file.

To override non-customized error messages (from Intelligence Server)

1 Open Mobile Administrator.

2 Click Security. The Security page opens.

3 In the Diagnostics section, note the following options:

https://lw.microstrategy.com/msdz/MSDZ_World2015/docs/projects/WebSDK/output/HTML5/default.htm#topics/other/Messages_Bundle_and_Localized_Descriptor_Files.htm
https://lw.microstrategy.com/msdz/MSDZ_World2015/docs/projects/WebSDK/output/HTML5/default.htm#topics/other/Messages_Bundle_and_Localized_Descriptor_Files.htm
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• Override unhandled Intelligence Server error messages - Specifies the
error message text that will be sent to mobile apps for errors originating from
Intelligence Sever and that are not configured in the mobileErrors.xml file on
the Mobile server. To define an error message, select the check box and enter
the error message text in the text field.

Internationalization of this message is currently not supported.

• Include time stamp in error message - Select the check box to include a
time stamp when the error message is sent to the mobile apps.

4 Click Save.

Default mobileErrors.xml

The out-of-the-box mobileErrors.xml file includes customizations for the error messages
listed in the following table. For other scenarios, mobile administrator can choose to
replace the error messages through the Override unhandled Intelligence Server
error messages setting on the Security page in Mobile Administrator Security page, or
add additional error messages to the mobileErrors.xml file.

Scenario Error Code Customized Error Message

User does not have the privilege to
use mobile app

-2147205002 You do not have the required privilege to
access this resource. Please contact your
Administrator.

User lacks necessary privileges to
access the resource

-2147213784 You do not have the required privilege to
open the page. Please contact your
Administrator.

Project LDAP privilege error -2147214578 The username or password you entered is
incorrect.

User is not linked to any
MicroStrategy user

-2147212488 Your account is not linked to a MicroStrategy
account. Please contact your Administrator.

The size of the result binary
exceeds the limit set by the client
request

-2147071867 The size of the result binary exceeds the
limit set by the client request. Please contact
your Administrator.

Dataset cannot be run -2147466604 The page could not be displayed because
cube is not published or dataset returns an
error. Please publish the cube or contact
your administrator for help.

Username is not found or
password is incorrect

-2147216959 The username or password you entered is
incorrect.

User is disabled -2147216965 Your account has been disabled. Please
contact your Administrator.

User is required to change the
password

-2147216960 Your password has expired. You will need to
change it in order to connect.
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Scenario Error Code Customized Error Message

Password has expired -2147216963 Your password has expired. You will need to
change it in order to connect.

Project is not loaded -2147209183 The project is offline now. If the problem
persists, please contact your administrator
for help.

Attempt to access data for project
not registered with server

-2147209151 The project could not be found. Please
contact your Administrator.

Intelligence Server is not
connected

-2147206923 The contents of this page could not be
displayed because the Intelligence Server is
not running. Please contact the
Administrator.

The connection failed -2147207419 The contents of this page could not be
displayed because the Intelligence Server is
not running. Please contact the
Administrator.

The target report, document, or
any object (e.g. attribute, metric,
etc.) referenced cannot be found
in the metadata

-2147216373 The page could not be displayed. Please
contact your Administrator.

Standard authentication not
allowed

-2147213792 Standard authentication is not allowed.
Please specify a correct authentication
mode or contact your administrator for help.

Maximum number of Server users
exceeded

-2147209056 Maximum number of Server users
exceeded. Please try again. If the problem
persists, contact the Administrator.

User does not have privilege to
login to the selected project

-2147216961 Please contact your Administrator.

Database connection errors -2147216380 The page could not be displayed. Please
contact your Administrator.

Login failure -2147216953 You cannot log in as Windows user. Please
contact your Administrator.

Unable to determine your
Windows identity

-2147205087 You cannot log in as Windows user. Please
contact your Administrator.

The user does not have access to
this object

-2147214570 You do not have the required privilege to
open the page. Please contact your
Administrator.

Login failure -2147072513 You have reached the maximum number of
password attempts. Please contact your
Administrator.

You cannot supply a new
password; the current password is
not modifiable

-2147216972 You are not allowed to change your
password. Please contact your Administrator.
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Scenario Error Code Customized Error Message

No server is available to serve
your request

-2147205282 The contents of this page could not be
displayed because the Intelligence Server is
not running. Please contact the
Administrator.

Type mismatch -2147352571 Error when answering the prompt. Please
review your answer(s).

The proposed answer to a prompt
question failed validation
requirements

-2147217090 Error when answering the prompt. Please
review your answer(s).

Failed to load object from XML -2147216992 Error when answering the prompt. Please
review your answer(s).

Request timeout -2147206497 Your request has timed out. Please try again
later.

Maximum number of result rows
retrieved per report was exceeded

-2147202391 The page could not be displayed. Please
contact your Administrator.

Message is not persisted in
history list. History list may be full

-2147205473 The page could not be displayed. Please
contact your Administrator.

Maximum number of jobs per
User Account exceeded when
trying to submit job for user in
project Id

-2147209053 You have reached the maximum number of
messages per user. Please contact the
Administrator.

Number of jobs exceeded
maximum for Project

-2147209164 The maximum number of messages per
project has been reached. Please contact
the Administrator.

You do not have access to the
object

-2147214579 You do not have the required privilege to
open the page. Please contact your
Administrator.

Project is idle -2147209192 The project is idle now. If the problem
persists, please contact your administrator
for help.

Troubleshooting MicroStrategy Mobile
This section provides guidance for finding and fixing trouble spots in the system. While
the material in this section does not go into great detail, it does provide references to the
relevant portions of the documentation where the topic or remedy is discussed in more
detail.

• Troubleshooting connection issues, page 238

• Troubleshooting reports and documents, page 238

• Troubleshooting prompt answers, page 238
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Troubleshooting connection issues
When you create a configuration for a mobile device (see Configuring MicroStrategy
Mobile for iPhone or iPad, page 186), you must specify the Mobile Server machine by its
fully qualified name so that the Mobile device can locate the machine on the network.

Troubleshooting reports and documents
• MicroStrategy recommends that caching be enabled for all reports and documents

intended to be viewed on a mobile device. For information on report and document
caching, including instructions on how to enable caching for specific reports and
documents, see the Caching chapter of the System Administration Guide.

• If subscribed reports and documents are loading slowly on an iPhone or iPad, enable
the Automatically Pre-Load Caches setting. This setting causes cached
reports/documents to be loaded onto the device when the application is launched.
This setting is found in the iPhone Settings or iPad Settings tab of the Mobile
Configuration Editor, or in the device’s Settings screen if the device is configured
for users to have access to the settings. For information about configuring your
device, see Configuring MicroStrategy Mobile for iPhone or iPad, page 186.

• If a Video Player widget stops in the middle of streaming video playback: When a
mobile device is offline, the user can play the portion of the streaming video that was
downloaded while the mobile device was online.

By default, the downloaded video file is discarded when the MicroStrategy Mobile
application is closed. You can ensure that the video is downloaded and stored on the
mobile device for offline use. For steps, see Pre-caching online content on the
mobile device for offline use, page 211.

Troubleshooting prompt answers
To support the scanning of barcodes using MicroStrategy Mobile for iPhone, you must
store the barcode data used in the associated prompt with a database data type that
supports text data. MicroStrategy recommends using the VarChar data type for your
database to store the barcode data. For information about setting up the database, see the
Project Design Guide and the Installation and Configuration Guide.

https://www2.microstrategy.com/producthelp/10.7/SystemAdmin/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/ProjectDesignGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/10.7/InstallConfig/WebHelp/Lang_1033/index.htm


GLOSSARY
access control list

A list of users, groups and the access permissions that each has for an object.

attribute

A data level defined by the system architect and associated with one or more columns in
a data warehouse lookup table. Attributes include data classifications like Region, Order,
Customer, Age, Item, City, and Year. They provide a means for aggregating and filtering
at a given level.

See also:

• attribute element

• attribute form

attribute element

A value of any of the attribute forms of an attribute. For example, New York and Dallas
are elements of the attribute City; January, February, and March are elements of the
attribute Month.

attribute form

One of several columns associated with an attribute that are different aspects of the same
thing. ID, Name, Last Name, Long Description, and Abbreviation could be forms of the
attribute Customer. Every attribute supports its own collection of forms.

cache

A special data store holding recently accessed information for quick future access. This is
normally done for frequently requested reports, whose execution is faster because they
need not run against the database. Results from the data warehouse are stored separately
and can be used by new job requests that require the same data. In the MicroStrategy
environment, when a user runs a report for the first time, the job is submitted to the
database for processing. However, if the results of that report are cached, the results can
be returned immediately without having to wait for the database to process the job the
next time that the report is run.
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consolidation

An object that can be placed on a report and is made up of an ordered collection of
elements called consolidation elements. Each element is a grouping of attribute elements
that accommodates inter-row arithmetic operations.

dashboard

A visually intuitive display of data that summarizes key business indicators for a quick
status check. A special type of document, dashboards usually provide interactive features
that let users change how they view the dashboard’s data.

dataset

A MicroStrategy report that retrieves data from the data warehouse or cache. It is used to
define the data available on a document.

document

1 A container for objects representing data coming from one or more reports, as well
as positioning and formatting information. A document is used to format data from
multiple reports in a single display of presentation quality.

2 The MicroStrategy object that supports the functionality defined in (1).

drill

A method of obtaining supplementary information after a report has been executed. The
new data is retrieved by requerying the Intelligent Cube or database at a different
attribute or fact level.

See also:

• page-by

• sort

• subtotal

filter

A MicroStrategy object that specifies the conditions that the data must meet to be
included in the report results. Using a filter on a report narrows the data to consider only
the information that is relevant to answer your business question, since a report queries
the database against all the data stored in the data warehouse.

A filter is composed of at least one qualification, which is the actual condition that must
be met for the data to be included on a report. Multiple qualifications in a single filter are
combined using logical operators. Examples include “Region = Northeast” or “Revenue >
$1 million”.

A filter is normally implemented in the SQL WHERE clause.

Grid/Graph

A control placed in a document that displays information in the same way a
MicroStrategy report does.
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hierarchy

A set of attributes defining a meaningful path for element browsing or drilling. The order
of the attributes is typically—though not always—defined such that a higher attribute has
a one-to-many relationship with its child attributes.

level

1 In a data warehouse, facts are said to be stored at a particular level defined by the
attribute IDs present in the fact table. For example, if a fact table has a Date column,
an Item_ID column, and a fact column, that fact is stored at the Date/Item level.

2 In a metric calculation, the level is the granularity of where an attribute appears in its
hierarchy, where that attribute defines how a related metric is calculated. For
example, a metric on a report with Year and Store attributes would be calculated at
the Year/Store level.

See also: level of aggregation.

level of aggregation

The point in an attribute hierarchy where aggregation is performed. For example, in the
geographical State--City--Store hierarchy there are three possible levels of aggregation.

link

A connection in one report or document to another report or document. A link lets an
analyst execute another document or report (the target) from a document or report (the
source), and to pass parameters to answer any prompts that are in the target.

metric

1 A business calculation defined by an expression built with functions, facts, attributes,
or other metrics. For example: Sum(dollar_sales) or [Sales] - [Cost].

2 The MicroStrategy object that contains the metric definition. It represents a business
measure or key performance indicator.

page-by

Segmenting data in a grid report by placing available attributes, consolidations, and
metrics on a third axis called the Page axis. Since a grid is two-dimensional, only a slice
of the cube can be seen at any one time. The slice is characterized by the choice of
elements on the Page axis. By varying the selection of elements, the user can page
through the cube.

See also:

• drill

• sort

• subtotal

panel

A way of grouping data in a document so that users can navigate subsets of data as if the
subsets were pages in a smaller document. Each “page”, or layer of data, is a panel; a
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group of panels is called a panel stack.

panel stack

The holder for a collection of panels, or layers of data, in a document. A user can
navigate or flip through the panels in a panel stack; only one panel is displayed at a time.

permission

Defines for each object the degree of control that a user has over them.

privilege

Defines what types of operations certain users and user groups can perform in the
MicroStrategy system. For example, which objects a given user can create and which
applications and editors he can use.

prompt

1 MicroStrategy object in the report definition that is incomplete by design. The user is
asked during the resolution phase of report execution to provide an answer that
completes the query. A typical example with a filter is choosing a specific attribute on
which to qualify.

2 In general, a window requesting user input, as in "type login ID and password at the
prompt."

qualification

The actual condition that must be met for data to be included on a report. Examples
include “Region = Northeast” or “Revenue > $1 million”. Qualifications are used in filters
and custom groups. You can create multiple qualifications for a single filter or custom
group, and then set how to combine the qualifications using the logical operators AND,
AND NOT, OR, and OR NOT.

See also:

• filter

report

The central focus of any decision support investigation, a report allows users to query for
data, analyze that data, and then present it in a visually pleasing manner.

See also:

• filter

• template

report creation

The process of building reports from existing, predesigned reports in MicroStrategy
Developer or in MicroStrategy Web.
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report design

The process of building reports from basic report components using the Report Editor in
MicroStrategy Developer or MicroStrategy Web.

schema

1 The set of tables in a data warehouse associated with a logical data model. The
attribute and fact columns in those tables are considered part of the schema itself.

2 The layout or structure of a database system. In relational databases, the schema
defines the tables, the fields in each table, and the relationships between fields and
tables.

selector

A type of control in a document that allows a user to:

• Flip through the panels in a panel stack, to see different predefined layers of data, or
“pages”, in the same document

• Display different attribute elements or metrics in a Grid/Graph

sort

Arranging data according to some characteristic of the data itself (alphabetical
descending, numeric ascending, and so forth).

See also:

• drill

• page-by

• subtotal

subtotal

A totaling operation performed for a portion of a result set.

See also:

• drill

• page-by

• sort

threshold

Used to create conditional formatting for metric values. For example, if revenue is
greater than $200, format that cell to have a blue background with bold type.

widget

A type of control that presents data in a visual and interactive way; an interactive Flash-
only graph that dynamically updates when a new set of data is selected. Some types
include Gauge, Heat Map, and Stacked Area widgets.
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A

Android application, opening in a
document 132

Android widget 78

attribute element prompt 61

Barcode Reader prompt 66

creating 61

display styles 63

Geo Location prompt 65

types 61

audience 8

authentication settings for
MicroStrategy Mobile Server 163

B

Barcode Reader prompt 65

attribute element prompt 66

value prompt 66

best practices for designing a document
for MicroStrategy Mobile 19

button 152

caption 153

creating 157

custom style 153

default link 153

formatting 158

highlight state 153

icon 153

multiple links 153

normal state 153

style 153

tab bar (iPad and iPhone) 154

C

caching online content 211

certificate server for client
authentication 164

setting up 164

client authentication with a certificate
server 164

Command Manager 229
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copying text (iPad and iPhone) 50

D

Data Cloud widget (iPhone and
iPad) 81

Date Selection widget (iPad) 81

creating 81

example 81

docked panel selector 37

docked panel selector (iPad)

creating 37

document (Android)

designing for MicroStrategy
Mobile 19

formatting 26

linking to documents and
reports 139

document (iPad)

designing for MicroStrategy
Mobile 19

enabling text copying 50

formatting 26, 33

linking to documents and
reports 138

document (iPhone)

designing for MicroStrategy
Mobile 19

enabling text copying 50

formatting 26, 33

linking to documents and
reports 138

document layout

formatting 31

Mobile Views and 28

document, linking to documents and
reports 138

E

error messages

customizing for mobile devices 233

override error messages 234

example

Date Selection widget (iPad) 81

docked panel selector 37

Graph Matrix visualization (iPad) 85

Heat Map widget (iPad) 86

how to find 6

Image Layout widget 87

Information Window 93

iPad 39

Map widget (iPhone) 100

Interactive Grid widget 90

Map widget 93

Microcharts widget (iPad and
Android) 108

Photo Uploader widget 113

RSS Reader widget (iPhone) 116

Survey widget (iPhone) 120

Time Series widget 125

Timeline widget (iPad) 121

F

formatting

Android document 26

document layout 31

iPad document 26

iPhone document 26
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Mobile View 27

G

Geo Location prompt 64

attribute element prompt 65

value prompt 65

Graph Matrix visualization (iPad) 85

example 85

H

Heat Map widget (iPad) 86

example 86

home screen configuration 202

creating a custom home screen 203

I

Image Layout widget 87

example 87

Image Viewer widget

creating in a document 88

in a document 87

Information Window 38

creating for a button 43

creating for a Grid/Graph 40

creating for a selector 40

creating for a text field 43

creating for an image 43

display (iPad) 44

placement 44

window mode 44

transaction table in 67

Information Window (iPhone) 100

creating 101

installing MicroStrategy Mobile
Server 162

Interactive Grid widget

creating in a document 91

document 90

example 90

iPad

document display when rotated 27

transaction table 67

widget 78

iPad application, opening in a
document 132

iPhone

document display when rotated 27

transaction table 67

widget 78

iPhone 5 24

iPhone application, opening in a
document 132

L

linking a document to documents and
reports 138

Android 139

creating 139

iPad 138

iPhone 138

M

Map widget

creating in a document 96

example 93

Geo Location prompt on 102

in a document 93
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Information Window 100

creating 101

Microcharts widget (iPad and Android)

creating in a document 109

display theme 110

example 108

in a document 108

KPI List mode 109

metric column width 110

Smooth Scroll mode for iPad 110

MicroStrategy Mobile

administering 161

architecture 161

client application 162

data security 222

deploying and configuring 183

Android 194

configuring from the device 215

connectivity settings 199

home screen 202

iPad 183, 186

iPhone 183, 186

push notification for iPad and
iPhone 213

displaying a report as a widget 78

document display when rotated 27

Mobile View 27

opening a mobile device
application 132

report and document subscription.
See also subscribing to reports
and documents. 222

server 162

subscription workflow 221

troubleshooting 237

MicroStrategy Mobile for Android

calling from a document 134

configuring 194

deploying 194

directions from a document 135

document design for 19

emailing from a document 134

formatting document for 26

mapping current location 135

opening a video from a
document 135

texting from a document 135

MicroStrategy Mobile for iPad

configuring 186

configuring push notification 213

deploying 183

directions from a document 135

displaying a web page from a
document 136

document design for 19

emailing from a document 134

formatting document for 26, 33

mapping current location 135

opening a video from a
document 135

MicroStrategy Mobile for iPhone

calling from a document 134

configuring 186

configuring push notification 213

deploying 183
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directions from a document 135

document design for 19

emailing from a document 134

formatting document for 26, 33

mapping current location 135

opening a video from a
document 135

texting from a document 135

MicroStrategy Mobile Server 162

authentication settings 163

client authentication 164

installing 162

privileges and permissions 163

SSL encryption 164

Mobile View 27

mobileErrors.xml 233

default settings 235

Multimedia widget

creating in a document 111

in a document 111

P

page-by on a report

iPad 22

panel stack 36

docked panel selector 37

permissions for MicroStrategy Mobile
Server 163

Photo Uploader widget

creating in a document 113

destination folder 168

example 113

in a document 113

pre-caching online content 211

prerequisites 8

privileges for MicroStrategy Mobile
Server 163

prompt

Android 56

Geo Location on a Map
widget 102

attribute element 61

Barcode Reader 65

Geo Location 64

iPad 56

Geo Location on a Map
widget 102

iPhone 56

Geo Location on a Map
widget 102

value 58

R

report

displaying as widget 78

page-by navigation (iPad) 22

RSS Reader widget (iPhone) 116

S

sample. See example. 6

security of data in MicroStrategy
Mobile 222

Signature Capture input control
destination folder 168

SSL encryption 164
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subscribing to reports and
documents 222

Command Manager 229

Developer 231

methods 223

MicroStrategy Web 229

multiple subscriptions
simultaneously
(Developer) 224

personalized prompt answers
(MicroStrategy Web) 231

prerequisites 223

subscribing

Developer 231

MicroStrategy Web 230

unsubscribing

Developer 232

MicroStrategy Web 230

update schedule (MicroStrategy
Web) 230

subscription workflow for
MicroStrategy Mobile 221

executing the report 221

reviewing the report 222

scheduling a report or
document 221

T

tab bar (iPad and iPhone) 154

creating 155

example 154

Time Series widget

creating in a document 126

example 125

in a document 125

Timeline widget (iPad)

creating 122

example 121

Transaction Services 55

transaction table (iPad and iPhone) 67

buttons 69

cell 69

adding to a table 76

placeholder text 69

reordering 76

title 69

creating 70

formatting 74

group 69

adding to a table 75

deleting 75

reordering 75

hidden group 69

Information Window 67, 71

troubleshooting MicroStrategy
Mobile 237

connection issues 238

document 238

prompt 238

report 238

V

value prompt 58

Barcode Reader prompt 66

creating 58

Geo Location prompt 65
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W

widget 78

Android 78

Data Cloud (iPad) 81

Data Cloud (iPhone) 81

Date Selection (iPad) 81

Graph Matrix visualization (iPad) 85

Heat Map (iPad) 86

Image Layout 87

Image Viewer 87

Interactive Grid 90

iPad 78

iPhone 78

Map 93

Microcharts (iPad and Android) 108

Multimedia 111

Photo Uploader 113

Survey (iPad) 119

Time Series 125

Timeline (iPad) 121

Video Player (iPad and iPhone) 128
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